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disclose the Software. The EULA and the 
license set forth therein, does not require 
or permit, among other things, that Key-
sight: (1) Furnish technical information 
related to commercial computer software 
or commercial computer software docu-
mentation that is not customarily provided 
to the public; or (2) Relinquish to, or other-
wise provide, the government rights in 
excess of these rights customarily provided 
to the public to use, modify, reproduce, 
release, perform, display, or disclose com-
mercial computer software or commercial 
computer software documentation. No 
additional government requirements 
beyond those set forth in the EULA shall 
apply, except to the extent that those 
terms, rights, or licenses are explicitly 
required from all providers of commercial 
computer software pursuant to the FAR and 
the DFARS and are set forth specifically in 
writing elsewhere in the EULA. Keysight 
shall be under no obligation to update, 
revise or otherwise modify the Software. 
With respect to any technical data as 
defined by FAR 2.101, pursuant to FAR 
12.211 and 27.404.2 and DFARS 227.7102, 
the U.S. government acquires no greater 
than Limited Rights as defined in FAR 
27.401 or DFAR 227.7103-5 (c), as appli-
cable in any technical data. 

Warranty

THE MATERIAL CONTAINED IN THIS DOCU-
MENT IS PROVIDED "AS IS," AND IS SUB-
JECT TO BEING CHANGED, WITHOUT 
NOTICE, IN FUTURE EDITIONS. FURTHER, 
TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, KEYSIGHT DISCLAIMS 
ALL WARRANTIES, EITHER EXPRESS OR 
IMPLIED WITH REGARD TO THIS MANUAL 
AND ANY INFORMATION CONTAINED 
HEREIN, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PAR-
TICULAR PURPOSE. KEYSIGHT SHALL NOT 
BE LIABLE FOR ERRORS OR FOR INCIDEN-

TAL OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH THE FURNISHING, 
USE, OR PERFORMANCE OF THIS DOCU-
MENT OR ANY INFORMATION CONTAINED 
HEREIN. SHOULD KEYSIGHT AND THE 
USER HAVE A SEPARATE WRITTEN AGREE-
MENT WITH WARRANTY TERMS COVER-
ING THE MATERIAL IN THIS DOCUMENT 
THAT CONFLICT WITH THESE TERMS, THE 
WARRANTY TERMS IN THE SEPARATE 
AGREEMENT WILL CONTROL.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. 
It calls attention to an operating pro-
cedure, practice, or the like that, if 
not correctly performed or adhered 
to, could result in damage to the 
product or loss of important data. Do 
not proceed beyond a CAUTION 
notice until the indicated conditions 
are fully understood and met. 

WARNING
A WARNING notice denotes a hazard. 
It calls attention to an operating pro-
cedure, practice, or the like that, if 
not correctly performed or adhered 
to, could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.

Notices
© Keysight Technologies 2020

No part of this manual may be reproduced 
in any form or by any means (including 
electronic storage and retrieval or transla-
tion into a foreign language) without prior 
agreement and written consent from 
Keysight Technologies as governed by 
United States and international copyright 
laws.

Manual Part Number
N7781-90001

Edition

Edition 7.1, October 2020

Keysight Technologies Deutschland GmbH 
Herrenberger Strasse 130,
71034 Böblingen, Germany

Technology Licenses
The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer 
software,” as defined by Federal Acquisition 
Regulation (“FAR”) 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement 

(“DFARS”) 227.7202, the U.S. government 
acquires commercial computer software 
under the same terms by which the soft-
ware is customarily provided to the public. 
Accordingly, Keysight provides the Soft-
ware to U.S. government customers under 
its standard commercial license, which is 
embodied in its End User License Agree-
ment (EULA), a copy of which can be found 
at http://www.keysight.com/find/sweula. 
The license set forth in the EULA represents 
the exclusive authority by which the U.S. 
government may use, modify, distribute, or 

2 Keysight N778xB User’s Guide



Keysight N778xB User’s Guide 3

Compliance and Environmental Information

Table 1  Compliance and Environmental Information

Safety Symbol Description

This product complies with WEEE Directive (2002/96/EC) marking requirements. 
The affixed label indicates that you must not discard this electrical/electronic 
product in domestic household waste.

Product Category: With reference to the equipment types in WEEE Directive Annex I, 
this product is classed as a “Monitoring and Control instrumentation” product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more 
information.
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1 Quick Start 
Information

This section demonstrates how to connect your instruments optically and 
electrically for typical applications. They are intended as a quick start 
guide, although it is strongly recommended that you read through 
Chapter, “General,” on page 27, Chapter, “Getting Started,” on page 33 
and Chapter, “Applications,” on page 71 prior to operating the 
instruments. 

Each application supports different modes of operation, some of which 
may require additional connections, which are described in the respective 
application section of this user guide.

NOTE
Please install the polarizationNAVIGATOR™ software before you plug in 
the instrument(s) to the USB port of the PC! This ensures that the drivers 
are available when you plug-in the instrument(s). If you have connected 
the instrument(s) prior to software installation, you may have to delete 
the instrument(s) manually from the Windows device manager. This does 
not apply to the N7781BD or the N7788BD. It also does not apply to 
instruments that are used with GPIB only. 

NOTE
Run the Configuration Wizard each time you connect additional 
instruments.



20 Keysight N778xB User’s Guide

1 Quick Start Information
 

N7781B Setup (Polarimetry)

Figure 1 N7781B Setup

N7782B Setup (PER Analysis)

Standard Option (No Internal Laser Source)

Figure 2 N7782B Setup
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Option 401, 501, 101 (With Internal Laser Source) and N7783B

Figure 3 N7782B with internal laser source and N7783B Setup

For further PER/PMF crosstalk measurement setups refer to Application: 
PER/PMF Crosstalk on page 103.
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WARNING
Please read the laser safety warnings of section Safety Instructions on 
page 28 if your instrument contains a laser source (N7782B with Option 
#101, #401, #501).
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N7784B Setup (Polarization Stabilization)

Figure 4 N7784B Setup

N7785B Setup (Polarization Scrambling)

Figure 5 N7785B Setup
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N7786B Setup (Polarization Synthesis)

Figure 6 N7786B Setup

N7788B Setup (PMD/PDL Analysis)

Figure 7 N7788B Setup
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N7783B Setup (PER Analysis)

Figure 8 N7783B Setup

For further PER/PMF crosstalk measurement setups refer to Application: 
PER/PMF Crosstalk on page 103.

N7781BD Setup (Polarimetry)

Figure 9 N7781BD Setup
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NOTE
Press the Modify Knob twice to access the on-screen keyboard.
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N7788BD Setup (PMD/PDL Analysis)

Figure 10 N7788BD Setup
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This chapter contains safety, regulatory and warranty information.

Safety Instructions   /  28
Regulatory Information   /  31
Declaration of Conformity   /  32
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Safety Instructions

• This instrument shall only be operated according to the instructions in 
this manual.

• Before this instrument (including external power supply) is connected 
to an electricity outlet make sure the outlet is provided with a protective 
earth contact. Also make sure that you use a three line AC power cord.

• The instrument and any external power supply shipped with the 
instrument do not contain operator serviceable parts. To prevent 
personal injuries or damage to the instrument do not open the devices. 

• If you need to turn off the power, unplug the instrument at the mains or 
remove the power cable connector from the appliance coupler at the 
rear of the instrument. For this reason, the power cable connection 
should be easily accessible - allowing you to turn off the power quickly. 
If the instrument is in a cabinet, it must be disconnected from the line 
power by the system’s line power switch.

• This instrument may be labeled with one of the safety symbols shown 
below (if the instrument is not labeled with a certain safety label, the 
respective safety measures do not apply to that instrument):

This label is located near certain parts of the instrument 
that get hot during operation. This applies to the white 
surface below the lid of the N7783B Thermal Cycling 
Unit, i.e. the trench that the fiber is placed into. Avoid 
touching this surface during operation.
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This label denotes laser output ports of instruments that 
contain laser sources. Refer to Table 2 on page -29 for 
further details.

Table 2  Parameters of Lasers Included in certain instruments (see column headers for 
respective product options

N7782B #101 #401 #401/#501

Laser Type Fabry-Perot Fabry-Perot Fabry-Perot

Wavelength or Wavelength Range 850nm 1310nm 1550nm

Max. CW output power*

* Max. CW output power means the highest possible optical CW power that the laser 
source can produce at its output.

0.2mW 1mW 1mW

Beam waist diameter 9μm 9μm 9μm

Numerical aperture 0.1 0.1 0.1

Laser class according to IEC 
60825-1 (2001)

Class 1 Class 1 Class 1

Max. permissible CW output power†

† Max. permissible CW output power is the highest optical power that is permitted within 
the appropriate IEC laser class.

0.8mW 15.6mW 10mW
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• Under no circumstances look into the optical output of the instrument 
or to an optical cable attached to the optical output when the device is 
operational. The laser radiation can seriously damage your eyesight

• Do not enable the laser when there is no fiber attached to the optical 
output connector.

• The laser is enabled by starting the PER application in the 
polarizationNAVIGATOR™ software. In that application there is also a 
button to enable/disable the laser source once the application is 
running. The laser is on when one of the green LEDs to the right of the 
optical connector labeled ”Output” is lit.

• The use of optical instruments with this product will increase eye 
hazard.

• Refer servicing only to qualified and authorized personnel.

WARNING
Please pay attention to the following laser safety warnings if your 
instrument contains a laser source (N7782B with Option #101, #401, 
#501):
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Regulatory Information

• Compliance with Canadian EMC Requirements:
This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme à la norme NMB-001 du Canada.

Table 3  Notice for Germany: Noise Declaration

Acoustic Noise Emission

LpA < 50 dB

Operator position

Normal operation

per ISO 7779
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Declaration of Conformity

Latest declaration of conformity is available at

http://www.keysight.com/go/conformity

http://www.keysight.com/go/conformity
http://www.keysight.com/go/conformity
http://www.keysight.com/go/conformity

http://www.keysight.com/go/conformity
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About this manual   /  34
System Requirements   /  35
Unpacking the N778xB/BD   /  36
Connectors and Controls   /  37
Software Installation/Software Updates   /  45
Connect the Instrument   /  50
Connecting Tunable Laser Sources   /  57
Run the Configuration Wizard   /  58
Using the N778xB/BD GPIB Interface (Remote GPIB)   /  59
Changing the GPIB Address   /  60
Accessories   /  64
Operating N778xB/BD instruments   /  64
Operating N778xBD instruments   /  66



34 Keysight N778xB User’s Guide

3 Getting Started
 

About this manual

This manual covers all N778xB/BD instruments. There may be applications 
or functions described within, which cannot be performed with a specific 
instrument. The sections or chapters of this manual contain product 
numbers like N778xB/N778xBD. These product numbers indicate the 
instruments that the specific section applies to.

Many functions and applications are controlled using an external Personal 
Computer (PC), or an integrated PC, so a large portion of this manual is 
about software and refers to screenshots.

Instruments from the N778xBD series comprise an integrated PC, where 
the polarizationNAVIGATOR™ software will run in a compact display mode, 
optimized for touch-screen control, which will be called Integrated PC 
Mode throughout this manual. Therefore you will often find pairs of 
screenshots, one of them referring to the External PC Mode, the other one 
referring to the Integrated PC Mode. In most cases, the functions are 
exactly the same in both modes, but for better accessibility they may be 
rearranged.
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System Requirements

Light source with single mode fiber output (connector: FC/APC or FC/PC, 
depending on instrument input). In case of an N7782B with option #101, 
#401 or #501 such a source is included. 

Personal Computer (included with instruments of the N778xBD family):

• Intel Pentium III, 700 MHz or higher

• Windows 10, Windows 7 or Windows XP SP2 (32 bit)

If connected via USB:

• Available USB (1.1 or higher)

If connected via GPIB:

• VISA-compliant GPIB interface

• VISA driver (usually shipped with the interface)
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Unpacking the N778xB/BD

• Unpack your shipment.

• Inspect the shipping containers for damage.

• Inspect the instruments.

• Verify that you received the options and accessories that you ordered.

Keep the shipping containers and cushioning material until you have 
inspected the contents of the shipment for completeness and have 
checked the equipment mechanically and electrically. In addition to the 
respective instruments the shipment should contain: 

N7783B

• 12V power supply

• Power cable

• Expansion cable

• Additional documents

N778xB (except N7783B)

• Power cable

• USB cable

• BNC cable (N7788B only)

• Analog-In cable, p/n N7784-61601 (N7784B only)

• Expansion port trigger cable, p/n N7786-61601 (N7786B only)

• CD: includes User Guides and software

• Getting Started Guide

• Additional documents

N7781BD / N7788BD (discontinued)

• Power cable

• BNC cable (N7788BD only)

• User Guide

• Additional documents

Refer also to the contents list of the N778xB/BD shipment.

If anything is missing or defective, contact your nearest Keysight 
Technologies sales office. If the shipment was damaged, contact the 
carrier, then contact the nearest Keysight Technologies sales office. 



Keysight N778xB User’s Guide 37

Getting Started 3

 

Connectors and Controls

The following sections provide an overview of the optical and electrical 
connectors, as well as the control elements of the N778xB/BD 
instruments. Throughout this document you will find references to the 
connectors and controls shown in the respective figures. 

N7781B Front Panel

Figure 11 N7781B Front Panel

1 Power button and power LED

2 Optical connector - Polarimeter Input (SMF)

1
2
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N7782B Front Panel

Standard Option (No Internal Laser Source)

Figure 12 N7782B Front Panel

1 Power button and power LED

2 Optical connector - Analyzer Input (SMF)

Option 401, 501, 101 (With Internal Laser Source)

Figure 13 N7782B Front Panel with internal laser source

1 Power button and power LED

2 Optical connector - Laser Output (SMF)

3 Optical connector - Analyzer Input (SMF)

4 Laser switch and laser operation LED

1
2

1
2 3

4
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N7784B Front Panel

Figure 14 N7784B Front Panel 

1 Power button and power LED

2 Optical connector - LiNbO3 polarization controller (PC) Input (SMF)

3 Optical connector - LiNbO3 polarization controller (PC) Output (SMF)

4 Optical connector - Polarization beam splitter (PBS) Input (SMF)

5 Optical connector - Polarization beam splitter (PBS) Output (PMF)

6 Control button and control operation LED

N7785B Front Panel

Figure 15 N7785B Front Panel 

1 Power button and power LED

2 Optical connector - Synchronous Scrambler Input (SMF)

1
2 3 4 5

6

1
2 3
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3 Optical connector - Synchronous Scrambler Output (SMF)

N7786B Front Panel

Figure 16 N7786B Front Panel

1 Power button and power LED

2 Optical connector - Polarization Synthesizer Input (SMF)

3 Optical connector - Polarization Synthesizer Output (SMF)

4 Control button and control operation LED

N7788B Front Panel

Figure 17 N7788B Front Panel

1 Power button and power LED

2 Optical connector - Laser Input (SMF)

1
2 3

4

1
2 3 4
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3 Optical connector - LiNbO3 polarization controller (PC) Output (SMF)

4 Optical connector - Polarimeter Input (SMF)

N778xB Rear Panel

Figure 18 N778xB Rear Panel

1 IEEE 488.2 connector (GPIB)

2 Service connector

3 Expansion connector (e.g. used for Trigger #2, Analog-Input, 
Analog-Output, control of N7783B Thermal Cycling Units, see 
Expansion Port Connector Pinout on page 142)

4 USB connector

5 Trigger Input #1, TTL-Compatible (see Digital Inputs on page 144)

6 Trigger Output, TTL-Compatible (see Digital Outputs on page 144)

7 Power Cord Input (see Power Supply Information and Environmental 
Conditions on page 143)

1 7

245 6 3
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N7783B Rear Panel

Figure 19 N7783B Rear Panel

1 Power Supply input (see Power Supply Information and Environmental 
Conditions on page 143)

2 Expansion input (connect to N778xB/BD)

3 Expansion output (can be used to connect a second N7783B)

N7781BD Front Panel

Figure 20 N7781BD Front Panel

1 Power button

2 Touch screen

3 Modify knob

4 Escape (ESC) button

5 Accept (OK) button

6 Cursor left button

7 Cursor right button

8 USB connector (compliant with USB2.0)

9 Optical connector - Polarimeter Input (SMF)

1 23

1

2

4

5

6 7

3

8

9
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N7788BD Front Panel

Figure 21 N7788BD Front Panel

1 Power button

2 Touch screen

3 Modify knob

4 Escape (ESC) button

5 Accept (OK) button

6 Cursor left button

7 Cursor right button

8 USB connector (compliant with USB2.0)

9 Optical connector - Laser Input (SMF)

10 Optical connector - Polarization Controller Output (SMF)

11 Optical connector - Polarimeter Input (SMF)

N778xBD Rear Panel

Figure 22 N778xBD Rear Panel

1 IEEE 488.2 connector (GPIB)

2 Service connector

1

2

4

5

6 7

3

8

9 10 11

1

2 3

7 8

9 10 11 12

13

6
4 5
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3 Expansion connector (e.g. used for Trigger #2, Analog-Input, 
Analog-Outputs, control of N7783B Thermal Cycling Units)

4 Trigger Input #1, TTL-Compatible (see Digital Inputs on page 144)

5 Trigger Output, TTL-Compatible (see Digital Outputs on page 144)

6 Power Cord Input (see Power Supply Information and Environmental 
Conditions on page 143)

7 VGA output

8 RS 232 connector (Use standard 9-pin extension cable for connection 
to RS 232-controlled device)

9 PS/2 keyboard connector

10 PS/2 mouse connector

11 USB connector (compliant with USB2.0)

12 LAN connector (10/100MBit/s)

13 Audio connectors (not supported)
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Software Installation/Software Updates

Install the software before you plug-in the hardware 

The N778xB/BD instruments come with the polarizationNAVIGATOR™ 
software to provide optimum performance. All drivers and supplements 
are included in the installation package.

This section explains how to install the Photonic Application Suite and the 
polarizationNAVIGATOR™ on your computer.

The polarizationNAVIGATOR™ is now part of the Photonic Application 
Suite, which is a framework of measurement engines for various 
applications. 

The polarizationNAVIGATOR™ requires the Photonic Application Suite 
(Main) package to be installed, which contains a number of common 
elements.

The polarizationNAVIGATOR™ software is pre-installed on N778xBD 
instruments.

To install the polarizationNAVIGATOR™ on a personal computer for use 
with N778xB instruments use the CD supplied with the instrument, or 
download the Package Manager from the webpage 
www.keysight.com/find/n7700

NOTE
You need administrative permissions to install the Photonic Application 
Suite and the polarizationNAVIGATOR™.

NOTE
Please install the Photonic Application Suite (Main) package before you 
plug in any Keysight N778xB instrument(s) to the USB port of the PC! 
This ensures that the drivers are available when you plug-in the 
instrument(s). If you have connected the instrument(s) prior to software 
installation, you may have to delete the instrument(s) manually from the 
Windows Device Manager. This does not apply to instruments that are 
connected via GPIB. 
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The Package Manager software is used to install and update the different 
packages of the Photonic Application Suite, including the 
polarizationNAVIGATOR™.

The Package Manager should start automatically once you put the CD into 
the drive. Otherwise run “setup.exe” from the CD root directory.

If you downloaded the Package Manager from the Keysight website run 
“setup.exe” from the download folder.

NOTE
If an Internet connection is available, the Package Manager will check 
whether newer packages are available on the Keysight Update Server. 
Using the same mechanism, the Package Manager will update itself if 
a newer version is found on the Update Server.

NOTE
Click the Help link on the bottom left of the Package Manager window to 
access instructions and troubleshooting tips for using the Package 
Manager.
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The Package manager lists all known packages and shows which version 
of each of the packages is installed on your PC, if any. It also lists all 
packages that are available for download or installation.

The packages are grouped into categories like “Driver” and “Literature”. 
Click on the group buttons to show only packages belonging to that group.

When moving the mouse cursor over the names in the “Components” 
column, a description of this package is shown in the package description 
area. When moving the mouse cursor over the links (download/install) or 
the version numbers of the “Known Versions” column, release notes (if 
available) and specific information (like missing requirements) for this 
package are displayed in the package description area.

The “Known Version” number is colored green, if there is a version 
available that is newer than the one currently installed.

To the right there is a list of available actions for each of the packages:

• Download

If your computer is connected to the Internet, the Package Manager 
will check for the latest available versions and show the action 
“Download” for any available packages. The size of the compressed 
package is listed for each one. Once download is complete, the 
Package Manager checks the file integrity.

If you’ve downloaded a package in the past or you’re running the 
Package Manager from CD, the packages don’t need to be 
downloaded. 

• Install

By pressing install, the package will be uncompressed and the installer 
will be launched.

• Show Info

Some packages do not contain an installer, but documents instead. By 
pressing Show Info, these documents will be shown (e.g. text files).

• Not available

There may be package versions known to the Package Manager that 
are no longer available on the Update Server and that have not been 
downloaded to your PC before. Those packages are listed, but no 
action is available.
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There are a number of functions at the bottom of the Package Manager 
Window:

• www.keysight.com/find/N7700

Show Photonic Application Suite product website including ordering 
information (Internet access required).

• Manage Subscriptions

Enter or remove access codes for accessing restricted packages 
(Internet access required).

• Download All

Download all packages visible in the current group, if they are newer 
than the installed ones (Internet access required).

• Explore Download Folder

Delete files from the 'Packages' folder to free disk space.

NOTE
Certain packages require other packages to be installed. Once you 
installed a package that requires one or more other packages, those 
packages will be indicated by an arrow to the right of the action list. It is 
strongly recommended to install all these packages as well before 
running any applications.

NOTE
By removing the “Only Show Most Recent Versions” checkmark, all 
known and available package versions are listed.

NOTE
By default some of the applications of this suite will check regularly 
whether updates are available on the Keysight Update Server (requires 
Internet access). To disable this feature, remove the “Automatically 
Check for Updates” checkmark.
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NOTE
Please install the Photonic Application Suite (Main) before you plug in 
any Keysight N778xB instrument(s) to the USB port of the PC. This 
ensures that the drivers are available when you plug-in the 
instrument(s). If you have connected the instrument(s) prior to software 
installation, you may have to delete the instrument(s) manually from the 
Windows Device Manager. This does not apply to instruments that are 
connected via GPIB. 



50 Keysight N778xB User’s Guide

3 Getting Started
 

Connect the Instrument

Install the software before you plug-in the hardware 

If you have installed the software, you can connect the instrument to your 
computer.

Instruments of the N778xBD family don't require an external computer and 
therefore this section does not apply. To connect N778xB instruments to 
your personal computer there are two options:

• Use the USB interface (preferred)

• Use the GPIB interface

Connecting the Instrument to the USB Interface

Connect the instrument to the computer and power it up if you have not 
yet done so. Depending on the type of instrument, you may have to wait up 
to 20 seconds until the instrument has finished the boot-up phase.

The driver is not signed - Please install anyway.

On first installation, WINDOWS will come up with a message stating that 
the driver is not signed. Please install the driver anyway.

After the driver installation is complete, start the polarizationNAVIGATOR™ 
software.

Starting with revision 1.5 of the Photonic Application Suite, we are using 
the libusb-win32 driver package (details at the end of this section). The 
main reason for this change is the availability of this driver package for 
64bit operating systems.

NOTE
When an N778xB instrument is connected to the USB bus, it will not be 
listed in the Keysight Connection Expert.

NOTE
If you want to revert to a version of the Photonic Application Suite less 
than 1.5, the old USB drivers will be installed on the PC again, but they 
are not necessarily applied to N778x instruments. Below you will find 
instructions on how to apply the correct drivers.
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If you connect an N778x instrument through USB to the PC (power it up 
and wait until it is recognized by Windows) and is not recognized by the 
Photonic Application Suite software, please check the computer’s Device 
Manager (in Windows XP: right-click My Computer, then select 
Properties, then switch to tab Hardware, then click Device Manager).

If USB drivers have been installed for the corresponding instrument with a 
PAS revision less than 1.5 installed on the PC, they will be listed as 
Keysight Technologies N778x USB Instruments in the section Universal 
Serial Bus controllers.

If USB drivers have been installed for the corresponding instrument with a 
PAS revision 1.5 or higher installed on the PC, they will be listed as 
Keysight Technologies N778x USB Instruments (lib) in the section 
libusb-win32 devices.

You can manually change the associated drivers from the Windows Device 
Manager as shown in the following pictures.
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 NOTE
When reverting to the <1.5 drivers, there may be a warning about the 
drivers not having passed Windows Logo testing. If so, please click 
Continue Anyway to complete the operation.

NOTE
Libusb- win32 is a library that allows userspace application to access 
USB devices on Windows operation systems 

(Win2k, WinXP, Vista, Win7).

It is derived from and fully API compatible to libusb available at 
http://libusb.sourceforge.net.

The complete license document will be displayed by running the USB 
driver installer from the Package Manager.

For more information visit the project's web site at:

http://libusb- win32.sourceforge.net

http://sourceforge.net/projects/libusb- win32
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Connecting the Instrument to the GPIB Interface

NOTE

VISA has to be installed. 

Use a standard GPIB cable to connect the N778xB/BD to the PC. On the PC, 
VISA has to be installed to provide the GPIB functionality. Usually VISA 
comes with your GPIB board, but may not be automatically installed on your 
system. Check your GPIB board's driver CD or contact the vendor of your 
GPIB interface for more information about VISA. Keysight VISA is provided 
by the IO Libraries Suite, which can be installed from the Package Manager.

The default GPIB address is 30. Please refer to Changing the GPIB Address 
on page 60 on how to change the GPIB address. You can check the correct 
installation if you turn on the instrument and wait for some seconds. Start 
the Keysight Connection Expert or the National Instruments Automation 
Explorer on your PC and scan for new instruments. The instrument should 
be detected on address 30.

You have to quit the Polarization Navigator software on the N778xBD to 
put the GPIB port into non-controller mode. Only in this mode can you 
control the instrument from outside. Otherwise the N778xBD uses the 
GPIB port as controller port to control other instruments such as tunable 
laser sources.

NOTE
When an N778xB instrument is connected to the GPIB bus, the Keysight 
Connection Expert will display a warning icon next to it. You can safely 
ignore this warning. Clearing this warning from the instrument’s details 
view won’t prevent it from reoccurring immediately afterwards.
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Connecting Tunable Laser Sources

Connect your TLS to the GPIB port of the N778xB/BD. 

The polarizationNAVIGATOR™ software can communicate with Keysight 
Tunable Laser Sources (TLS) either via the instrument's GPIB port (in that 
case the instrument's GPIB port is used as GPIB-Master, see Using the 
N778xB/BD GPIB Interface (Remote GPIB) on page 59 for details) or via a 
GPIB board installed in your PC.

Connect the TLS to the appropriate interface, turn it on and run the 
Configuration Wizard. The TLS should then be listed under "Misc. 
Instruments".

Don't forget the BNC trigger cable!

Some laser sources need a trigger cable connected to the N778xB/BD. 
Refer to Measurement Setup on page 99 for details on how to connect the 
trigger cable.
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Run the Configuration Wizard

Now that the software is installed and the instrument is connected and 
turned on, you can start the polarizationNAVIGATOR™ software and run 
the Configuration Wizard.

On first startup the Configuration Wizard will come up automatically. If 
you want to rerun the Configuration Wizard, you can click on the button 
named Wizard or click on Tools > Configuration Wizard in the menu.

Please follow the instructions shown in the dialog box.

Instruments of the N778xBD family only require execution of the 
Configuration Wizard if external devices are connected via GPIB (e.g. 
tunable laser sources).
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Using the N778xB/BD GPIB Interface (Remote GPIB)

The N778xB/BD instrument can be used as GPIB-Master to control 
third-party instruments. This mode is referred to as Remote GPIB. In that 
case, the N778xB/BD has to be connected to the PC via the USB port.

We recommend connecting your GPIB instrument to the GPIB port of the 
N778xB/BD instrument and running the Configuration Wizard.

Go to Tools > Options > Remote GPIB to change the settings manually. If 
you have one or more N778xB/BD instrument connected to your PC via 
USB, you can select the instrument you want to use as remote GPIB 
interface by its accordant serial number listed in the drop-down menu. For 
using the internal GPIB interface of an external computer please choose 
PC internal (VISA).

NOTE
The polarizationNAVIGATOR™ software fully supports the remote GPIB 
port. However, it does not behave like a standard GPIB interface for other 
software such as LabView™.
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Changing the GPIB Address

The default GPIB address of the N778xB/BD is set to 30. To change the 
GPIB address, proceed as follows:

• Make sure that the N778xB/BD is the only instrument connected to the 
GPIB interface and turn it on.

• Start the polarizationNAVIGATOR™

• If the instrument is not yet listed in the browser tree click on 
Tools > Scan for Instruments and scan for new GPIB instruments. If not 
shown automatically, the browser bar can be accessed from the View 
menu. The instrument should be detected with its current GPIB address 
(factory setting: 30). One or more new items appear in the browser tree 
representing the instrument. Some instruments are listed as 
Polarimeters, as Polarization Controllers, as both or as Misc. 
Instruments. The N7783B is not listed as an individual instrument.

• Show the properties dialog of the instrument by right-clicking on its 
item and choosing Properties

• Click on Change at Device on the Interface-Tab.

• Enter new GPIB address (10..30) and click on OK.

• Turn the instrument off and back on to apply the changed address.

• In the Properties dialog click on OK.

• Run the Configuration Wizard again.
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Options

Table 4  Keysight Options 1

Keysight Option No Narrative Description

N7781B Polarization Analyzer

N7781B-300 Polarization Analyzer, 1270nm to 1375nm

N7781B-400 Polarization Analyzer, 1270nm to 1375nm and 1460nm 
to 1620nm

N7781B-500 Polarization Analyzer, 1460nm to 1620nm

N7781B-021 straight contact connector

N7781B-022 angled contact connector

N7782B PER-Analyzer

N7782B-101 PER-Analyzer, 850nm to 1000nm with 850nm VCSEL

N7782B-400 PER-Analyzer, 1270nm to 1375nm and  1460nm to 
1620nm

N7782B-401 PER-Analyzer, 1270nm to 1375nm and 1460nm to 
1620nm with 1300nm / 1550nm dual VCSEL

N7782B-500 PER-Analyzer, 1460nm to 1620nm

N7782B-501 PER-Analyzer, 1460nm to 1620nm with 1550nm VCSEL

N7782B-021 straight contact connector

N7782B-022 angled contact connector

N7783B Thermal Cycling Unit

N7784B Polarization Controller

N7784B-021 straight contact connector

N7784B-022 angled contact connector

N7785B Synchronous Scrambler

N7785B-021 straight contact connector

N7785B-022 angled contact connector

N7786B Polarization Synthesizer
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N7786B-400 Polarization Synthesizer, 1270nm to 1375nm and 
1460nm to 1620nm

N7786B-500 Polarization Synthesizer, 1460nm to 1620nm

N7786B-021 straight contact connector

N7786B-022 angled contact connector

N7788B Optical Component Analyzer 

N7788B-300 Optical Component Analyzer, 1270nm to 1375nm

N7788B-400 Component Analyzer, 1270nm to 1375nm and 1460nm 
to 1620nm

N7788B-500 Optical Component Analyzer, 1460nm to 1620nm

N7788B-021 straight laser input Port

N7788B-022 angled laser input Port

N7788B-031 straight DUT Port

N7788B-032 angled DUT Port

Keysight Option No Narrative Description
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Table 5  Keysight Options 2

Keysight Options No Narrative Description

N7781BD Polarization Analyzer

N7781BD-300 Polarization Analyzer, 1270nm to 1375nm

N7781BD-400 Polarization Analyzer, 1270nm to 1375nm and 
1460nm to 1620nm

N7781BD-500 Polarization Analyzer, 1460nm to 1620nm 

N7781BD-021 straight contact connector

N7781BD-022 angled contact connector

N7788BD Optical Component Analyzer

N7788BD-300 Optical Component Analyzer, 1270nm to 
1375nm

N7788BD-400 Component Analyzer, 1270nm to 1375nm and 
1460nm to 1620nm 

N7788BD-500 Optical Component Analyzer, 1460nm to 
1620nm

N7788BD-021 straight laser input Port

N7788BD-022 angled laser input Port

N7788BD-031 Straight DUT Port

N7788BD-032 Angled DUT Port
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Operating N778xB/BD instruments

When the polarizationNAVIGATOR™ is started it will not automatically 
perform any measurements. The application bar will list all installed 
applications, while the browser window will show an icon for each 
N778xB/BD or supported external instrument (e.g. tunable laser sources) 
that has been either added by using the Configuration Wizard or added 
and configured manually and that can be directly interacted with. The 
N7783B for example will not be listed here. 

The browser window can be shown or hidden, by setting or removing the 
checkmark in front of the browser bar entry in the View menu. The 
installed applications are listed in the Applications section of the browser 
bar, in case of an N778xB, and in the top button row, in case of an 
N778xBD. If an application is activated, it will automatically activate the 
associated and required instruments. From the browser bar, an application 
is activated by double-clicking or by choosing Activate from the context 
menu. In the GUI of an N778xBD instrument, a single click on the buttons 
in the top row will activate the application. In case you have several similar 
instruments connected to the PC that the polarizationNAVIGATOR™ is 
running on, you might want to activate individual instruments from the 
browser bar.

A green arrow indicates that an instrument is activated, i.e. 
communication has been established. Before using an instrument with the 
polarizationNAVIGATOR™ it has to be activated either directly or by 
activating the corresponding application. An application may activate 
several instruments at once, which will be indicated by a yellow lock 
symbol.

Double-click on an instrument to activate it (or click on activate in its 
context menu). The polarizationNAVIGATOR™ can activate instruments 
automatically at startup. To use this feature, check Activate On Startup in 
the instruments context menu. After activation, a green arrow should 
appear on the icon of the instrument in the browser bar.

In the browser bar there will appear sub-items below an activated 
instrument or application, allowing you to choose between different types 
of view of the acquired data, as well as providing access to instrument or 
application specific settings. 

The PMD/PDL/Loss- Application, for instance, will activate a tunable laser 
source and N778xB/BD instruments for polarization analysis and 
polarization control. If any of the instruments required for the specific 
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application is missing, there will be an error message and the application 
won't open. This may also occur if the application has been used with a 
different instrument that is no longer available.

Refer to Application: Polarimeter on page 74 for a detailed description of 
the polarimeter functions.

Refer to Application: PMD/PDL (PMD/PDL/Loss) on page 87 for a detailed 
description of the component test functions, i.e. Loss, PMD, PDL 
measurement.

Refer to Application: PER/PMF Crosstalk on page 103 for a detailed 
description of the functions for measuring the polarization extinction ratio 
in a polarization maintaining fiber and for measuring the splicing angle 
between two polarization maintaining fibers.

NOTE
You can add applications by right-clicking the root of the 
application-node and selecting "add". To reset the linkage of an 
application to certain instruments, you can delete the application using 
the "delete" key and re-adding it. On next activation, the application will 
try to find the necessary instruments again.

NOTE
A proper light source has to be connected to the instrument for 
performing measurements. N7782B with certain options already 
includes such a laser source.
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Operating N778xBD instruments

Use the supplied power cable to connect the instrument to a power 
socket. Depending upon the previous state of the instrument it may power 
up immediately. Otherwise push the button at the left of the instruments 
front plate. The computer will boot Windows and will auto-login with 
administrative privileges. In case you need to login manually, use:

User: Administrator

Password: sphere314

The polarizationNAVIGATOR™ software will start up automatically after 
login. Once closed, it can be started manually using the icon on the 
desktop or the entry in the start menu.

Throughout the system the touch screen acts as a mouse. For right click 
operations there is an always-on-top icon, which will turn the next touch 
to a right-click touch. If this icon is not on the screen it can be reactivated 
from the system tray by clicking on the pm-icon and setting a mark next to 
the Right button. You will have to quit the polarizationNAVIGATOR™ in 
order to access the system tray.

In addition, the knob on the front plate can be used for cycling through 
lists of buttons and for changing numerical values. Pressing the wheel is 
similar to pressing the OK button and will push a button or accept a 
numerical value. The ESC key will toggle between menu access (File, Edit, 
View, etc.) and button access and it will abort changing numerical values. 
The Left Arrow and Right Arrow buttons will switch between different 
graphs (PMD, PDL, DOP, Stokes-Parameters, etc.) and will change the 
cursor position in dialog boxes. For most dialogs, special 
on-screen-keyboard-dialogs will appear. In case you need to enter 
additional characters, Windows provides an always-on-top on-screen 
keyboard, which can be activated by pressing the wheel twice in quick 
succession. For using this feature, the polarizationNAVIGATOR™ has to be 
running. A link to the on-screen keyboard is placed on the desktop, which 
can be used otherwise. When powering up the instrument, it will log on 
automatically. To login again after logging out, you can use the on-screen 
keyboard which is displayed at the bottom of the login screen. Enter 
username and password provided at the beginning of this section.

Furthermore, USB and PS/2 keyboards and mice can be connected to the 
N778xBD.

Using any of these controls, choose an application and use the control 
buttons for setting the specific parameters and controlling the application. 
Usually the horizontal row of buttons switches between several subsets of 
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functions or parameters, which are then listed as a column of buttons to 
the right. There may be more items in a horizontal or vertical set than 
buttons. In this case More will be among the set of buttons. Usually you 
will find an Exit button, which will stop the active application. The actual 
parameters and functions are similar to those described in the specific 
chapters of the manual (N7781B/BD: see Application: Polarimeter on 
page 74 and N7788B/BD: see Application: PMD/PDL (PMD/PDL/Loss) on 
page 87).

Network Access

Measurements are stored in D:\My Documents\My PolarizationNavigator 
Files and D:\My Documents\My PolarizationNavigator History.

You can access these files from a remote computer by using the Windows 
Explorer, the Internet Explorer or an FTP client. When connected through a 
local area network, you can use the instruments name, which is its serial 
number to access the folders, e.g.:
ftp://DE47800301/Measurements/

ftp://DE47800301/History/

When connected through the Internet, you have to use the IP address of 
the instrument to access the folders, e.g.
ftp://192.168.0.1/Measurements/

ftp://192.168.0.1/History/

For accessing these folders, you have to login with the following 
information

User: Administrator

Password: sphere314

NOTE
You can find the IP address of the instrument by using the corresponding 
polarizationNAVIGATOR™ function from the Tools menu or by running 
the ipconfig command from the command prompt if you have a 
keyboard connected.
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Remote Control

The N778xBD can be controlled remotely. Doing this you can either use 
the Remote Desktop Connection tool of Windows XP or a web interface 
based on an Active-X control. The N778xBD is configured to listen for 
remote access requests. Routers and Firewalls have to be configured to 
allow TCP port 3389 for Remote Desktop access and TCP port 80 for the 
web based interface.

Remote Desktop Connection Tool

On the computer from which you want to remote-control the instrument 
open the start menu and run Programs > Accessories > Communications 
> Remote Desktop Connections. If the instrument is in the same local 
network it can be addressed by the instruments serial number of the 
instrument (e.g. DE48200001). If the instrument is not in the same local 
network, you have to enter the IP address of the instrument instead of its 
name. You then are prompted with the remote login screen and have to 
login as administrator.

User: Administrator

Password: sphere314

Web-Interface

You can use the Internet explorer to connect to the IP address of the 
instrument at port 80 and choosing the sub-folder called agilentRL (e.g. 
http://192.168.1.1:80/agilentRL). For using the remote control access you 
need a certain Active-X plugin provided by Microsoft, which will be 
installed automatically the first time you visit this URL.

NOTE
When using the Internet Explorer, you have to make sure that FTP is set 
to active mode. You can do this by opening the menu Tools, choosing 
Internet Options..., selecting the tab Ad vanced and removing the mark 
from Use passive FTP (for Firewall and DSL modem compatibil ity) in the 
section Browsing. This may also apply when using other FTP tools.
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You will then be prompted to enter the server name, i.e. its IP address, if 
you connected using the IP address or the instruments serial number (e.g. 
DE47800301) if you connected using the instruments name. In addition 
you can choose the screen resolution (640x480 is the native resolution of 
the instrument). After pressing Connect you have to press space or a 
mouse button to gain control of the remote instrument. You then are 
prompted with the remote login screen and have to login as administrator.

User: Administrator

Password: sphere314

You can create a link like this

http://x.x.x.x/agilentRL/?Server=x.x.x.x&AutoConnect=1&FS=1

to skip the configuration screen, where x.x.x.x is the IP address or the 
name of the remote instrument.

NOTE
There may appear an error message in your browser window if you 
choose Full Screen and have the desktop resolution of the computer that 
you’re logging on to the N778xBD with set to a very high resolution. Try 
logging in while choosing a lower resolution in the web interface or by 
changing the desktop resolution of the computer that you’re logging in 
with.
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Rebooting the Remote System

You can force a reboot of the remote instrument by pressing 
CTRL-ALT-END in the remote session and then select 
Shut Down > Restart.

Recovery Console

The N778xBD instruments provide an emergency recovery tool. If the 
system is corrupted, you can connect a keyboard to the instrument and 
press ESC during the boot process. You will be prompted to do so while 
still in text mode. You can then select the Recovery Console from the boot 
menu and will be guided through the recovery process. This recovery tool 
will only recover the C:\ drive, i.e. the system drive. It will reset the 
polarizationNAVIGATOR™ to the version the instrument has been delivered 
with. Therefore the polarizationNAVIGATOR™ may prompt you for 
updating the instruments firmware, if you have performed any updates 
since purchasing the instrument. You will have to re-apply any such 
updates after the recovery. The D:\ drive, which contains your 
measurements, will not be modified during the recovery.
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General

Shown in the following sections are, among other information, screenshots 
of the polarizationNAVIGATOR™ software running in the Integrated PC 
Mode, which is used for instruments of the N778xBD series. When clicking 
buttons from the top row in this mode, the button columns to the right will 
change. Sometimes there are more function buttons than the number of 
available slots in the respective row or column. In that case there will be a 
button labeled More..., which will replace the row/column with another set 
of buttons. If the polarizationNAVIGATOR™ is running on a desktop or 
notebook PC with N778xB/BD instruments connected to it, it will be 
running in External PC Mode, which basically supports the same functions 
with a slightly different screen layout. Sections of screenshots from the 
polarizationNAVIGATOR™ in the External PC Mode are shown for specific 
functions as well.

Table 6  Instruments that support certain applications

Application Supporting instruments 

“Application: Polarimeter” N7781B/BD, N7786B*, N7788B/BD

“Application: PMD/PDL 
(PMD/PDL/Loss)”

N7788B/BD

“Application: PMD/PDL/Loss 
(Stepped)”

N7788B/BD

“Application: PER/PMF Crosstalk” N7781B/BD, N7782B, N7786B†, N7788B/BD

“Application: Polarimeter 
Calibration”

N7781B/BD, N7786B, N7788B/BD

“Application: Manual Waveplate 
Control”

N7784B, N7785B, N7786B, N7788B

“Application: Random Polarization 
Scrambling”

N7784B, N7785B, N7786B, N7788B

“Application: Sequence 
Operation”

N7784B, N7785B, N7786B, N7788B

“Application: Continuous 
Scrambling”

N7784B, N7785B, N7786B, N7788B

“Application: Polarization 
Stabilization”

N7784B, N7785B, N7786B, N7788B
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* The N7786B instrument is able to perform all polarimeter operations described in section
Application: Polarimeter on page 74. Keep in mind, though, that since the polarimeter of 
the N7786B is in the monitor path of the device, the optical power at the polarimeter is about one 
tenth (-10dB) of the power at the polarimeter in an N7781B/BD. This is included in the instruments 
calibration, so the power readout will be ok, but the minimum input power of the instrument will be 
increased by about 10dB.

† see previous footnote
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Application: Polarimeter

Choosing the Wavelength

To obtain accurate measurement results the operation wavelength of the 
light source has to be provided. If you have not already done so, open the 
Settings window of the N778xB by clicking on the Settings entry in the 
browser window. Enter the wavelength and choose a sweep rate of 
0 nm/s. If a TLS is activated1 and the mark Take from TLS is set, the 
polarimeter wavelength will be updated automatically if the laser 
wavelength is changed using the polarizationNAVIGATOR™. The 
polarimeter wavelength will not be updated if the laser wavelength is 
changed at the laser front panel. In the Integrated PC Mode (N778xBD) 
open the corresponding button subset by clicking Sampling Settings.

Auto Gaining

To provide a wide range of input power, the polarimetric receiver has 14 
different input gain settings (0=lowest sensitivity, 13=highest sensitivity). 
Usually the instruments choose the correct input gain settings to achieve 
optimum performance. You can suppress the gain switching by removing 
the check on the Auto field next to the gain display.

1 This needs to be configured and will be listed under Misc. Instruments.



Keysight N778xB User’s Guide 75

Applications 4

 

The Oscilloscope Mode

The default operation mode is Oscilloscope. In this mode, data is sampled 
at a constant sampling rate. You can choose the desired number of 
samples.

The sampling rate together with the number of samples determines the 
observed time scale. The number of samples is defined by setting the 
Post-Trigger Samples value, even when no external trigger is used.

There are two options in this mode: Continuous and Oneshot. In the 
continuous mode, the measurement is restarted after receiving a trace. In 
oneshot mode the acquisition has to be manually (re)started by pressing 
the button next to the list box or by pressing Trigger, when using the 
Integrated PC Mode. To stop measuring in continuous mode select Hold 
from the drop-down menu or by pressing Stop respectively.
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Triggering

You can synchronize the start of a measurement cycle to certain events 
such as an external trigger signal.

When using an N778xB instrument, trigger settings are configured using 
the Trigger list box. When using an N778xBD instrument, trigger settings 
are accessed by pressing the Trigger Source button in the Sampling 
Settings sub-bar.

Select TTL High or TTL Low to choose the desired trigger edge of an 
externally applied digital signal. The signal has to be applied to the BNC 
input named Trig. In. The actual measurement is performed continuously, 
so the trigger event defines the portion of the measured data stream to be 
shown. You can set the number of samples to be stored from right before 
the trigger event (Pre-Trig. Samples) and right after the trigger event 
(Post-Trig. Samples).

Choose SOP Change if you want to trigger on a changing SOP. You can set 
the sensitivity by pressing on Sensitivity. In the example, a trigger event is 
detected when the SOP changes by at least 3 degree on the Poincaré 
sphere within a time interval of 10 ms. Note that in principle you could 
achieve the same sensitivity by choosing different values (e.g. 1,5 deg and 
5 ms). However this may cause false trigger events due to measurement 
noise.

In the External PC Mode (N778xB) the SOP Change parameters, like 
angular sensitivity, are accessed by clicking on the Sensitivity button, 
which will show up when the SOP Change mode is active. In the Integrated 
PC Mode (N778xBD) these settings are located in the SOP Change sub 
section. You can also set the number of samples to be stored from before 
the SOP change event (Pre-Trig. Samples) and after the SOP change event 
(Post-Trig. Samples).
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Setting an SOP reference frame

Since the polarimeters in the N778xB/BD instruments are connected with 
single-mode fibers, there is no absolute SOP reference frame, i.e. the 
Stokes parameter system displayed by the polarizationNAVIGATOR™ is 
rotated by an arbitrary amount with respect to the system with s1, s2, s3 
being the directions of horizontal/vertical, +/-45° and left/right circular 
polarization. If the absolute state of polarization at some point of the setup 
is known and controllable, you can rotate the Stokes readout to 
compensate for the rotations introduced by single-mode or polarization 
maintaining fibers in the system, as long as there are only such fibers or 
components that rotate the state of polarization, i.e. they must not exhibit 
a significant amount of PDL.

You need to set two states of polarization that are orthogonal in Stokes 
space, i.e. e.g. horizontal and +45°. Set the first state of polarization at 
your reference point in the setup. Go to Tools > Set SOP Reference, select 
the corresponding SOP from the top drop-down list, press SET, then OK. 
Set the second state of polarization at your reference point in the setup. 
Repeat the steps described above. You can remove a reference frame by 
pressing CLR for both SOPs in Tools > Set SOP Reference. Using SOPs 
that do not fulfill the above mentioned requirements will result in invalid 
readouts for the DOP and the Stokes parameters.
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The Trace Mode

In Trace mode, data is sampled with a fixed sampling rate of 2.5 kHz and 
stored only if the SOP has changed by a certain amount. The sensitivity 
can be adjusted by the ”Trace Sensitivity” value. A value of 0.02 will record 
a new SOP when the normalized SOP has changed my more than 0.02 on 
the Poincaré sphere. A value of 0.00 will record SOPs with a constant 
sampling rate of 2.5 kHz. The displayed buffer operates like a FIFO 
(first-in-first-out) buffer. Thus the oldest SOPs are discarded when new 
SOPs are stored. The number of SOPs stored is controlled by the 
Post-Trig. Samples value. Switch to the Stokes-window and change the 
input polarization to see how SOPs are stored in this mode. You can clear 
the current trace by choosing Clear Measurement from the Edit menu or 
by pressing F2.

Saving Measurements / Snapshots

You can save measurement data using the Save as option from the File 
menu and providing a filename or by pressing the Quick Save/Savequick 
button. This will assign an automatic filename and store it in the folder \My 
Documents\My PolarizationNavigator Files. The name format for these 
automatically generated filenames can be configured in the Save tab of 
the Options dialog in the Tools menu (the default is the current date with 
an increasing counter). Alternatively you can make a snapshot by pressing 
the camera button on the left side of a window. The current measurement 
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is transferred to the Gallery shown in the browser window, but not saved at 
this time. This allows you to compare different measurements with each 
other. In addition, the most recent files will be placed in your \My 
Documents\My PolarizationNavigator History folder. 

You can change the default folders for measurement and for history files in 
the General > Path Settings tab of the Options dialog in the Tools menu. 
Here you can also set the maximum number of history files to be kept.

Loading Measurements / Snapshots

Saved files can be accessed through the Open... dialog from the File 
menu, by pressing Open or by opening the corresponding file using the 
Windows Explorer. Open files will be listed in the Gallery portion of the 
browse tree. When using an N778xBD, you can cycle through open 
windows (saved documents as well as activated applications) by pressing 
the Next Window button in the top row. The content of the \My 
Documents\My PolarizationNavigator Files and \My Documents\My 
PolarizationNavigator History folders can also be accessed from the 
respective entries in the browser bar.
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NOTE
When you press the camera button a new gallery entry is created and a 
new window is opened. This also happens if you open a saved document. 
Any running application remains active in the background. You can cycle 
through open documents and active applications by either clicking on 
the corresponding entry in the browser bar, by choosing entries in the 
Windows menu, by pressing CTRL+F6 or by using the Next Window 
button in the top button row of the N778xBD interface.

NOTE
The gallery is not stored on the hard disk. You have to click on Save or 
Save As to save the measurement displayed in the current window.
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Exporting Measurement Data

Measurement data can be exported to different file types (e.g. ASCII, CSV). 
You can export the current measurement by selecting Export from the File 
menu, providing a file name and choosing the desired file format from the 
drop-down list. For details on supported file formats refer to ASCII File 
Formats on page 338.

Graph Views

Graph views are used to display the normalized Stokes parameters, the 
DOP and the power versus time. Use the mouse (or touch pen) to zoom 
into the plot by clicking and drawing a rectangle. Double-click the graph 
area to reset the zoom. Double-click the trace to set the axis properties. By 
this you can manually set the axis ranges. Basic scaling changes and 
marker settings are performed using the buttons to the top right of the 
graph window or by using the Scaling and Markers button subsets, which 
can be accessed from the top button row of an application or document in 
Internal PC mode. The buttons have the following functions:

• Autoscale X-Axis - Toggle button. If set, the x-axis settings are 
automatically changed to always show the whole plot. 

• Autoscale Y-Axis - Toggle button. If set, the y-axis settings are 
automatically changed to always show the whole plot. 

• Include Zero - Toggle button. When auto-scaling is active, the 
Y-scaling is chosen to include 0. This is especially useful when viewing 
e.g. the DOP.

• Show/Hide Comment - Toggle button. Toggles a Window containing 
information about the measurement.

• Add Marker - Add a Marker to the current measurement.

Markers can be moved by left-clicking them and holding the left mouse 
button (or using the touch pen) while moving the marker. If the current 
graph view contains a single trace (DOP, power), the marker will be an 
X/Y-marker, i.e. it will stick to the trace and display the X and Y values for 
the marked point on the trace. If the graph contains several traces (Stokes 
parameters), the marker will be a Vertical Marker, i.e. it will just mark and 
display an X value. When switching between the graph view tabs, the 
markers will stay at their chosen X positions and may change their vertical 
behavior, depending upon the type of data displayed. In the External PC 
Mode, the marker behavior can be toggled manually from the marker 
context menu, which is brought up by right-clicking the marker. In the 
Internal PC mode, the marker settings can be accessed by choosing the 
Markers sub-set from the top button row of the application or document; 
from these menus, the markers can be deleted as well. Markers will be 
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erased if a new measurement is performed. Before working with markers, it 
is therefore recommended to stop the measurement by setting the 
acquisition mode to Hold in the External PC mode or by pressing Stop 
from the Sampling Mode button sub-set in the Integrated PC Mode.

The Graph Bar

These buttons on the left side of the window are not always shown. You 
can toggle this Graph Bar from the View menu. The buttons on the left 
side of the window have the following functions:

• Toggle X-axis unit - Toggles between the display of the appropriate 
unit (e.g. ms, nm) and the display of an increasing counter (number 
datapoints).

• Linear/dB power plot - Toggles between a logarithmic (dB) and a 
linear power scale.

• X-Unit - Selects the desired unit modifier (e.g. pm, nm etc.)

• Y-Unit - Selects the desired unit modifier (e.g. nW, mW etc.)

• Graph Properties - Opens the Graph Properties dialog box.

• Restore Last Scaling - If zoomed into a plot, this restores the previous 
scaling.
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The Poincaré View

As described before, you can choose different views for the same 
measurement data. One of these views is the Poincaré sphere window. You 
can rotate the sphere by clicking onto the sphere and dragging the mouse 
with the left mouse button held down. 

In addition there’s a toolbar to the left of the graph view. 

The Graph Bar

These buttons may not always be shown. You can toggle this Graph Bar 
from the View menu.

The buttons have the following functions:

• Show Gallery Measurements - Displays all measurements of the 
gallery in the same sphere. This is especially useful for comparison 
purposes.

• Line/Point Display - Toggles between line-mode (all SOPs are 
connected by lines) and point mode (each SOP is displayed as isolated 
point).

• Show Marker - Displays stored markers (see next button)

• Store Marker - Adds the current SOP to a list of markers. If more than 
one marker is stored, the angular difference is displayed on the right 
side of the window. Markers are cleared if another display tab (graph 
view) is chosen.

• Clear All Markers - Clears the list of markers

• Show PER - The polarization extinction ratio (PER) of light in 
a PMF can be determined by creating circle trajectories on 
the Poincaré sphere. This can be done in Realtime mode by 
either changing the wavelength or by slightly stretching or 
twisting the PMF. When you see the circle trajectory, press 
this button to calculate the PER. Press the button again to 
remove the displayed PER. 

• Poincare View Zoom - By pressing this button, a slider 
appears that allows you to zoom in and out of the Poincaré 
View. The same behavior is achieved by using the wheel of 
an attached mouse.

Power Unit and Reference Power

Pressing the button below the power or DOP bar will bring up a context 
menu. Here you can choose the power unit (mW, dBm, dB) and store the 
current power value as a reference which is later on used for the dB 
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representation. Furthermore you can choose which portion of the trace is 
used for the numerical Poincaré view displays (e.g. start of trace, sample 
with maximum power, average). 

Data Logging

The N778xB/BD instruments support data logging, i.e. you can define an 
interval at which measurements will be stored. In between the instrument 
continues to perform measurements and refreshes the display but does 
not save these intermediate measurements to disk. Before starting a 
logging session you should set appropriate parameters like sampling rate, 
number of samples per measurement (Post-Trig. Samples) and gain.

In the External PC Mode, a wizard will guide you through the setup of the 
actual logging parameters after you press Start Logging. This wizard is 
going to be described first. Using the logging feature in the Internal PC 
mode is described further below.

First you have to choose whether to store the measurements in a single 
file or as multiple files, i.e. one file for each individual measurement. A 
single document should be chosen only for small logging series, since all 
data is stored in memory until the logging sequence has stopped and 
saved to disk. Long logging series should be stored as separate files, since 
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no memory restrictions apply, except for the total free space on the hard 
disk. In addition the measurements are each saved to disk, which can be 
useful in case of, for example, a power failure.

The next step is to set the Logging Interval in seconds, the maximum 
number of measurements to log and the filename body. The filename body 
is used as the first part of the automatically generated filename, followed 
by an increasing counter. If Maximum Logs is set to zero, measurements 
will be logged until you press Stop logging.

During the logging process there will appear a small window, informing 
about the current logging state.

Once the logging has been stopped, there will be a dialog, allowing you to 
immediately open the logging series. Opening a very long series that has 
been saved to separate files can take some time.

When a logging series has been opened, there will be a horizontal slider 
below the data figures, allowing you to navigate within the series.

In the Integrated PC Mode, the logging parameters described above can 
be set directly in the Logging section that is accessed from the top button 
row of the application.
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Importing Logging Series

If logging data has been saved to a single file before, it can be opened 
using the opening functions described above (see section Loading 
Measurements / Snapshots on page 79). If logging data from a single 
series has been stored to individual files you need to use the Import Series 
function, which can be found in the File menu, as well as in the right 
button bar when using the Integrated PC mode. Choosing Import Series 
will bring up a file dialog in which you have to choose the folder that the 
logging files have been stored in (by default this is an automatically 
generated sub-folder of your \My Documents\My PolarizationNavigator 
Files folder). You have to navigate into the specific folder and press the 
Open button. It does not matter which file of the logging series has been 
selected before.

If the logging series had been stored in individual files, there will be a 
dialog when closing the document or exiting polarizationNAVIGATOR™ 
that asks you about saving the changes. Actually the data itself has not 
been altered, but at this point, the polarizationNAVIGATOR™ suggests you 
save the whole series in a single file. By doing this, you can avoid importing 
the data the next time you’re working with it. On the other hand this will 
create a file of about the same size as the initial set of files, which can be 
quite a large number. 

Streaming SOP Data to Hard Disk

When sampling mode is set to Trace, the logging function acts slightly 
differently. Instead of performing measurements at predefined intervals, 
starting logging in trace mode will stream the measured data into an ASCII 
file (see ASCII File Formats on page 338 for details on the data format). In 
this file you will find rows containing the four not normalized Stokes 
parameters in mW (S0 represents the optical power) and the DOP.

NOTE
SOP/DOP data logging can be combined with the SOP Change trigger 
mode. By setting the logging interval to zero and choosing appropriate 
sensitivity parameters in the trigger configuration, events can be 
monitored over long periods of time without storing unnecessarily large 
amounts of data.
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Application: PMD/PDL (PMD/PDL/Loss)

Use this application for PDL/PMD sweep measurements. It uses a 
continuous sweep of the tunable laser source (TLS) to measure the 
following parameters versus wavelength:

• PDL, Best Case SOP (i.e. SOP with the maximum transmission 
coefficient, denoted PDLPSP)

• Pmin/Pmax

• Power/Loss

• DGD, PSP, second-order PMD (denoted PMD2nd)

See Measurement Setup on page 99 for details on how to connect the DUT 
and the trigger cable.

Before starting a measurement you should check or set the measurement 
parameters.

Application Setup Parameters

When using External PC mode, the measurement control buttons are 
displayed in the top left portion of the application window, the 
measurement parameters are shown to the right of these and the 
evaluation parameters are shown even further to the right. When using 
Integrated PC mode, the measurement control buttons can be found in the 
Control sub-set, the measurement parameters in the Setup sub-set and 
the evaluation parameters in the Post Process sub-set. Details of those 
parameters are given in the table below. 

Table 7  Application PDL/PMD Setup Parameters

Parameter Description

Start wavelength (nm): Defines the start of the wavelength sweep.

Stop wavelength (nm): Defines the stop of the wavelength sweep.

Sweep rate (nm/s): Defines the nominal sweep rate of the laser. 
Note, that the number of data points changes 
with the sweep rate since the sampling rate is 
constant. The resulting number of samples are 
shown in the field Samples.

Laser Power (dBm): Defines the optical output power of the laser 
source.
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Dynamic Range (Low/ Med/ High): Sets up the power dynamic range of the 
measurement. A dynamic range of 
approximately 20dB can be achieved within a 
single laser sweep. Higher dynamic ranges are 
achieved by performing several sweeps with 
different input amplifier gain settings.

Samples: Shows the estimated number of samples.

Current Gain: Shows the current gain setting of the input 
amplifiers (0=lowest sensitivity, 13=highest 
sensitivity). Each step changes the allowed 
optical input power range by approximately 
3dB.

Auto Gain: Defines if the next measurement is done using 
the autogaining feature, otherwise the 
measurement will be done using a fixed gain. 
Autogaining is recommended for DUTs with 
high dynamic loss range (e.g. filters).

Use LLOG: Keysight tunable laser sources provide a 
built-in optical wavemeter to increase 
wavelength accuracy. Check this box to use 
the internal wavemeter functionality (Lambda 
Logging).

Reference: If a reference measurement is done you can 
select whether it will be used for the 
measurement or not. If more than one 
reference is available, you can choose between 
those.

Resolution (nm): Defines the width of the averaging window as 
well as data interleaving. Use smaller values 
for a better wavelength resolution.

Parameter Description
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Performing Measurements

In the Integrated PC Mode, measurements are performed by using the 
buttons in the Control subset, while in External PC Mode these buttons are 
always shown.
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Performing a Preview Measurement

A preview measurement can be performed to check power/loss levels of a 
DUT. Evaluation is faster than a standard measurement, but it contains no 
information on PDL or DGD. Connect the DUT and enter the desired 
settings (see Application Setup Parameters on page 87). Then press 
Preview. A preview measurement is performed and a power/loss trace is 
acquired. 

Performing a Non-Referenced Measurement

Connect the DUT and enter the desired settings (see Application Setup 
Parameters on page 87) then press Run Single or Run Repeat. Referenced 
measurements allow for maximum PDL and Loss accuracy. Referenced 
measurements typically do not increase DGD accuracy.

Performing a Referenced Measurement

Connect a patchcord to the DUT ports, enter the desired settings (see 
Application Setup Parameters on page 87) and perform a reference 
measurement by pressing Take Reference. Then connect the DUT and 
press Run Single or Run Repeat. Best performance will be achieved in this 
mode. A referenced measurement requires the reference sweep to cover 
the whole range of the DUT sweep, therefore the measurement 
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parameters should be entered before taking the reference, or the 
reference sweep chosen should be large enough to be able to vary the 
DUT sweep wavelengths later on.

Saving Measurements / Snapshots

You can save measurement data using the Save as option from the File 
menu and providing a filename or by pressing the Quick Save / Savequick 
button. This will assign an automatic filename (current date with 
increasing counter) and store it in the folder \My Documents\My 
PolarizationNavigator Files. The name format for these automatically 
generated filenames can be configured in the Save tab of the Options 
dialog in the Tools menu (the default is the current date with an increasing 
counter). Alternatively you can make a snapshot by pressing the camera 
button on the left side of a window. The current measurement is 
transferred to the Gallery shown in the browser window, but not saved at 
this time. This allows you to compare different measurements with each 
other. In addition, the most recent files will be placed in your \My 
Documents\My PolarizationNavigator History folder.

You can change the default folders for measurement and for history files in 
the General > Path Settings tab of the Options dialog in the Tools menu. 
Here you can also set the maximum number of history files to be kept.
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Loading Measurements / Snapshots

Saved files can be accessed through the Open... dialog from the File 
menu, by pressing Open or by opening the corresponding file using the 
Windows Explorer. Open files will be listed in the Gallery portion of the 
browse tree. When using an N778xBD, you can cycle through open 
windows (saved documents as well as activated applications) by pressing 
the Next Window button in the top row. The content of the \My 
Documents\My PolarizationNavigator Files and \My Documents\My 
PolarizationNavigator History folders can also be accessed from the 
respective entries in the browser bar.

NOTE
When you press the camera button a new gallery entry is created and a 
new window is opened. This also happens if you open a saved document. 
Any running application remains active in the background. You can cycle 
through open documents and active applications by either clicking on 
the corresponding entry in the browser bar, by choosing entries in the 
Windows menu, by pressing CTRL+F6 or by using the Next Window 
button in the top button row of the N778xBD interface.
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Exporting Measurement Data

Measurement data can be exported to different file types (e.g. ASCII, CSV). 
You can export the current measurement by selecting Export from the File 
menu, providing a file name and choosing the desired file format from the 
drop-down list. For details on supported file formats refer to ASCII File 
Formats on page 338.

Performing Measurements associated with Serial Numbers

This mode is used if you want to characterize a number of similar DUTs 
and store the data with a reference to the devices’ serial numbers. Make 
sure to set measurement parameters (e.g. wavelength range) before 
performing the first measurement. You may also perform a reference 
measurement before starting the first measurement (see Performing a 
Referenced Measurement on page 90). Measurements associated with 
serial numbers are performed by pressing Run Serial.

NOTE
The gallery is not stored on the hard disk. You have to click on Save or 
Save As to save the measurement displayed in the current window.
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In the dialog you can enter a DUT description, a Part Number, the Serial 
Number of the current DUT, as well as the path where the files should be 
saved and whether to automatically generate a pdf report. The files will be 
saved in the specified path with the serial number as file name. An actual 
measurement is performed every time you change the serial number and 
press the Enter key or the Apply button. When using Integrated PC mode, 
the on-screen keyboard can be used to enter the serial numbers if no 
external keyboard is attached to the N778xBD.

Exit this measurement mode by pressing Stop Measurement and closing 
the dialog window.

Data Logging

The N778xB/BD instruments support data logging, i.e. you can define an 
interval at which measurements will be stored. Before starting a logging 
session you should set appropriate parameters like wavelength range, 
dynamic range and gain.

In the External PC Mode, a wizard will guide you through the setup of the 
actual logging parameters after you press Start Logging. This wizard is 
going to be described first. Using the logging feature in the Internal PC 
mode is described further below.

First you have to choose whether to store the measurements in a single file 
or as separate files. A single document should be chosen only for small 
logging series, since all data is stored in memory until the logging 
sequence has stopped and saved to disk. Long logging series should be 
stored as separate files, since no memory restrictions apply, except for the 
total free space on the hard disk. In addition, the measurements are saved 
to each disk, which can be useful in case of, for example, a power failure.
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The next step is to set the logging interval in seconds, the maximum 
number of measurements to log and the filename body, which is used as 
the first part of the filenames, followed by an increasing counter. If 
Maximum Logs is set to zero, measurements will be logged until you press 
Stop logging.

During the logging process there will appear a small window, informing 
you about the current logging state.

Once the logging has been stopped, there will be a dialog, allowing you to 
immediately open the logging series. Opening a very long series that has 
been saved to separate files can take some time.

When a logging series has been opened, there will be a horizontal slider 
below the data figures, allowing you to navigate within the series.

In the Integrated PC Mode, the logging parameters described above can 
be set directly in the Logging section that is accessed from the top button 
row of the application.
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Importing Logging Series

If logging data has been saved to a single file before, it can be opened 
using the opening functions described above (see section Loading 
Measurements / Snapshots on page 92). If logging data from a single 
series had been stored to individual files you need to use the Import Series 
function, which can be found in the File menu. It can be found in the right 
button bar when using the Integrated PC mode (as long as no document is 
opened and no application is activated). Choosing Import Series will bring 
up a file dialog in which you have to choose the folder that the logging files 
have been stored in (by default this is an automatically generated 
sub-folder of your \My Documents\My PolarizationNavigator Files folder). 
You have to navigate into the specific folder and press the Open button. It 
does not matter which file of the logging series has been selected before.

If the logging series had been stored in individual files, there will be a 
dialog when closing the document or exiting polarizationNAVIGATOR™ 
that asks you about saving the changes. Actually the data itself has not 
been altered, but at this point, the polarizationNAVIGATOR™ suggests you 
save the whole series in a single file. By doing this, you can avoid importing 
the data the next time you’re working with it. On the other hand this will 
create a file of about the same size as the initial set of files, which can be 
quite a large number.
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Application Properties 

Application properties can be accessed by pressing the Properties button, 
which is located at the right side of the application window in External PC 
mode and in the top button row of the application in Internal PC mode.

KeepRawData

Raw data can be stored together with the measurement result if the option 
Keep Raw Data is set. The default setting is Yes. Setting this option to No 
will reduce the size of the saved files, setting it to Yes stores additional 
data about the measurements. This data includes the measured SOPs at 
the output of the DUT and the assumed SOPs at the input of the DUT 
which are derived from the reference measurement. In case of the 
referenced measurement, Mueller matrices for each wavelength are also 
included. This additional raw data cannot be displayed by the Polarization 
Navigator. It can be exported to an ASCII-file or to a MATLAB .mat-file by 
clicking on File/Export.

It can also be accessed by loading a .pbin-file into the MATLAB workspace:
Data=PBinRead('Result.pbin');

figure;plot(Data.Lambda,Data.MuellerMatrix);

figure;plot(Data.SOPInput(:,1),Data.SOPInput(:,2:5));

figure;plot(Data.SOPOutput(:,1),Data.SOPOutput(:,2:5));

The Mueller Matrix elements are stored in 16 columns. Each row belongs 
to a different wavelength. The Mueller Matrix of the 10th row can be 
derived by the following command:
M= reshape(Data.MuellerMatrix(10,:),4,4)';

You can convert the Mueller matrix data into Jones space using the 
following MATLAB command:
Jones=Mueller2Jones(Data.MuellerMatrix);

The resulting matrix contains a row for each wavelength. Each 4 elements 
of a row form a Jones matrix, where the first 2 elements contain the top 
row of the Jones matrix and the next 2 elements contain the bottom row of 
the Jones matrix.

Also note that the input SOP is cycled through a system of 6 input SOPs. If 
you want to access only one SOP out of the whole system use following 
command:
nSystem=3;

figure;

plot( Data.SOPOutput(nSystem:6:end,1),

Data.SOPOutput(nSystem:6:end,2:5) );
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UseInternalRef

This option determines whether or not an internal reference measurement 
is used. If set to yes, an internal reference measurement will be performed 
before each actual measurement or after a customizable refresh time. 
Setting this option to Yes results in maximum DGD accuracy. The default 
value is Yes. Although setting this option to No reduces measurement time 
it is not recommended you do so, because of the reduced accuracy.

InternalRefValidMinutes

This option determines the period of time after which an internal 
measurement becomes invalid, if UseInternalRef is set to Yes. When set to 
zero, the polarizationNAVIGATOR™ automatically decides on when to 
perform internal reference measurements Otherwise internal reference 
measurement are performed with the given refresh rate, in minutes.

DetectModeHops

When sweeping tunable laser sources across large wavelength ranges 
there may occur mode-hops. When DetectModeHops is set to Yes, the 
polarizationNAVIGATOR™ tries to detect such mode-hops and to handle 
the data as if no mode-hop had occurred, i.e. interpolate data in between 
the samples right before and right after the mode-hop.

NOTE
To use the MATLAB commands described above requires some MATLAB 
script files that can be found in the \Bin\Matlab\ subfolder of the 
polarizationNAVIGATOR™ install path.

NOTE
Changing this parameter will affect any future measurement. It will not 
affect any open documents or measurements.
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Measurement Setup 

The N7788B/BD combines polarization control functions and polarimetric 
measurement functions within a single instrument. Therefore optical 
connections are reduced to a minimum. A tunable laser source (TLS) is 
connected to the input and the device under test (DUT) is connected to the 
corresponding optical ports.
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Application: PMD/PDL/Loss (Stepped)

Use this application for PDL/PMD stepped measurements, i.e. if your laser 
source is not capable of continuous sweeping. The application uses a 
stepped sweep of the tunable laser source (TLS) to measure the following 
parameters versus wavelength:

• PDL, Best Case SOP (i.e. SOP with the maximum transmission 
coefficient, denoted PDLPSP)

• Pmin/Pmax

• Power/Loss

• DGD, PSP, second-order PMD (denoted PMD2nd)

See Measurement Setup on page 99 for details on how to connect the DUT 
and the trigger cables.

Most of the functions of this application work closely resemble the 
functions explained in Application: PMD/PDL (PMD/PDL/Loss) on 
page 87. Therefore, in the following sections, only the differences between 
the stepped and the continuous application will be mentioned in detail.

Application Setup Parameters

Table 8  Application PDL/PMD (Stepped) Setup Parameters

Parameter Description

Start wavelength (nm): Defines the start of the wavelength sweep.

Stop wavelength (nm): Defines the stop of the wavelength sweep.

Step Size (nm): Defines the wavelength step size for the 
measurement.

Laser Power (dBm): Defines the optical output power of the laser 
source.

Current Gain: Shows the current gain setting of the input 
amplifiers (0=lowest sensitivity, 13=highest 
sensitivity). Each step changes the allowed 
optical input power range by approximately 
3dB.



Keysight N778xB User’s Guide 101

Applications 4

 

Performing measurements

Performing measurements works just as described in Performing 
Measurements on page 89, except there is no preview and no serial 
number mode available and that you have to define the Step Size for the 
measurement. The minimum required number of steps basically depends 
upon the DGD of the DUT. Large DGD values require relatively small 
wavelength steps. By pressing the Auto button, the step size is determined 
automatically by the polarizationNAVIGATOR™.

Samples: Shows the estimated number of samples.

Reference: If a reference measurement is done you can 
select whether it will be used for the 
measurement or not.

Resolution (nm): Defines the width of the averaging window as 
well as data interleaving. Use smaller values 
for a better wavelength resolution.

Parameter Description
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Application Properties

In stepped mode there is one application property in addition to those 
described in Application Properties on page 97.

ReferenceStepSize

When performing reference measurements, the laser source is using this 
step size instead of that entered in the application controls. Reference 
measurements are performed with a fiber with negligible DGD, so large 
wavelength steps are appropriate. They are thus less time consuming than 
when the same step-size was used as for DUTs with high DGDs. The 
default setting is 5nm.
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Application: PER/PMF Crosstalk

Use this application for crosstalk measurements in polarization 
maintaining fibers (PMF) or for measuring misalignment angles between 
PMF connectors or splices. Typically the light inside a PMF has to be 
guided either in the slow or in the fast axis. Usually this can only be 
achieved to some extent and the signal inside the PMF can be divided into 
two components guided in the fast and the slow axis. The power ratio 
between these two components is called polarization extinction ratio 
(PER). Typical values are between 20dB and 40dB meaning that the power 
in the wrong axis is 20dB (40dB respectively) below the light in the desired 
axis.

In case of limited PER the output polarization will move on a small-circle 
on the Poincaré sphere when mechanically disturbing the PMF, changing 
its temperature or when changing the wavelength of the source. The 
radius is a measure for the PER. This application measures the radius of 
the trajectory of the output polarization and calculates the PER. A laser 
source is used as stimulus and the trajectory can either be generated by 
continuously changing the source wavelength or by disturbing the PMF 
(either manually or using N7783B Thermal Cycling Unit).

For details on the different methods, please refer to the following sections:

• Manual PER Measurement on page 105

• Swept Wavelength Method on page 107

• Using a single N7783B Thermal Cycling Unit on page 108

• Splice Alignment (using two N7783B Thermal Cycling Units) on 
page 110

• Automatic Splice Alignment (using Fujikura PM splicer) on page 112

These applications (except Automatic Splice Alignment) use different 
means to measure the PER in a fiber. Once this value has been obtained, 
they allow you to switch to PER Live mode, in which you can, for example, 
optimize the input polarization into a PM patchcord and will get a realtime 
readout of the PER without any further stretching, heating or sweeping. 
For these live measurements it is required that no polarization changes are 
introduced after the PM fibre (e.g. moving a single-mode patchcord that 
connects the PM fiber to the N7782B input). In general, polarimetric PER 
measurements will perform best when polarization disturbances are 
minimized. You can do this by making sure that no fiber movements occur 
during the measurement and that the fibers are not subject to temperature 
changes anywhere else than in the Thermal Cycling Units.
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There are a number of options that can be used to influence certain 
aspects of the measurements. These can be configured in a dialog that can 
be accessed by pressing the Properties button, which is located at the 
right side of the application window in External PC mode and in the top 
button row of the application in Internal PC mode. Details on these options 
can be found in Application Properties on page 115.

Integrated Laser Sources

N7782B units can be equipped with integrated VCSEL sources. These laser 
sources can be turned on and off using the button near the Output 
connector on the front panel of the N7782B or using the checkmarks 
below the control buttons of the PER application. If the N7782B contains 
more than one VCSEL (e.g. dual-VCSEL option #401), the active VCSEL 
can be chosen by setting the mark in front of either Lambda 1 or Lambda 
2. The polarimeter wavelength will be set automatically according to the 
selected VCSEL. Removing the mark will turn both VCSELs off. Using the 
button on the front panel, you can cycle through the VCSELs and the 
off-state. If the VCSEL is switched using the front panel button, the 
polarimeter wavelength is not updated in the polarizationNAVIGATOR™; 
you have to do it manually to obtain accurate results in that case.
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Manual PER Measurement

Use this application for crosstalk measurements of polarization 
maintaining fibers (PMF) using a laser source at a fixed wavelength and by 
stretching / disturbing the PMF manually. The crosstalk is often expressed 
by the Polarization Extinction Ratio (PER) which is given by the ratio 
between the power levels of the two PMF axes (typically expressed in dB).

Connect the instrument and the PMF according to the following setup:

To optimize the PER inside the PMF follow these steps:

1 Set up your device so that coherent light is guided through the PMF 
(e.g. turn on your laser diode or connect a tunable laser source to the 
PMF). If you’re using an N7782B with VCSEL option (#101, #401, 
#501), you can connect the PMF to the input of the N7782B, assuming 
the wavelength option matches the operating range of the DUT. The 
internal source will be activated automatically, so you don’t have to 
turn it on before starting the application

2 Start the PER / PMF Crosstalk application.
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3 Enter the correct wavelength of the laser source. If the internal source 
of an N7782B with VCSEL option is used, the wavelength is set 
automatically.

4 Click on PER Manual

5 Gently stretch the PMF so that a yellow circle appears. Try to make a 
full circle, then the PER-fit will be most accurate.

6 The number displayed on the screen is the current PER.

7 Once a PER value is stable, you can click on PER Live for real time 
alignment.

8 Now the current PER is measured in real time based on the reference 
stored automatically during the previous steps.

9 Optimize the input polarization into the PMF by trying to move the blue 
spot into the center of the display which indicates the optimum input 
polarization.

10 If you think you have reached the optimum, you can repeat the 
measurement by clicking on PER Manual and stretching the fiber 
again, thus verifying the input polarization obtained in the previous 
steps.
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Swept Wavelength Method

Use this application for crosstalk measurements in polarization 
maintaining fibers (PMF) using a swept laser source. The crosstalk is often 
expressed by the Polarization Extinction Ratio (PER) which is given by the 
ratio between the power levels of the two PMF axes (typically expressed in 
dB).

Connect the instrument and the PMF according to the following setup1:

To optimize the PER inside the PMF follow these steps:

1 Set up your device so that light is guided through the PMF. If you 
connected your laser source using GPIB it will be controlled 
automatically. Otherwise use the manual mode and setup the laser so 
that it permanently sweeps over the desired wavelength range 
(typically 5nm to 10nm). The sweep speed should be around 40 nm/s.

2 If you use a Keysight laser source you have to configure it beforehand 
so that it appears under Misc. Instruments in the browser. Please run 
the configuration wizard before using this application, so that the laser 
source is installed properly.

3 Start the PER / PMF Crosstalk application.

4 Enter the correct center wavelength and the sweep range. You may 
also choose a manual gain setting, but by default the application uses 
automatic gain. When using a properly configured Keysight laser 
source you can also set the output power of that source.

5 Click on PER WL Scan / Wavelength Scan

1 Many tunable laser sources have a PMF output. Therefore, the limited PER inside this output PMF 
can reduce measurement performance. An inline polarizer can reduce this effect.
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6 Now the current PER is measured in real time by continuously 
evaluating the circle-trajectory.

7 Once a PER value is stable, you can click on PER Live for real time 
alignment.

8 Now the current PER is measured in real time based on the reference 
stored automatically during the previous steps.

9 Optimize the input polarization into the PMF by trying to move the blue 
spot into the center of the display which indicates the optimum input 
polarization.

Using a single N7783B Thermal Cycling Unit

Use this application for crosstalk measurements of polarization 
maintaining fibers (PMF) using a laser source at a fixed wavelength and an 
N7783B to automatically heat up and cool down the PMF. 

Connect the instrument and the PMF according to the following setup:
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To optimize the PER inside the PMF follow these steps:

1 Set up your device so that coherent light is guided through the PMF 
(e.g. turn on your laser diode or connect a tunable laser source to the 
PMF). If you’re using an N7782B with VCSEL option (#101, #401, 
#501), you can connect the PMF to the input of the N7782B, assuming 
the wavelength option matches the operating range of the DUT. The 
internal source will be activated automatically, so you don’t have to 
turn it on before starting the application.

2 Start the PER / PMF Crosstalk application.

3 If a Thermal Cycling Unit is connected to the N7782B, Heater #1 
should appear as off in the Fiber Heater Status area. If this heater entry 
shows not connected check cable connections and restart application.

4 Enter the correct wavelength of the laser source. If the internal source 
of an N7782B with VCSEL option is used, the wavelength is set 
automatically.

5 Click on PER (Heater)

6 The N7783B starts a temperature cycle by heating up the PMF 
(LED=red), cooling it down (LED=green) and turning the device off 
(LED=off).

7 The number displayed on the screen is the current PER.

8 Once a PER value is stable, the software automatically switches to the 
PER Live mode for real time alignment.

9 Now the current PER is measured in real time based on the reference 
stored automatically during the previous steps.
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10 Optimize the input polarization into the PMF by trying to move the blue 
spot into the center of the display which indicates the optimum input 
polarization.

11 If you think you have reached the optimum, you can repeat the 
measurement by clicking on PER (Heater) again, thus verifying the 
input polarization.

Splice Alignment (using two N7783B Thermal Cycling Units)

Use this application for characterizing splices or connections between two 
polarization maintaining fibers. In that configuration, two N7783B Thermal 
Cycling Units are needed (one for each PMF) in a daisy-chain 
configuration.

Connect the N7783B units to the N7782B according to the following 
setup:
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To optimize the splice angle follow these steps:

1 Set up your device so that coherent light is guided through the PMF 
(e.g. turn on your laser diode or connect a laser source to the PMF). If 
you’re using an N7782B with VCSEL option (#101, #401, #501), you 
can connect the PMF to the input of the N7782B, assuming the 
wavelength option matches the operating range of the DUT. The 
internal source will be activated automatically, so you don’t have to 
turn it on before starting the application.

2 Start the PER / PMF Crosstalk application.

3 If two Thermal Cycling Unit are connected to the N7782B, Heater #1 
and Heater #2 should appear as off in the Fiber Heater Status area. If 
any of the heater entries show not connected check cable connections 
and restart application.

4 Enter the correct wavelength of the laser source. If the internal source 
of an N7782B with VCSEL option is used, the wavelength is set 
automatically.

5 Click on Splice Align

6 The first N7783B starts a temperature cycle by heating up the PMF 
(LED=red), cooling it down (LED=green) and turning the device off 
(LED=off). After that, the second N7783B does a similar temperature 
cycle.

7 The number displayed on the screen is the current PER / Splice Angle.
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Automatic Splice Alignment (using Fujikura PM splicer)

You can use the N7782B PER-Analyzer in combination with a Fujikura 
FSM-45PM / FSM-45PM-LDF splicer to automatically optimize the splice 
angle. You will need the following equipment:

• N7782B PER-Analyzer

• 2 x N7783B Thermal Cycling Unit

• Fujikura FSM-45PM / FSM-45PM-LDF Splicer (Firmware revision 
higher than 1.37)

The measurement setup is very similar to the setup shown in Splice 
Alignment (using two N7783B Thermal Cycling Units) on page 110. In 
addition, connect the splicer using an RS-232 null-modem cable to the 
PC.
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Use the following steps to configure the polarizationNAVIGATOR™ and the 
PM splicer for automatic splice alignment (these steps have to be 
performed once before the application can be used):

1 Select Add from the context menu of the Misc. Instruments node:

2 Choose the Fujikura Splicer from the list and press OK.

3 If you are using a serial port other than COM1, go to the Properties 
menu of the splicer by right-clicking the Fujikura Splicer (COMx) entry 
in the browser tree. Double click the COMPortNo entry and enter the 
appropriate COM-Port.

4 To check whether the communication with the splicer is working, you 
can double-click on the splicer entry in the browser tree. You will see a 
panel allowing you to remote control the splicer keys:
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5 Modify one of the splice programs of the PM splice and select A1200 
(R-A1200 in case there are two entries containing A1200) as 
theta-aligning method. If you start the splice operation now, the splicer 
uses the Splice-Angle readout of the polarizationNAVIGATOR™.

6 You may set Pause 1 and / or Pause 2 to On in the Utility Menu of the 
PM splicer. This will make the Splicer pause between the alignment 
and the actual splice, so you can check the alignment result before 
performing the splicing operation.

The following steps describe how to perform PM splices with automatic 
angular alignment using an N7782B and two N7783B:

1 Start the PER / PMF Crosstalk application. If the application 
recognizes the splicer (i.e. it is configured in polarizationNAVIGATOR™, 
the COM port is chosen correctly and the null modem cable is plugged 
in correctly) it should be marked with a lock symbol in the browser tree.

2 Connect a laser source to one of the PM fibers that are going to be 
spliced and connect the other fiber to the N7782B input. Prepare the 
fibers as usual (stripping, cleaning and cleaving) and put them into the 
clamps of the splicer. 

3 To make sure that the splicer can communicate with the application, 
you may press RESET on the splicer. A small window should appear in 
the lower right corner of the polarizationNAVIGATOR™, confirming the 
reception of the command:
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4 Use the Set button of the PM splicer to start the alignment. x-, y- and 
z- alignment will be performed by visual feedback of the PM splicer, 
but the angular alignment will be performed using the splice angle 
readout of the N7782B. The application performs a number of steps 
until it approaches the target angle with the desired accuracy, 

• By changing the splice program at the PM splicer, you can choose a 
target angle other than zero. 

• You can select the desired angle accuracy from the properties menu 
(see Application Properties on page 115). 

• If you are using an instrument with internal laser source, e.g. an 
N7782B with option #401, you can let the software automatically 
turn off the laser source when not in use (see Application Properties 
on page 115). This can reduce effects caused by scattered light seen 
by the splicer camera. 

Application Properties 

Application properties can be accessed by pressing the Properties button, 
which is located at the right side of the application window in External PC 
mode and in the top button row of the application in Internal PC mode. 
Some of these options apply to some of the measurement modes only

HeatingTime

When using N7783B units, this value defines the heating time in seconds. 
If HeatingTimeAuto is set to Off, the N7783B will heat the fiber for this 
number of seconds. If HeatingTimeAuto is set to On, the N7783B will 
automatically stop heating if the required information has been obtained, 
but will not exceed the number of seconds defined in HeatingTime. 
Regardless of this value, the N7783B will stop heating/cooling after a 
period of 30-60s.

CoolingTime

When using N7783B units, this value defines the cooling time in seconds. 
If HeatingTimeAuto is set to Off, the N7783B will cool the fiber for this 
number of seconds. If HeatingTimeAuto is set to On, the N7783B will 
automatically stop heating if the required information has been obtained, 
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but will not exceed the number of seconds defined in HeatingTime. 
Regardless of this value, the N7783B will stop heating/cooling after a 
period of 30-60s.

SettlingTime

This is the time between the end of the heating cycle and the beginning of 
the cooling cycle. 

SpliceAngleAccuracy

When using an N7782B together with a Fujikura FSM-45PM splicer to 
automatically optimize the splice angle, this value defines the limit at 
which the application does not try to improve the angle any further. 

LightSourceAutoOff

If this option is set to Yes, the integrated VCSEL of an N7782B is turned off 
during visual alignment periods of the Fujikura FSM-45PM splicer.

HeatingTimeAuto

If this is set to Yes, the N7782B will choose the heating and cooling time 
automatically, but uses the values defined in HeatingTime, CoolingTime 
and SettlingTime as maximum values.
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Application: Polarimeter Calibration

Use this application to calibrate the polarimeter at a wavelength not 
included in the factory calibration range. 

Obtaining Calibration Data

The calibration is done in the following steps:

1 Enter the wavelength you want to use in the dialog box.

2 Connect the light source you are using to the polarimeter input. For the 
calibration process, it is recommended that you insert a polarization 
controller (e.g. a fiber-loop polarization controller) in between both, so 
you can easily and continuously change the state of polarization.

• Turn on the light source and start the application Polarimeter 
Calibration.

• Click on Run and move the blue spot on the Poincaré sphere into the 
red marked regions. When passing one region, it will turn to green. 
You may have to rotate the sphere view, to find which regions have 
not yet been passed. You can abort the calibration data acquisition 
by pressing the Stop Measurement button.

• After all regions have been passed by the blue spot or the Accept 
button is pressed, the calibration data is generated. You can assign 
a name to this calibration set.

NOTE
Make sure the calibration wavelength is within the operating wavelength 
range of the instrument.

NOTE
You may have to add this application manually to the application tree by 
right-clicking on Applications and then selecting Add and choosing 
Polarimeter Cal ibration from the list.

NOTE
The light source should be fully polarized (DOP=1). In case you are using 
an unpolarized broadband source, make sure it is filtered by an inline 
polarizer.
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After running this application, the polarimeter automatically uses the 
calibration set. You can leave the application now by clicking on Exit and 
use the polarimeter by double-clicking on the instrument.

Managing Calibration Data

You can select the desired calibration data set used in this session by 
right-clicking on the polarimeter in the browser tree and clicking on 
Properties.

Go to the Calibration tab and select the appropriate calibration data set.

Individual calibration data sets can be removed by selecting them from the 
drop-down list and pressing the Clear button in the Calibration tab.

NOTE
After restarting the polarizationNAVIGATOR™, the factory calibration 
data is selected automatically.
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Polarization Controller Basics

This chapter describes the basic operation of the polarization controller 
functions of the N778xB/BD instruments.

The operation of the LiNbO3 polarization controller (PC) integrated with 
most instruments of the N778xB/BD series family is comparable to a 
cascade of five endlessly rotatable waveplates:

The state of the PC is given by the position of the waveplates which is 
expressed in terms of five angles ϕ0...ϕ4 measured in rad (ranging from 
0..π. Due to the internal structure of the PC the waveplates are endlessly 
rotatable, i.e. there will be a continuous and polarization state transition 
when increasing the position beyond 2π, which is similar to starting from 0 
again. The polarization state for a waveplate setting of 2π+φ is similar to a 
waveplate setting of 0+φ.

Note that the retardation may slightly differ from the nominal values 
depending on the operating wavelength and also temperature. 
Furthermore there may be a systematic deviation due to the electro-optic 
properties of the LiNbO3 polarization controller. Usually these deviations 
are not an issue since in most applications the polarization is adjusted in 
an adaptive way (like for manual fiber-loop polarization controllers).

The angles can either be set statically or dynamically. Dynamic change is 
implemented by means of a look-up table stored in the memory of the 
instrument. This look-up table can be processed once or repeatedly at 
different clock rates. Triggering or synchronizing with an external clock is 
also possible. There are different modes of operation described in the 
following sections.

PC Input
(SMF)

PC Output
(SMF)

��� ��� ��� ��� ���

� � � � �
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Loop Synchronous Operation in Optical Loop Test Beds

In scramble mode and sequence mode the instrument can be 
synchronized to external events to support synchronous operation to 
optical loop test beds. Two configurations are recommended:

No Loop Clock - Internal Timebase

In this configuration the N778xB/BD is synchronized to the beginning of 
the loop sequence when the fiber loop is loaded with the optical burst 
data. It then processes the look-up table (either generated for scrambling 
or loaded from a file) using an internal clock timer. The loop cycle time 
depends on the length of the fiber loop. You have to find the clock rate and 
the phase of the PC manually to match the switching times with the loop 
cycles. A more detailed description of the scrambler parameters is given in 
Application: Random Polarization Scrambling on page 124.

N7784B / N7785B / 
N7786B

Loop Control

Trigger
Input #1

"Loop Load"

PC InputPC Output
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Synchronized to Loop - Clock External Timebase

In this configuration the N778xB/BD is synchronized to the loop clock. 
Switching occurs on the rising edge of the signal applied to the trigger 
input #1. The look-up table pointer is reset to the beginning when trigger 
input #2 is set to logical high for at least 100 μs. A more detailed 
description of the scrambler parameters is given in Application: Random 
Polarization Scrambling on page 124. Trigger #1 and trigger #2 are not the 
BNC connectors on the instrument rear panel, but pins of the expansion 
port (see Expansion Port Connector Pinout on page 142 for details.

Loop Control

Trigger
Input #2

Trigger
Input #1

"Loop Load" "Loop Clock"

PC InputPC Output

N7784B / N7785B /
N7786B
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Application: Manual Waveplate Control

In manual operation mode the polarization can be adjusted by manually 
setting the five angles ϕ0...ϕ4. The operation is comparable to manual 
fiber-loop polarization controllers. In the polarizationNAVIGATOR™ 
software settings can be saved and restored.

When the N778xB/BD polarization controller is activated by clicking on 
the corresponding polarization controller symbol in the browser tree, 
sub-items named Sequence, Manual and Scramble appear below the 
symbol.

By double-clicking the Manual sub-item, a dialog is opened, containing 
five sliders. Move the sliders to adjust the position of each waveplate. The 
slider ranges represent a rotation angle range of 4π, i.e. two full rotations. 
The initial slider position (vertically centered) denotes a rotation angle of 0; 
moving the slider to the top rotates the corresponding (virtual) waveplate 
by 2π into one direction, moving it to the bottom rotates the waveplate by 
the same amount in the other direction.

You can store five sets of slider positions by pressing CTRL while clicking 
on a memory button of the control bar. All five waveplate positions are 
stored for each memory button. Simply click on the desired memory 
button to recall this set any time later.
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NOTE
The software remembers the stored slider settings even when you exit 
and restart the polarizationNAVIGATOR™.
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Application: Random Polarization Scrambling

In random scrambling mode, polarization changes are created by setting 
all (virtual) waveplates to a sequence of randomized rotation angles at an 
adjustable clock rate.

When the N778xB/BD polarization controller is activated by clicking on 
the corresponding polarization controller symbol in the browser tree, 
sub-items named Sequence, Manual and Scramble appear below the 
symbol. 

The scrambler operation is activated by double-clicking the sub-item 
Scramble of the N778xB/BD instrument. This will also show a dialog for 
setting the parameters of the scrambling operation.

For simple asynchronous operation turn Timebase to Timer and choose a 
Repetition Rate. The repetition rate is the clock used for processing the 
look-up table. 

The default setting is Polarimeter Clock. In this mode, the scrambler clock 
is synchronized to the internal clock of the sampling electronics when 
using an N7786B or an N7788B/BD as polarization controller and 
polarimeter at the same time. In this mode the repetition rate of the 
scrambling operation cannot be changed. In that case, the periods of 
constant polarization can be increased by using the Prescaler setting, thus 
effectively slowing down the scrambling operation. The repetition rate is 
divided by Prescaler+1, i.e. the polarization controller switches to the next 
waveplate setting every Prescaler+1 clock pulses, regardless of the clock 
source.

NOTE
In random or sequence operation, the actual polarization switching from 
one waveplate setting to the next occurs within some µs. Changing the 
repetition rate or the prescaler extends the delay between these 
switches.
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Scrambling is implemented by automatically generating a special 
look-up-table. The table length can be chosen by the field Seq. Length. 
When changing this value, the new sequence will be randomized, which 
may take some seconds, depending upon the sequence length. Larger 
values will increase the size of the look-up table.

By pressing the Randomize button, the current pattern is replaced by a 
new set of random SOPs.

If Synchronization is set to Auto Repeat, the scrambling sequence is 
processed repeatedly without any external synchronization. The sequence 
will be randomized initially and will be repeated unchanged.

If Synchronization is set to Auto Oneshot, the scrambling sequence is 
processed just once. The polarization controller remains in the state 
defined by the last table entry.
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If Synchronization is set to External Repeat or External Oneshot, the 
behavior is similar except that the sequence is restarted when a low/high 
transition occurs at the Trigger Input #1. The exact time relative to the 
external trigger signal can be adjusted using the Hold off time. This value 
defines the delay between the trigger pulse and the restart of the 
sequence.

The external trigger signal can also be used as timebase instead of the 
internal timer. In this mode the look-up-table is processed at the clock 
rate applied to Trigger Input #1. Set Timebase to External to activate this 
function.

When using an external timebase, a restart of the sequence can be 
achieved by applying a TTL signal to Trigger Input #2. This input is not 
edge-triggered, instead a logical high level of at least 100 μs duration will 
trigger a restart of the sequence on the next rising edge of Trigger Input 
#1.
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Application: Sequence Operation

This application can be used with N7784B, N7785B, N7786B, N7788B/BD.

In sequence mode a look-up table given in an ASCII text file can be 
uploaded to the instrument.

When the N778xB/BD polarization controller is activated by clicking on 
the corresponding polarization controller symbol in the browser tree, 
sub-items named Sequence, Manual and Scramble appear below the 
symbol. 

The sequence mode is activated by double-clicking the Sequence 
sub-item of the N778xB/BD instrument. The sequence mode is very similar 
to the scrambling mode except that the randomized sequence is replaced 
by a customizable sequence that can be uploaded to the instrument. The 
sequence has to be stored in an ASCII file with decimal numbers ranging 
from 0 to 2π. Each row represents an entry of the look-up table, each of 
the five columns represents a waveplate position. Use ’,’ as decimal 
symbol and ’;’ to seperate waveplate values and put each sequence step in 
a new line like this:

0,00;0;0;0;0

1,57;0;0;0;0

3,14;0;0;0;0

You can find some sample sequences in the Examples\DemoSequences 
subfolder of the polarizationNAVIGATOR™ folder.

By pressing Load Sequence a file dialog will be shown. After selecting an 
ASCII file containing waveplate positions, the waveplate settings are 
transferred to the instrument and the sequence is started. Refer to 
Application: Random Polarization Scrambling on page 124 for a 
description of the parameters Timebase, Rep. Rate, Prescaler, Hold off 
and Synchronization. Seq. Length cannot be set in the 
polarizationNAVIGATOR™ interface, since it is defined by the number of 
lines in the ASCII file.
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Application: Continuous Scrambling

Use this application to scramble the polarization state in a continuous 
manner using an N7784B, N7785B, N7786B or an N7788B/BD. The 
scrambling behavior resembles that of a motorized fiber-loop polarization 
controller.

The LiNbO3 waveplates are controlled in a way that creates a continuous 
movement of the output polarization state with an adjustable scrambling 
speed.

After activating the application Continuous Scrambling, you can start and 
stop the scrambling operation by pressing Start Scrambler and Stop 
Scrambler. When pressing Start for the first time after activating the 
application, it may take some seconds until the scrambling sequence has 
been generated. The parameter Scanrate defines the scrambling speed. 
An estimation of the resulting scrambling speed is given in the status field. 
You can change the unit this estimation is displayed in by using the Speed 
Unit drop-down list.

The scanrate settings 1-8 correspond approximately to the scanrate 
settings of the Keysight 11896 polarization controller.

See also Target ContScrambling on page 266.
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Application: Polarization Stabilization

N7784B Polarization Stabilization

In addition to the manual, scramble and sequence modes described before 
(see previous sections), the N7784B can be used to generate a fixed 
output SOP, even with varying input SOPs. 

When the N7784B polarization controller is activated by clicking on the 
corresponding polarization controller symbol in the browser tree, 
sub-items named Sequence, Manual, Scramble and Stabilize appear 
below the symbol.

By double-clicking the Stabilize sub-item of an active N7784B instrument, 
the settings for the stabilizer operation can be accessed.

By pressing Settings, several control parameters of the SOP controller 
(see N7784B / N7786B Settings on page 134) can be modified. The same 
dialog can be accessed by selecting Properties from the context menu of 
an N7784B in the browser tree.

By clicking the Stabilize check mark, the controller can be stopped or 
resumed. When the Criterion is set to Internal (see N7784B / N7786B 
Settings on page 134), the controller generates a fixed, stable output SOP. 
Configure the N7784B according to the following setup:

NOTE
You only need to connect a computer to the N7784B for changing the 
control parameters. Otherwise you can activate and deactivate the 
stabilizer operation by pressing the Control button on the front panel of 
the N7784B. The Active LED will be lit while the instrument is stabilizing.
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When it is set to Analog In, an appropriate external signal has to be 
provided and the N7784B will optimize the output SOP with respect to this 
feedback signal. Configure the N7784B according to the following setup:

LiNbO3 Polarization
Controller Powermeter

PBS

PC Input
(SMF)

PBS
Input

PC Output
(SMF)

PBS

Output (PMF)

Polarization
Stabilized Signal

Input
Signal

Personal Computer

USB

N7784B

LiNbO3 Polarization
Controller Powermeter

PBS

PC Input
(SMF)

PC Output
(SMF)

Polarization
Stabilized Signal

Input
Signal

Personal Computer

USB

Expansion

External Feedback Signal

N7784B

NOTE
Make sure that the instrument providing the external signal does not 
perform any auto-ranging. If it does, the analog signal will be 
discontinuous and thus prevent the controller from finding the optimum.
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N7786B Polarization Stabilization

In addition to the sequence, manual and scramble modes described before 
(see N7784B / N7786B Settings on page 134), the N7786B can be used to 
generate specific output SOPs, even with varying input SOPs. 

When the N7786B polarization controller is activated by clicking on the 
polarization controller symbol in the browser tree, sub-items named 
Sequence, Manual, Scramble and SOP Stabilize appear below the 
symbol.

By double-clicking the SOP Stabilize sub-item of an active N7786B 
instrument, the settings for the SOP stabilizer can be accessed. By default 
a list of four SOPs is shown in the SOP Table, which can be replaced with 
an arbitrary list of SOPs by pressing Import. The imported file is expected 
to contain one normalized Stokes vector per line, with spaces or tabs as 
separators between the vector components, like this:

0 0 -1

-1 0 0 

0 -1 0 

or 

-7.2138585e-002  2.2201973e-001 -9.7236992e-001

-2.5000000e-001  1.8163563e-001 -9.5105652e-001

You can find some sample sequences in the Examples\DemoSOPTables 
subfolder of the polarizationNAVIGATOR™ folder. By clicking the WP 
checkbox, the corresponding waveplate angles are shown instead of the 
Stokes vectors. These Settings, however, are only available once the 
N7786B has been set to stabilize the corresponding SOP. Before that all 
waveplate positions will read 0. The waveplate position display of the 
currently selected row of the sequence will be updated continuously if the 
input SOP is changed.

By setting the appropriate check marks, the target SOPs can be shown 
(Show Target SOPs, red dots), as well as the SOPs actually generated 
(Show Ctrl SOPs, green dots)
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and the N7786B can be set to Auto Cycle through the list of SOPs with an 
adjustable delay between two successive SOPs (note that for high-speed 
cycling the Trace mode (described below) is more appropriate). This delay 
can be set in the text box to the right of the Auto Cycle checkbox.

By pressing Settings, several control parameters (see N7784B / N7786B 
Settings on page 134) of the SOP controller can be modified.

The Stabilize checkmark is set automatically, when choosing an SOP from 
the list or when activating the Auto Cycle or the Set-And-Forget feature.
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By unchecking or checking this option manually, the controller can be 
stopped or resumed. The Set-And-Forget mode activates the controller 
and stabilizes the output SOP to the output SOP present at the time of 
activation. By pressing the Orth. SOP button, the target SOP is replaced 
with its orthogonal SOP.

For optimum performance the operating Wavelength has to be entered in 
the corresponding text box.

N7786B Trace Mode

The Trace mode is designed for high speed SOP cycling. While in the 
Stabilizer mode the N7786B continuously adapts to any changes of the 
input polarization, the trace mode finds appropriate waveplate settings 
once and does not adapt to changes of the input polarization and thus 
allows for significantly faster repetition rates.

An appropriate pattern of polarization controller settings yielding the 
desired sequence of output SOPs is generated automatically once you 
press the Trace button, which may take some seconds. Once this pattern 
has been generated, it is repeated by the N7786B at the adjustable 
Repetition Rate, without any further SOP stabilization, i.e. without 
adaptation to subsequent changes of the input SOP.

Exit the trace mode by checking the Stabilize check box or by deactivating 
the instrument in the browser tree.

NOTE
When using the Trace mode of the N7786B, make sure that the input 
polarization remains stable.
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N7784B / N7786B Settings

By pressing Settings from the SOP Stabilize sub-item of an 
N7784B/N7786B instrument, several startup options as well as control 
parameters can be set. This dialog can also be accessed by choosing 
Properties from the N7784B / N7786B instruments context menu and 
selecting the Stabilizer Settings tab.

In case of the N7784B, you can choose whether to use the Internal or an 
external (Analog In) Feedback Signal and the Feedback Operation (i.e. 
whether to Maximize or to Minimize the feedback signal) as well as the 
Analog Input Range of the external signal. In case of an N7786B these 
settings are not used.

You can choose, whether the SOP stabilizer feature should be activated 
automatically On Startup or not, as well as the Control Speed and the 
operating wavelength (Boot Wavelength). 

Pressing the Write To Flash button will store the new settings. This is only 
required if you want to set these values as default when powering up the 
unit next time.

NOTE
You need to press the Write To Flash button to make the changes 
persistent. Otherwise, they will be reset to the default values once the 
instrument is being restarted.
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By pressing the Play and Stop buttons (green arrow, red circle), the 
stabilizer is started and stopped respectively. The control button on the 
front panel of the instrument will cycle through these two states.

N7784B / N7786B Control Parameters

In addition, the internal control parameters can be overridden from the 
dialog described in N7784B / N7786B Settings on page 134. You can 
configure the control behavior to optimize the controller to your particular 
system.

If you click on Override Default Settings on the Settings dialog, you can 
enter the following values:

• Control Step Size: Increase this parameter to make the control steps 
larger.

• Gradient Step Size: The controller measures the gradient of the 
feedback signal with respect to the control parameters. This is done by 
dithering the control parameters. Increase this parameter to make the 
dithering steps larger.

• Coarse Threshold: If the feedback signal differs too much from the 
optimum, the controller switches to the coarse mode, i.e. the control 
steps are temporarily increased to quickly move back into the optimum.

• Off Threshold: This parameter is no longer used 

• Dither Step Duration: Dither Step Duration defines the number of 
samples that the instrument will keep a certain polcontroller dithering 
setting, thus allowing for slower analog-in rise times (see illustrations 
below). 

• Dither Step Skip: Dither Step Skip makes the algorithm skip the first 
number of samples of new each polarization controller dithering 
setting, so a slow powermeter rise time won’t impact the dithering 
operation. If (Dither Step Duration - Dither Step Skip) > 1, an averaging 
over the respective samples is performed (see illustrations below). 
Dither Step Skip must never be greater than Dither Step Duration - 1.

• Stop Stabilizer if Target SOP reached: This setting is only valid for SOP 
stabilization. If the controller reaches the target SOP, it will stop active 
control, i.e. it will stop dithering. The Accuracy parameter lets you 
define how close the SOP needs to come to the target SOP before 
deactivation of control.
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NOTE
You can only change the control parameters if the controller is turned off.
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Using Applications with Multiple Laser Sources

The software tsupports the connection of several laser sources to the GPIB 
port of the computer or the instrument (make sure these laser sources are 
configured to communicate at different GPIB addresses). However, the 
applications can only control one laser source at a time. Therefore, you 
can add the same application twice to the browser window and associate 
the two applications with two laser sources.

Use, for example, the following steps to configure the PMD / PDL / Loss - 
Application (see Application: PMD/PDL (PMD/PDL/Loss) on page 87) for 
two laser sources:

1 Run the wizard to perform the automatic configuration. Your two laser 
sources should be listed under Misc.Instruments.

2 Double-click on the PDL/PMD-Application (see Application: PMD/PDL 
(PMD/PDL/Loss) on page 87). You will be asked for the laser source 
you want to use together with this application. This configuration will 
also be used for the next time you start the application.

3 Exit the application.

4 Rename the application by right-clicking and selecting Rename or by 
clicking on the entry twice with a short delay in between. Choose a 
name describing the laser source (e.g. “Component Test (C-Band)”)

5 Add the same application again by right-clicking in the browser 
window and choosing Add. Choose Swept PMD/PDL/Loss Test.

6 Double-click on the new application and choose the other laser source.

7 Exit the application.

8 Rename the application as described above.

NOTE
Once the link to an instrument is stored, it can only be changed by 
deleting the application and adding it again.
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Trigger Configuration

If you are using two or more laser sources, the trigger outputs of these 
laser sources have to be combined and connected to the trigger input port 
of the instrument.

If you are using the PMD/PDL/Loss-Application (see Application: 
PMD/PDL (PMD/PDL/Loss) on page 87) together with Keysight Tunable 
Laser sources, this can be done by daisy-chaining the trigger signals:

• Connect the trigger output of laser 1 to the trigger input of the laser
2.

• Connect the trigger output of laser 2 to the trigger input of the
N778xB/BD.

The polarizationNAVIGATOR™ will configure the trigger settings of these 
sources to PASSTHROUGH automatically.
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Instrument Block Diagrams

Some N778xB/BD instruments allow for different applications, each of 
which may require a different optical setup. This section contains block 
diagrams for instruments that contain several functional blocks that can 
be used for individual applications.
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N7786B
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Expansion Port Connector Pinout

Pin Function

1 Analog Out A

2 Analog Out C

3 GND

4 Trigger Input #1

5 Trigger Input #2

6

7

8 Analog In GND

9 Analog Out B

10 Analog Out D

11 GND

12 Trigger Out

13 Analog In

14

15
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Electrical Data and Environmental Conditions

Power Supply Information and Environmental Conditions

N7781B/N7782B/N7784B/N7785B/N7786B/N7788B

N7781BD/N7788BD

Power 100-240 V~, 50-60 Hz, 60 VA max.

Voltage Fluctuation up to 10%

Use Indoor

Altitude up to 2000m

Operating Temperature +5°C...+40°C

Operating Humidity Range 0%-80% r.h. non-condensing

Installation Category II

PollutionDegree 2

Interfaces GPIB, USB

Power 100-240 V~, 50-60 Hz, 200 VA max.

Voltage Fluctuation up to 10%

Use Indoor

Altitude up to 2000m

Operating Temperature +5°C...+40°C

Operating Humidity Range 0%-80% r.h. non-condensing

Installation Category II

Pollution Degree 2

Interfaces GPIB, LAN
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Digital Inputs

Table 9  Digital Inputs

Digital Outputs

Table 10  Digital Outputs

Power (Instrument) 12 V=, 36W

Power (Power Supply*)

* Use UMEC UP0451E-12P82L power supply only

100-240 V~, 47-63 Hz, 1.0 A max.

Voltage Fluctuation up to 10%

Use Indoor

Altitude up to 2000m

Operating Temperature +5°C...+40°C

Operating Humidity Range 0%-80% r.h. non-condensing

Installation Category II

Pollution Degree 2

Technology: AC series (advanced high-speed 
CMOS)

Input Voltage Range: 0V.. 5V

Digital Input Levels: 1,65V .. 2,75V (low level threshold)

2,75V .. 3,85V (high level threshold)

Technology: AC series (advanced high-speed CMOS)

Digital Output Levels: 0,36V .. 0,44V (low level threshold)
4,76V .. 4,86V (high level threshold)
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This chapter describes how to control instruments using the 
COM/ActiveX-interface library (AgServerN778xLib).
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Introduction

A comfortable way to communicate with N778x instruments is to use the 
COM/ActiveX-interface offered by the library AgServerN778xLib. This 
library is installed when the “Photonic Application Suite (Main)” package is 
installed.

Modern programming languages typically offer an easy way to access 
COM/ActiveX-interfaces. For example, C#, Visual Basic .NET, LabView and 
MATLAB allow to browse all available methods and properties. If you use 
one of these languages, we therefore recommend to use the 
COM/ActiveX-interface.

If a language does not allow to easily browse the methods/properties of a 
COM/ActiveX library, it may be easier to just use the method “SCPIQuery” 
of the library AgServerN778xLib. This method takes a string as a 
parameter which defines the desired action. This string needs to be 
formatted according to the so-called SCPI standard (Standard Commands 
for Programmable Instruments). The library parses the SCPI strings and 
converts them into the binary format used by the instruments. 

NOTE
Use the COM/ActiveX-interface if you use C#, Visual Basic .NET, LabView 
or MATLAB.

NOTE
Up to version 2.0 of the Photonic Application Suite (PAS), the library was 
implemented as a DLL (AgN778xLib.dll) and accessed through the 
COM/Active-X class AgN778xLib. This DLL did not support 64 bit 
remoting environments.

With PAS version 2.1 it has been replaced by a COM server executable 
accessed through the class AgServerN778xLib which supports both 
32 bit and 64 bit remote environments.

Migrating from the old class to the new class just means changing the 
name of the class at the very beginning of an automation program / 
method.

For the sake of compatibility, the DLL is still part of any PAS installation. 
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Using LabView for controlling instruments

This is a simple VI to send a SCPI-command to an instrument:

You can find this VI in the DemoLabView8.5 folder.

Creating the reference to the driver is the origin for all activities. You can 
create this reference either by copying it from the example or create it as 
follows:

• Add the VI “Automation Open” from the ActiveX palette:

NOTE
The screenshots used in this section still refer to the DLL implementation 
of the library. Choose AgServerN778xLib instead of AgN778xLib to use 
the 64 bit capable implementation instead.
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• Right-Click on the VI and click on “Select ActiveX Class” and then on 
“Browse”:

• Then select the COM automation object “IVI AgServerN778x ...”
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• To access the objects, right-click on the VI and select 
“Create->Property” or “Create->Method”:
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Using MATLAB for controlling instruments

Use the following MATLAB-command sequence to send a SCPI command:

% Create COM-Object

N778X = actxserver('AgServerN778xLib.AgN778x');

% Initialize

N778X.Initialize(’USB::04400133’,0,0);

% Send SCPI-command

Response=N778X.SCPIQuery('*IDN?');

Note that you have to replace the VisaDesciptor ’USB::04400133’ by the 
serial number of your instrument. You can also use a GPIB card installed in 
your computer. In this case, use ’GPIB::30::INSTR’ as descriptor. When 
finished, you should close the instrument:

N778X.Close;

Use this SCPI-Command to measure a polarization state:

SOP=N778X.SCPIQuery(':POL:SOP?');

Alternatively, you can use the corresponding COM-command:

SOP=N778X.Polarimeter.SOP;

Please refer to the MATLAB examples located in the DemoMATLAB folder.

COM/ActiveX-based examples:

• N778xCOMDemo_SOPSweep.m
Free running SOP measurement sweep.

• N778xCOMDemo_SOPSweep_Triggered.m
SOP measurement sweep triggered by the digital BNC input.

• N778xCOMDemo_SOPSweep_PreTrigger.m
Measurement sweep with pre-trigger phase, triggered by the digital 
BNC input.

• N778xCOMDemo_SOPSweep_Continuous.m
Continuous streaming of SOPs.
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SCPI-based examples:

• N778xSCPIDemo_SOPSweep.m
Free running SOP measurement sweep.

• N778xSCPIDemo_SOPSweep_Triggered.m
SOP measurement sweep triggered by the digital BNC input.

• N778xSCPIDemo_SOPSweep_PreTrigger.m
Measurement sweep with pre-trigger phase, triggered by the digital 
BNC input.

• N778xSCPIDemo_SOPSweep_Continuous.m
Continuous streaming of SOPs.
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COM/ActiveX-Interface

The COM/ActiveX-Interface allows you to control the instruments more 
comfortably since modern programming languages allow to browse the 
methods and properties.

For most commands, there is a corresponding SCPI command. These 
commands are described in the next chapter.

Interface List

To use the COM/ActiveX-Interface, you have to create a COM-object using 
the following identifier: 

AgServerN778xLib.AgN778x

In some languages, the library is listed as “IVI AgServerN778xLib ...”.

These are the interfaces offered by the COM Class:

Figure 23 Diagram of COM/ActiveX-interface classes
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IAgN778x

Table 11  Methods of interface IAgN778x

Table 12  Properties of interface IAgN778x

Initialize Initializes the communication to an instrument.

Close Closes an instrument.

SCPIQuery Send a SCPI command.

SCPI2SingleArray Send a SCPI command and interpret the result as array of 
32-bit floating point numbers (single-precision).

SCPI2DoubleArray Send a SCPI command and interpret the result as array of 
64-bit floating point numbers (double-precision).

SCPI2IntArray Send a SCPI command and interpret the result as array of 
32-bit integer numbers.

SCPIQueryBin Send a SCPI command with binary content.

Polarimeter (read only) IAgN778xPolarimeter* Returns the IAgN778xPolarimeter interface to 
control the polarimeter.

PolController (read only) IAgN778xPolController* Returns the IAgN778xPolController interface 
to control the polarization controller.

System (read only) IAgN778xSystem* Returns the IAgN778xSystem interface to 
control system commands.

DriverOperation (read only) IAgN778xDriverOperation* Returns the IAgN778xDriverOperation 
interface to control driver-related settings.

Identity (read only) IAgN778xIdentity* Returns the IAgN778xIdentity interface to 
access the instruments identity information.

Utility (read only) IAgN778xUtility* Returns the IAgN778xUtility interface to 
access some miscellaneous functions.

PolarizationNavigator (read only) IAgN778xPolarizationNavigator* Returns the IAgN778xPolarizationNavigator 
interface to control the Polarization Navigator.

Visa (read only) IAgN778xVisa* Returns the IAgN778xVisa interface to use the 
instrument’s GPIB port as master.
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method Initialize

Initialize(

[in] BSTR ResourceName, 

[in] VARIANT_BOOL idQuery, 

[in] VARIANT_BOOL Reset, 

[in,optional] BSTR OptionString)

Initializes the communication to the instrument. You have to call this 
method at the beginning of your program.
ResourceName 

Defines which interface is to be used to communicate with the instrument. 
Examples: “USB::04011133”, “GPIB::30::INSTR”
idQuery 

Defines whether to communicate with the instrument during initialization.
Reset 

Defines whether the instrument is to be reset during initialization.
OptionString 

Set this string to “DriverSetup= Trace=true” to enable the trace log file. 
See property IAgN778xSystem.TraceEnabled for more details.

method Close

Close()

Closes communication and frees resources.

method SCPIQuery

SCPIQuery(
[in] BSTR SCPICommand,
[out, retval] VARIANT* Response)

See IAgN778xDirectIO.SCPIQuery

method SCPI2SingleArray

SCPI2SingleArray(
[in] BSTR SCPICommand,
[out, retval] VARIANT* Response)

See IAgN778xDirectIO.SCPI2SingleArray
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method SCPI2DoubleArray

SCPI2DoubleArray(
[in] BSTR SCPICommand,
[out, retval] VARIANT* Response)

See IAgN778xDirectIO.SCPI2DoubleArray

method SCPI2IntArray

SCPI2IntArray(
[in] BSTR SCPICommand,
[out, retval] VARIANT* Response)

See IAgN778xDirectIO.SCPI2IntArray

method SCPIQueryBin

SCPIQueryBin(
[in] SAFEARRAY(BYTE) SCPICommand,
[out, retval] VARIANT* Response)

See IAgN778xDirectIO.SCPIQueryBin
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IAgN778xPolarimeter

Interface path: IAgN778x.Polarimeter

Table 13  Methods of interface IAgN778xPolarimeter

Table 14  Properties of interface IAgN778xPolarimeter

Stop Stops an ongoing measurement.

SweepStart Starts an SOP measurement sweep.

QuerySweepState Returns the current sweep status.

Oversampling (read only) IAgN778xOversampling* Returns the IAgN778xOversampling interface to 
control the polarimeter oversampling. This interface 
is not for public use.

SOP (read only) ARRAY(FLOAT) Returns a single SOP.

Wavelength DOUBLE Sets/gets the operating wavelength in nm. 

Gain LONG Sets/gets the current amplifier gain setting.

AutoGainFlag LONG Sets/gets the automatic gain setting.
0: Auto gaining off
1: Auto gaining on. If input power is too low even at 
the highest gain level, an underrange-error will be 
generated.
2: Auto gaining on. The underrange-error will be 
suppressed at the highest gain setting.
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SweepGet (read only) ARRAY(FLOAT) Returns the measurement result. The result is an 
array of single-precision floatling point numbers. The 
element order is as follows:
S0, S1, S2, S3, 
S0, S1, S2, S3, ... 
or in case of the continuous mode 
(eN778xSweepModeSOPContinuous):
TickCount, S0, S1, S2, S3, 
TickCount, S0, S1, S2, S3, ...
Note that TickCount is based on a 16-bit unsigned 
integer number which wraps around when exceeding 
the value 65535. The TickCount value allows to find 
out the exact time at which each sample has been 
taken in the continuous mode.

SweepSamples LONG Sets/gets the desired number of samples.

SweepRate DOUBLE Sets/gets the sweep rate in nm/s. When performing a 
swept measurement, very often, the wavelength is 
changed over time. This parameter allows you to 
inform the instrument about the speed at which the 
wavelength of the laser source is changing. The start 
wavelength is given by the property Wavelength.

SweepSamplingRate DOUBLE Sets/gets the sampling rate in kHz. Maximum 
samplingrate is 1041 kHz.

SweepLastPeakRange DOUBLE Returns how well the ADC range was used for the last 
peak power. If this value is below 0.5, the 
measurement sweep should be repeated with a 
higher amplifier gain setting.

SweepPreTriggerSamples LONG Sets/gets the desired number of pre-trigger samples 
(only valid using the trigger modes 
eN778xTrigSOPCHANGE, 
eN778xTrigPRETRIGTTLHIGH and 
eN778xTrigPRETRIGTTLLOW), see property 
SweepTriggerSource.

SweepPostTriggerSamples LONG Sets/gets the desired number of post-trigger 
samples.

SOPTrigSampleDiff DOUBLE Sets/gets the observed time interval in s for the SOP 
trigger detection.

SOPTrigSampleThres DOUBLE Sets/gets the minimum angular changein deg for the 
SOP trigger detection.
NOTE: Sampling rate must be set prior to setting this 
value.
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SweepContSOPAccuracy DOUBLE Sets/gets the SOP accuracy in rad used in the 
continuous sampling mode (see method SweepStart). 
A value of 0 causes all samples to be stored. This 
corresponds to a constant sampling rate of 2.5 kHz. 
Otherwise SOP changes smaller than 
SweepContSOPAccuracy will not cause a sample to 
be stored.

SweepTriggerSource enum eN778xTrig_t

eN778xTrigNone= 0
eN778xTrigTTLHIGH= 2
eN778xTrigTTLLOW= 3
eN778xTrigSOPCHANGE= 5
eN778xTrigPRETRIGTTLHIGH
= 7
eN778xTrigPRETRIGTTLLOW= 
8

Sets/gets the current trigger source. The values are:
eN778xTrigNone: No triggering.
eN778xTrigTTLHIGH: A measurement is triggered on 
the high edge of the BNC TTL input.
eN778xTrigTTLLOW: A measurement is triggered on 
the low edge of the BNC TTL input.
eN778xTrigSOPCHANGE: A trigger is created on an 
SOP-movement. Use the properties 
SOPTrigSampleDiff and SOPTrigSampleThres to 
adjust the sensitivity. Note that in this mode, the 
number of samples is set by the properties 
SweepPreTriggerSamples and 
SweepPostTriggerSamples.
eN778xTrigPRETRIGTTLHIGH: A trigger is created on 
an high transition on the BNC TTL input. However, in 
this mode, the number of samples is set by the 
properties SweepPreTriggerSamples and 
SweepPostTriggerSamples.
eN778xTrigPRETRIGTTLLOW: A trigger is created on 
an low transition on the BNC TTL input. However, in 
this mode, the number of samples is set by the 
properties SweepPreTriggerSamples and 
SweepPostTriggerSamples.

TriggerLog (read only) ARRAY(DOUBLE) During sweep sampling, trigger events on the BNC 
trigger input are recorded. The property TriggerLog 
returns an array with the sample numbers for which a 
trigger event has been detected. This is helpful when 
receiving digital trigger data from a wavelength 
locker during a wavelength sweep.
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method Stop

Stop()

Stops any ongoing SOP measurement.

method SweepStart

SweepStart([in] enum eN778xSweepMode_t Value)

enum eN778xSweepMode_t

{

eN778xSweepModeSOP = 1,

eN778xSweepModeSOPContinuous = 2,

}

Starts an SOP measurement sweep.
Value: 

Defines the sweep mode. 
A value of eN778xSweepModeSOP starts a normal one-shot 
measurement. 
A value of eN778xSweepModeSOPContinuous corresponds to the “Trace” 
mode in the Polarization Navigator. This allows streaming of SOP data at a 
maximum speed of 2.5 kHz. See the MATLAB example 
“N778xCOMDemo_SOPSweep_Continuous.m” for more details.

method QuerySweepState

QuerySweepState(
[out] LONG *nSamples,
[out] LONG *SweepErrorCode,
[out] BSTR *SweepErrorString,
[out, retval] enum eN778xSweepState_t* SweepState)

enum eN778xSweepState_t

{

eN778xSweepStateIdle = 0,

  eN778xSweepStateArmed = 1,

  eN778xSweepStateSampling = 2,

  eN778xSweepStateDataAvailable = 3,

  eN778xSweepStateError = 4

}

Returns the current sweep status consisting of the number of samples 
sampled so far, the sweep status and a corresponding error code.
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nSamples: 

Number of samples so far.
SweepErrorCode: 

Error code occurred during sampling. 
SweepErrorString: 

Corresponding error string. 
SweepState: 

Current sweep status. 
eN778xSweepStateIdle: No sweep has been started.
eN778xSweepStateSampling: A measurement is in progress.
eN778xSweepStateArmed: The instrument waits for a trigger signal.
eN778xSweepStateDataAvailable: Data can be read from the instrument.
eN778xSweepStateError: An error occurred.
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IAgN778xPolController

Interface path: IAgN778x.PolController

Table 15  Methods of interface IAgN778xPolController

Table 16  Properties of interface IAgN778xPolController

Stop Stops any ongoing polarization controller activity such as a 
sequence operation.

Waveplates Sets the orientation and retardation of the polarization controller 
waveplates.

Sequence (read only) IAgN778xSequence* Returns the IAgN778xSequence interface to control 
the sequence.

Stabilizer (read only) IAgN778xStabilizer* Returns the IAgN778xStabilizer interface to control 
the stabilizer.

WaveplatesPosition ARRAY(DOUBLE) Sets/gets the orientation of the polarization controller 
waveplates in rad. The array needs to have a length of 
5 elements.

WaveplatesRetardation ARRAY(DOUBLE) Sets/gets the retardation of the polarization controller 
waveplates. The array needs to have a length of 5 
elements. The is defined as fractions of Lambda. A 
value of 0.25 corresponds to a quarter waveplate. The 
maximum value of the 1st, 2nd, 4th and 5th 
waveplate is 0.25. Only the 3rd waveplate can create 
a retardation of up to 0.5.
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method Stop

Stop()

Stops any ongoing polarization controller activity such as a sequence 
operation.

method Waveplates

Waveplates(
[in] SAFEARRAY(DOUBLE) Position,
[in] SAFEARRAY(DOUBLE) Retardation);

Sets the orientation and retardation of the polarization controller 
waveplates.

Position: 

Defines the orientation of the 5 waveplates in rad. The array needs to have 
a length of 5 elements.
Retardation: 

Defines the retardation of the 5 waveplates in fractions of Lambda. A value 
of 0.25 corresponds to a quarter waveplate. The maximum value of the 1st, 
2nd, 4th and 5th waveplate is 0.25. Only the 3rd waveplate can create a 
retardation of up to 0.5. The array needs to have a length of 5 elements.

Smoothing DOUBLE Sets/gets the polarization controller smoothing 
switching speed in °/s. Values can range from 100°/s 
to 80000°/s. A value of 0 selects the fastest possible 
switching time.

Program enum eN778xPolConProgram_t

eN778xPolConProgramManual
= 0
eN778xPolConProgramScrambl
e = 10
eN778xPolConProgramSequen
ce = 32
eN778xPolConProgramReload= 
33

Sets the operation mode of the polarization controller 
or starts a sequence.

eN778xPolConProgramManual: The waveplate 
positions and retardations can be manually set.
eN778xPolConProgramScramble: Generates a 
random scrambling sequence.
eN778xPolConProgramSequence: Starts a sequence 
which has been written to the polarization controller 
using the IAgN778xSequence interface.
eN778xPolConProgramReload: Restarts a sequence 
which has been stopped using the Stop method.
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IAgN778xSequence

Interface path: IAgN778x.PolController.Sequence

Table 17  Methods of interface IAgN778xSequence

Table 18  Properties of interface IAgN778xSequence

SeqVoltage Sets the polarization controller sequence using direct
voltage values.

Sequence Sets the polarization controller sequence using waveplate
positions and retardations.

Length LONG Sets/gets the polarization controller sequence 
length.

RepetitionRate DOUBLE Sets/gets the polarization controller repetition 
rate in kHz.

Timebase enum eN778xPolConTimebase_t

eN778xPolConTimebaseTimer= 0
eN778xPolConTimebasePolarimeter= 1
eN778xPolConTimebaseExternal= 2

Sets/gets the polarization controller time base.

eN778xPolConTimebaseTimer: Uses an 
independent timer as clock.
eN778xPolConTimebasePolarimeter: Uses the 
same timer as the polarimeter.
eN778xPolConTimebaseExternal: Uses the BNC 
input as clock.

AutoOversampling BOOL Sets/gets the polarization controller 
auto-oversampling flag. If set to true, the 
internal sampling rate might chosen to be 
higher than set by the property RepetitionRate. 
This allows to compensate for certain drift 
behavior of the LiNbO3 chip.

Retrigger BOOL Sets/gets the polarization controller retrigger 
flag. A value of true allows a running sequence 
to be retriggered and thus interrupted by a 
trigger event. If set to false, subsequent trigger 
events are ignored.
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DriftCompensation BOOL Sets/gets the polarization controller 
drift-compensation flag. Normally, this value is 
set to true. When set to true, the drift behavior 
of the LiNbO3 chip is partailly compensated 
using internal calibration data.

Prescaler LONG Sets/gets the polarization controller pre-scaler 
value. This parameter allows to divide the 
sequence clock. The default value is 0 which 
does not divide the clock. A value of 1 divides 
by 2. A value of 2 divides by 3 etc.

Holdoff LONG Sets/gets the polarization controller hold-off 
value in μs. The hold-off value defines a latency 
time between the trigger event and the 
sequence start.

Oversampling LONG Sets/gets the polarization controller 
oversampling value. A value greater than 1 
increases the internal sampling rate. E.g. 
RepetitionRate set to 10kHz and Oversampling 
set to 10 creates an internal sampling rate of 
100kHz. The missing sequence entries are 
calculated to minimize drift (only if 
DriftCompensation is set to true). Note that this 
value is automaticaly set by the instrument if 
AutoOversampling is set to true.

SyncOutTrigger LONG Sets/gets the synchronization shift of the 
synchronous sequence output trigger feature. 
This feature allows to output a clock signal to 
the first analog output on the expansion port. A 
value of 0 turns this feature off. A non-zero 
value turns this feature on. Note that the 
property Oversampling needs to be greater than 
1. In that case, values of 1..Oversampling can 
define the phase shift of the clock output.
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SyncMode enum eN778xPolConSyncMode_t

eN778xPolConSyncModeAutoRepeat = 0
eN778xPolConSyncModeAutoOneshot = 1
eN778xPolConSyncModeExternalRepeat = 2
eN778xPolConSyncModeExternalOneshot =3
eN778xPolConSyncModePolarimeterRepeat = 4
eN778xPolConSyncModePolarimeterOneshot = 5

Sets/gets the polarization controller 
synchronization mode.

eN778xPolConSyncModeAutoRepeat: 
Sequence will automatically start and restart 
when reaching the end.
eN778xPolConSyncModeAutoOneshot: 
Sequence will automatically start and run only 
once.
eN778xPolConSyncModeExternalRepeat: 
Sequence will start when a low/high-transition 
is detected on the BNC input. When reachig the 
end of the sequence, it will be restarted.
eN778xPolConSyncModeExternalOneshot: 
Same as above, except that the sequence will 
not be repeated.
eN778xPolConSyncModePolarimeterRepeat: 
Sequence is started when the polarimeter starts 
sampling. The sequence is repeated when 
reaching the end.
eN778xPolConSyncModePolarimeterOneshot: 
Same as above, except that the sequence will 
not be repeated.

SuggestPolMetOversampling LONG See SuggestPolMetSamplingRate.

SuggestPolMetSamplingRate DOUBLE Not all ratios between the polarimeter clock and 
the polarization controller clock can be exactly 
synchronized to each other. Writing into this 
property will optimize the settings.
First, set the RepetitionRate property to the 
desired value. Then set the property 
SuggestPolMetOversampling to the desired 
polarimeter oversampling value. If 
AutoOversampling is false, set the property 
Oversampling to the desired value.
Now write the desired polarimeter sampling 
rate into the property 
SuggestPolMetSamplingRate. This will trigger 
the optimization process. As a result, the 
property RepetitionRate and 
SuggestPolMetSamplingRate has been 
modified. You should read the property 
SuggestPolMetSamplingRate and write it to 
IAgN778xPolarimeter.SweepSamplingRate.
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method SeqVoltage

SeqVoltage([in] SAFEARRAY(USHORT) pVal)

Sets the polarization controller sequence using direct voltage values.
pVal: 

Defines the voltage values. The voltage levels are defined by 16-bit 
unsigned integer values. Each element may range from 0 to 4095, where 
2048 is the neutral setting. Each waveplate is controlled by two voltages. 
Thus, each sequence row contains 10 voltage levels. Hence, the array 
length has to be a multiple of 10.

method Sequence

Sequence([in] SAFEARRAY(FLOAT) pVal)

Sets the polarization controller sequence using waveplate positions and 
retardations.
pVal: 

Defines the orientation and retardation values. Each waveplate is 
controlled by two float values: Orientation in rad and Retardation in 
fractions of Lambda (0.25 corresponds to l/4). Thus, each sequence row 
contains 10 float values. Hence, the array length has to be a multiple of 10. 
Each row has the following order:

Orientation waveplate 1
Retardation waveplate 1
Orientation waveplate 2
Retardation waveplate 2
Orientation waveplate 3
Retardation waveplate 3
Orientation waveplate 4
Retardation waveplate 4
Orientation waveplate 5
Retardation waveplate 5
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IAgN778xStabilizer

Interface path: IAgN778x.PolController.Stabilizer

Table 19  Methods of interface IAgN778xStabilizer

Table 20  Properties of interface IAgN778xStabilizer

FlashWrite Writes current settings to the flash memory.

Stabilize BOOL Sets/gets the state of the polarization stabilizer.

OnStartupStabilize BOOL Sets/gets the stabilizer stabilize-on-startup flag. A value of 
true will cause the instrument to start the stabilizer 
immediately after power on. Note that you have to use the 
method FlashWrite to store this setting in flash memory.

Invert BOOL Sets/gets the stabilizer invert
flag. A value of true inverts the error criterion.

SOP ARRAY(DOUBLE) Sets the target SOP or returns the current SOP. The target 
SOP can be provided as a 3-element normalized Stokes 
vector or a 4-element Stokes vector (with DOP=1). Reading 
this property will read the currently measured SOP from the 
stabilizer. Note that this property is only valid if the 
instruemnt contains a polarization analyzer such as 
N7788B or N7786B.

Feedback enum eN778xPolConFeedback_t

eN778xPolConFeedbackSOP= 0
eN778xPolConFeedbackInternal= 1
eN778xPolConFeedbackPower= 2
eN778xPolConFeedbackAnalogIn= 3
eN778xPolConFeedbackDOP= 4

Sets/gets the stabilizer feedback mode.

eN778xPolConFeedbackSOP: Uses the SOP as a feedback 
(only N7788B or N7786B).
eN778xPolConFeedbackInternal: Uses the internal 
photodetector of the N7784B.
eN778xPolConFeedbackPower: Uses the optical power 
(S0) as feedback (only N7788B or N7786B),
eN778xPolConFeedbackAnalogIn: Uses the analog input 
of the N7784B.
eN778xPolConFeedbackDOP: Uses the DOP as feedback 
(only N7788B or N7786B).
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method FlashWrite

FlashWrite()

Writes current settings to the flash memory. Use this command to write 
the state of the property OnStartupStabilize into the flash memory.
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IAgN778xSystem

Interface path: IAgN778x.System

Table 21  Properties of interface IAgN778xSystem

DirectIO (read only) IAgN778xDirectIO* Returns the IAgN778xDirectIO interface to control direct 
input/output.

GPIBMaster (read only) IAgN778xGPIBMaster* Returns the IAgN778xGPIBMaster interface to use the 
instrument’s GPIB port as master. 
Note: This interface is not for public use. Use the interface 
provided by IAgN778x.Visa instead.

SerialNumber (read only) BSTR Returns the instrument’s serial number.

ModelCode (read only) BSTR Returns the instrument’s serial mode code (e.g. “N7788B”).

Temperature (read only) DOUBLE Returns the internal temperature in °C.

GPIBAddress LONG Sets/gets the GPIB address.

TraceEnabled BOOL Sets/gets the “trace” flag. Setting this value to true will 
generate a log file on the desktop. The generated file is an 
XML file wich can be opened e.g. using the Internet Explorer.

AnalogOut ARRAY(DOUBLE) Sets/gets the analog output levels on the expansion port. The 
array needs to have a 4 elements ranging from -1 to 1. This 
corresponds to an output voltage of 0V .. 5V. Note: Reading 
this property returns the last value written into this property. If 
the instrument writes into the DACs, the property is left 
unchanged.
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IAgN778xDirectIO

Interface path: IAgN778x.System.DirectIO

Table 22  Methods of interface IAgN778xDirectIO

method SCPIQuery

SCPIQuery(
[in] BSTR SCPICommand,
[out, retval] VARIANT* Response)

Sends a SCPI command to the instrument and reads the response.
SCPICommand: 

The SCPI command.
Response: 

Normally, a string will be returned (BSTR). If the response starts with a ’#’, 
the data will be decoded and returned as BYTE array.

method SCPI2SingleArray

SCPI2SingleArray(
[in] BSTR SCPICommand,
[out, retval] VARIANT* Response)

Sends a SCPI command to the instrument and reads the response. A 
binary response will be interpreted as array of single-precision floating 
point values.

SCPIQuery Sends a SCPI command to the instrument and reads the response.

SCPI2SingleArray Sends a SCPI command to the instrument and reads the response as 
array of single-precision floating point values.

SCPI2DoubleArray Sends a SCPI command to the instrument and reads the response as 
array of double-precision floating point values.

SCPI2IntArray Sends a SCPI command to the instrument and reads the response as 
array of 32-bit integer values.

SCPIQueryBin Sends a binary SCPI command to the instrument and reads the response 
as binary (array of 8-bit unsigned integer values).
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SCPICommand: 

The SCPI command.
Response: 

Normally, a string will be returned (BSTR). If the response starts with a ’#’, 
the data will be decoded and returned as FLOAT array.

method SCPI2DoubleArray

SCPI2DoubleArray(
[in] BSTR SCPICommand,
[out, retval] VARIANT* Response)

Sends a SCPI command to the instrument and reads the response. A 
binary response will be interpreted as array of double-precision floating 
point values.
SCPICommand: 

The SCPI command.
Response: 

Normally, a string will be returned (BSTR). If the response starts with a ’#’, 
the data will be decoded and returned as DOUBLE array.

method SCPI2IntArray

SCPI2IntArray(
[in] BSTR SCPICommand,
[out, retval] VARIANT* Response)

Sends a SCPI command to the instrument and reads the response. A 
binary response will be interpreted as array of 32-bit integer values.
SCPICommand: 

The SCPI command.
Response: 

Normally, a string will be returned (BSTR). If the response starts with a ’#’, 
the data will be decoded and returned as LONG array.
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method SCPIQueryBin

SCPIQueryBin(
[in] SAFEARRAY(BYTE) SCPICommand,
[out, retval] VARIANT* Response);

Sends a SCPI command to the instrument and reads the response. A 
binary response will be interpreted as array of single-precision floating 
point values.
SCPICommand: 

The SCPI command as BYTE array.
Response: 

Normally, a string will be returned (BSTR). If the response starts with a ’#’, 
the data will be decoded and returned as BYTE array.
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IAgN778xDriverOperation

Interface path: IAgN778x.DriverOperation

Table 23  Methods of interface IAgN778xDriverOperation

Table 24  Properties of interface IAgN778xDriverOperation

method ThrowError

ThrowError([in] LONG ErrorCode)

Generates an error with the passed error code for testing purposes. 
Normally, an exception will be generated and the program should stop 
execution.
ErrorCode: 

The desired error code.

method ConvertErrorCode

ConvertErrorCode(
[in] LONG ErrorCode,
[out, retval] BSTR* pVal);

Converts an error code to a human readable string.

ThrowError Generates an error with the passed error code for testing purposes.

ConvertErrorCode Converts an error code to a human readable string.

ExceptionOnError BOOL Enables (default) or disables the generation 
of an exception if an error occurs. Temporarily 
disabling the exceptions can be useful to 
prevent program interruption if a controlled 
error handling is desired. You can use the 
property LastError to query the last error 
result.

LastError (read only) LONG Returns the last error result. 
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ErrorCode: 

The error code to be converted.
pVal: 

The generated error string.
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IAgN778xUtility

Interface path: IAgN778x.Utility

Table 25  Methods of interface IAgN778xUtility

Table 26  Properties of interface IAgN778xUtility

method Reset

Reset()

Sets the instrument to a predefined state.

Reset Sets the instrument to a predefined state.

SelfTestResult (read only) LONG Returns the self-test result. A value of 0 
indicates “no error”.

USBInstruments (read only) ARRAY(BSTR) Returns VISA descriptors of the connected 
USB instruments.
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IAgN778xIdentity

Interface path: IAgN778x.Identity

Table 27  Properties of interface IAgN778xIdentity

IdentityString (read only) BSTR Returns the identity-string (the response to 
the “*IDN?” SCPI-Command.
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IAgN778xVisa

Interface path: IAgN778x.Visa

Table 28  Methods of interface IAgN778xVisa

method Initialize

Initialize(
[in] BSTR ResourceName, 
[in,optional] BSTR RemoteGPIBInterface)

Initializes the communication either to a VISA instrument or an instrument 
connected to the GPIB-master port of the N778x instrument. We 
recommend to use this interface if you want the flexibility to either connect 
your supporting instrument (e.g. a tunable laser) to the GPIB master port 
of the N778x instrument or to use the VISA library installed on your 
computer. Any read/write operations have to be done using the methods 
of IAgN778xVisa. As a consequence, you can redirect the communication 
either to the VISA library or the GPIB master port just by changing the call 
to the “Initialize” method (see the following examples).

ResourceName: 

The VISA descriptor of the instrument to talk to (e.g. “GPIB::20::INSTR“).
RemoteGPIBInterface: 

Initialize Initializes the communication either to a VISA instrument or an 
instrument connected to the GPIB-master port of the N778x instrument.

Write Writes a string to the interface.

WriteBin Writes binary data to the interface.

Read Reads a string from the interface.

ReadSingleArray Reads from the interface and interprets binary data as array of 
single-precision floating point values.

ReadDoubleArray Reads from the interface and interprets binary data as array of 
double-precision floating point values.

ReadIntArray Reads from the interface and interprets binary data as array of 32-bit 
integer values.
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Leave this empty if you want to use the VISA library on our computer. 
Otherwise, set this value to the VISA descriptor of the N778x instrument to 
be used as GPIB master (e.g. “USB::DE04400133“).

Examples:

IAgN778x.Visa.Initialize(“GPIB::20::INSTR”,””);

Start communication to a GPIB instrument with the address 20 using the 
GPIB interface installed in your computer.

IAgN778x.Visa.Initialize(“TCPIP0::134.40.9.177::inst0::INSTR”,””);

Start communication to an instrument via TCP/IP using the VISA library 
installed on your computer.

IAgN778x.Visa.Initialize(“GPIB::20::INSTR”,”USB::DE04400133”);

Start communication to a GPIB instrument with the address 20 which is 
connected to the GPIB port of the N778x instrument with the serial 
number DE04400133 which is connected to the USB-port of your 
computer.
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IAgN778xPolarizationNavigator

Interface path: IAgN778x.PolarizationNavigator

Table 29  Methods of interface IAgN778xPolarizationNavigator

method SendCommand

SendCommand(
[in] BSTR Target, 
[in] BSTR Command, 
[out, retval] BSTR* Result)

Sends a command to the Polarization Navigator using its Automation 
Interface (see Polarization Navigator Automation on page 241).

Target: 

The target name.
Command: 

The automation command.
Result: 

The result from sent by the Polarization Navigator.

Examples:

IAgN778x.PolarizationNavigator.SendCommand(“Global”,”Get Version”);

Retrieves the Polarization Navigator version.

method Disconnect

Disconnect()

Disconnects any remotely connected Polarization Navigator instances (see 
Polarization Navigator Automation on page 241).

SendCommand Sends a command to the Polarization Navigator

Disconnect Disconnects any remotely connected Polarization Navigator instances.
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SCPI Commands

SCPI commands can be used for device communication over USB and the 
GPIB interface. This chapter summarizes all available SCPI commands with 
their syntax and parameter lists. Every command returns an error code 
(see Error Codes on page 336). If a command or result has more than one 
parameter handed over, each parameter is separated by a comma (,). Note 
that floating point values use a “.” as decimal point. SCPI commands can 
be sent to the instrument using the COM Class AgServerN778xLib which 
comes with the software. Please refer to the examples which are included 
for LabView and MATLAB.

For testing purposes, you can use the program “AgN778xSend.exe” which 
you can find the in start menu in “Keysight Photonic Application 
Suite->N778x”:
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Command Reference

Table 30  Summary of SCPI commands and corresponding COM/ActiveX functions. See 
COM/ActiveX documentation for a detailed description.

SCPI-Command COM/ActiveX function

*IDN? IAgN778xIdentity.IdentityString
Returns the instrument identification string.

*TST? IAgN778xUtility.SelfTestResult
Returns selftest result.

*RST IAgN778xUtility.Reset
Sets the instrument to a predefined state.

:HELLO? No corresponding COM/ActiveX function
Returns the string “Hello World”. Works without an instrument 
connected.

:POLarimeter:SOP? IAgN778xPolarimeter.SOP
Returns a single SOP.

:POLarimeter:WAVElength {DOUBLE}
:POLarimeter:WAVElength?

IAgN778xPolarimeter.Wavelength
Sets/gets the operating wavelength in nm.

:POLarimeter:GAIN {LONG}
:POLarimeter:GAIN?

IAgN778xPolarimeter.Gain
Sets/gets the current amplifier gain setting.

:POLarimeter:AUTOGAINflag [0,1,2]
:POLarimeter:AUTOGAINflag?

IAgN778xPolarimeter.AutoGainFlag
Sets/gets the automatic gain setting.

:POLarimeter:STOP IAgN778xPolarimeter.Stop
Stops an ongoing measurement.

:POLarimeter:SWEep:START 
[SOP,SOPCONTINUOUS]

IAgN778xPolarimeter.SweepStart
Starts an SOP measurement sweep.

:POLarimeter:SWEep:STATE? IAgN778xPolarimeter.QuerySweepState
Returns the current sweep status. The result is formatted as follows:
nSamples, [IDLE, ARMED, SAMPLING, DATA_AVAILABLE, ERROR], 
ErrorCode, ”Error String”

:POLarimeter:SWEep:GET? IAgN778xPolarimeter.SweepGet
Returns the measurement result. In case of the SOPCONTINUOUS 
mode, tick count values are included. The result is formatted as 
follows:
{BINBLOCK(FLOAT): S0, S1, S2, S3, S0, S1, S2, S3, ... }
or in case of the SOPCONTINUOUS mode:
{BINBLOCK(FLOAT): TickCount, S0, S1, S2, S3, TickCount,
S0, S1, S2, S3, ... }
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:POLarimeter:SWEep:SAMPLES {LONG}
:POLarimeter:SWEep:SAMPLES?

IAgN778xPolarimeter.SweepSamples
Sets/gets the desired number of samples.

:POLarimeter:SWEep:SWEEPrate {DOUBLE}
:POLarimeter:SWEep:SWEEPrate?

IAgN778xPolarimeter.SweepRate
Sets/gets the sweep rate in nm/s.

:POLarimeter:SWEep:SAMPLINGrate {DOUBLE}
:POLarimeter:SWEep:SAMPLINGrate?

IAgN778xPolarimeter.SweepSamplingRate
Sets/gets the sampling rate in kHz.

:POLarimeter:SWEep:LASTPEAKrange? IAgN778xPolarimeter.SweepLastPeakRange
Returns how well the ADC range was used for the last peak power.

:POLarimeter:SWEep:PREtrigger:PRETRIGsample
s {LONG}
:POLarimeter:SWEep:PREtrigger:PRETRIGsample
s?

IAgN778xPolarimeter.SweepPreTriggerSamples
Sets/gets the desired number of pre-trigger samples (only valid 
using for the trigger modes SOPCHANGE, PRETRIGGER_TTLHIGH 
and PRETRIGGER_TTLLOW), see “:TRIGger:SOURce”.

:POLarimeter:SWEep:PREtrigger:POSTTRIGsampl
es {LONG}
:POLarimeter:SWEep:PREtrigger:POSTTRIGsampl
es?

IAgN778xPolarimeter.SweepPostTriggerSamples
Sets/gets the desired number of post-trigger samples (only valid 
using for the trigger modes SOPCHANGE, PRETRIGGER_TTLHIGH 
and PRETRIGGER_TTLLOW), see “:TRIGger:SOURce”.

:POLarimeter:SWEep:PREtrigger:SAMPLEDIFF 
{DOUBLE}
:POLarimeter:SWEep:PREtrigger:SAMPLEDIFF?

IAgN778xPolarimeter.SOPTrigSampleDiff
Sets/gets the observed time interval in s for the SOP trigger 
detection.

:POLarimeter:SWEep:PREtrigger:SAMPLETHRESh
old {DOUBLE}
:POLarimeter:SWEep:PREtrigger:SAMPLETHRESh
old?

IAgN778xPolarimeter.SOPTrigSampleThres
Sets/gets the minimum angular change in deg for the SOP trigger 
detection.
NOTE: Sampling rate must be set prior to setting this value.

:POLarimeter:SWEep:CONTinuous:SOPACCuracy 
{DOUBLE}
:POLarimeter:SWEep:CONTinuous:SOPACCuracy

IAgN778xPolarimeter.SweepContSOPAccuracy
Sets/gets the SOP accuracy in rad used in the continuous sampling 
mode (see “:POLARIMETER:SWEEP:START”).

:TRIGger:SOURce [NONE, TTLHIGH, TTLLOW, 
SOPCHANGE, PRETRIGGER_TTLHIGH, 
PRETRIGGER_TTLLOW]
:TRIGger:SOURce?

IAgN778xPolarimeter.SweepTriggerSource
Sets or returns the trigger source.

:POLCONtroller:STOP IAgN778xPolController.Stop
Stops any ongoing polarization controller activity such as a 
sequence operation.
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:POLCONtroller:WAVEPLates 
{DOUBLE,DOUBLE,...}
:POLCONtroller:WAVEPLates?

IAgN778xPolController.Waveplates
Sets or returns the orientation and retardation of the polarization 
controller waveplates. The data consists of 10 floating point values. 
The order is given by:
Orientation Waveplate 1, Retardation Waveplate 1, Orientation 
Waveplate 2, Retardation Waveplate 2, Orientation Waveplate 3, 
Retardation Waveplate 3, Orientation Waveplate 4, Retardation 
Waveplate 4, Orientation Waveplate 5, Retardation Waveplate 5
The orientation is given in rad, the retardation is given in fractions of 
λ. A retardation of 0.25 corresponds to a quarter waveplate. The 
maximum value of the 1st, 2nd, 4th and 5th waveplate is 0.25. Only 
the 3rd waveplate can create a retardation of up to 0.5. 

:POLCONtroller:PROGRAM [MANUAL, 
SCRAMBLE, SEQUENCE, RELOAD]
:POLCONtroller:PROGRAM?

IAgN778xPolController.Program
Sets the operation mode of the polarization controller or starts a 
sequence.

:POLCONtroller:SMOOTHing {DOUBLE}
:POLCONtroller:SMOOTHing?

IAgN778xPolController.Smoothing
Sets/gets the polarization controller smoothing switching speed in 
°/s. Values can range from 100°/s to 80000°/s. A value of 0 selects 
the fastest possible switching time.

:POLCONtroller:SEQuence:LENgth {LONG}
:POLCONtroller:SEQuence:LENgth?

IAgN778xSequence.Length
Sets/gets the polarization controller sequence length.

:POLCONtroller:SEQuence:REPRATE {DOUBLE}
:POLCONtroller:SEQuence:REPRATE?

IAgN778xSequence.RepetitionRate
Sets/gets the polarization controller repetition rate in kHz.

:POLCONtroller:SEQuence:SYNCMODE 
[AUTOREPEAT, AUTOONESHOT, 
EXTERNALREPEAT, EXTERNALONESHOT, 
POLMETREPEAT, POLMETONESHOT]
:POLCONtroller:SEQuence:SYNCMODE?

IAgN778xSequence.SyncMode
Sets/gets the polarization controller synchronization mode.

:POLCONtroller:SEQuence:TIMEbase [TIMER, 
POLARIMETER, EXTERNAL]
:POLCONtroller:SEQuence:TIMEbase?

IAgN778xSequence.SyncMode
Sets/gets the polarization controller time base.

:POLCONtroller:SEQuence:AUTOOVERsampling 
[0,1]
:POLCONtroller:SEQuence:AUTOOVERsampling?

IAgN778xSequence.AutoOversampling
Sets/gets the polarization controller auto-oversampling flag.

:POLCONtroller:SEQuence:RETRIGger [0,1]
:POLCONtroller:SEQuence:RETRIGger?

IAgN778xSequence.Retrigger
Sets/gets the polarization controller retrigger flag.

:POLCONtroller:SEQuence:DRIFTcompensation 
[0,1]
:POLCONtroller:SEQuence:DRIFTcompensation?

IAgN778xSequence.DriftCompensation
Sets/gets the polarization controller drift-compensation flag.

:POLCONtroller:SEQuence:PREscaler {LONG}
:POLCONtroller:SEQuence:PREscaler?

IAgN778xSequence.Prescaler
Sets/gets the polarization controller pre-scaler value.
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:POLCONtroller:SEQuence:HOLDoff {LONG}
:POLCONtroller:SEQuence:HOLDoff?

IAgN778xSequence.Holdoff
Sets/gets the polarization controller hold-off value in μs.

:POLCONtroller:SEQuence:OVERsampling 
{LONG}
:POLCONtroller:SEQuence:OVERsampling?

IAgN778xSequence.Oversampling
Sets/gets the polarization controller oversampling value.

:POLCONtrollerSEQuence:SEQUENCE 
{DOUBLE,DOUBLE, ...}
:POLCONtrollerSEQuence:SEQUENCE 
{BINBLOCK(FLOAT)}

IAgN778xSequence.Sequence
Sets the polarization controller sequence using waveplate positions 
and retardations. The parameter list is a series of floating point 
values. Each waveplate is controlled by two float values: Orientation 
in rad and Retardation in fractions of Lambda (0.25 corresponds to 
λ/4). Thus, each sequence row contains 10 float values. Hence, the 
series length has to be a multiple of 10. Each row has the following 
order:
Orientation waveplate 1
Retardation waveplate 1
Orientation waveplate 2
Retardation waveplate 2
Orientation waveplate 3
Retardation waveplate 3
Orientation waveplate 4
Retardation waveplate 4
Orientation waveplate 5
Retardation waveplate 5
The sequence can also be supplied as a binary block of 
single-precision floating point numbers.

:POLCONtroller:SEQuence:SEQVOLTage {INT16, 
INT16, ... }
:POLCONtroller:SEQuence:SEQVOLTage 
{BINBLOCK(INT16)}

IAgN778xSequence.SeqVoltage
Sets the polarization controller sequence using direct voltage 
values. The parameter list is a series of integer values 
corresponding to the voltage levels. Each element may range from 0 
to 4095, where 2048 is the neutral setting. Each waveplate is 
controlled by two voltages. Thus, each sequence row contains 10 
voltage levels. Hence, the series length has to be a multiple of 10.
The sequence can also be supplied as a binary block of 
single-precision 16-bit integer numbers.

:POLCONtroller:SEQuence:SYNCOUTtrigger 
{LONG}
:POLCONtroller:SEQuence:SYNCOUTtrigger?

IAgN778xSequence.SyncOutTrigger
Sets/gets the synchronization shift of the synchronous sequence 
output trigger feature.

:POLCONtroller:SEQuence:SUGGESTPOLMETOVE
Rsampling {LONG}
::POLCONtroller:SEQuence:SUGGESTPOLMETOV
ERsampling?

IAgN778xSequence.SuggestPolMetOversampling

:POLCONtroller:SEQuence:SUGGESTPOLMETRAT
E {DOUBLE}
::POLCONtroller:SEQuence:SUGGESTPOLMETRAT
E?

IAgN778xSequence.SuggestPolMetSamplingRate
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:STABilizer:STABilize [0,1]
:STABilizer:STABilize?

IAgN778xStabilizer.Stabilize
Sets/gets the state of the polarization stabilizer.

:STABilizer:FLASHwrite IAgN778xStabilizer.FlashWrite
Writes current settings to the flash memory.

:STABilizer:ONSTARTUPstabilize [0,1]
:STABilizer:ONSTARTUPstabilize?

IAgN778xStabilizer.OnStartupStabilize
Sets/gets the stabilizer stabilize-on-startup flag.

:STABilizer:INVert [0,1]
:STABilizer:INVert?

IAgN778xStabilizer.Invert
Sets/gets the stabilizer invert flag.

:STABilizer:SOP {DOUBLE, DOUBLE, DOUBLE 
[,DOUBLE]}
:STABilizer:SOP?

IAgN778xStabilizer.SOP
Sets the target SOP or returns the current SOP.

:STABilizer:FEEDbackmode [SOP, DOP, POWER, 
INTERNAL, ANALOGIN]
:STABilizer:FEEDbackmode?

IAgN778xStabilizer.Feedback
Sets/gets the stabilizer feedback mode.

:SYSTem:ERRor? Returns the last error code. Note that reading the error will clear the 
error state.

:SYSTem:TRACEenabled [0,1]
:SYSTem:TRACEenabled?

IAgN778xSystem.TraceEnabled
Enables or disables the trace log file.

:SYSTem:COMMunicate:GPIB:[SELF:]ADDress 
{LONG}
:SYSTem:COMMunicate:GPIB:[SELF:]ADDress?

IAgN778xSystem.GPIBAddress
Sets/gets the GPIB address.

:SYSTem:SPECial:TEMPerature? IAgN778xSystem.Temperature
Returns the temperature measured by the internal temperature 
sensor.

:SYSTem:ANALOGout:IMMediate {DOUBLE, 
DOUBLE, DOUBLE, DOUBLE}

IAgN778xSystem.AnalogOut
Sets the analog outputs.
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Table 31  SCPI Datatypes

Datatype Explanation

DOUBLE 64-bit double-precision floating point number. The parameter is written 
in the standard IEEE format (e.g. “1e-6” or “1.234”)

FLOAT 32-bit single-precision floating point number. The parameter is written 
in the standard IEEE format (e.g. “1e-6” or “1.234”)

LONG 32-bit integer number.

INT16 16-bit integer number.

BINBLOCK(FLOAT) Describes a block of binary single-precision floating point values. A 
binary block always begins with a ’#’ character. The next character is 
numeric and denotes the number of bytes to skip (including the ’#’ 
character) before the actual binary data begins. The following numeric 
characters form the number of bytes in the actual binary block.
Example:
A single-precision floating point number (“FLOAT”) consists of 4 bytes. 
Thus, three FLOATs are 12 bytes long. The binary block looks like
#412xxxxyyyyzzzz
where “xxxx”, “yyyy” and “zzzz” denote the 4 bytes of one FLOAT value. 
The byte order is little-endian.

BINBLOCK(INT16) Describes a block of binary 16-bit integer values. The format is the same 
as in BINBLOCK(FLOAT).
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This chapter describes the LabView™ driver libraries installed at 
installation of the polarizationNAVIGATOR™.
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Starting a VISA Session   /  189
Variable Handling   /  191
Error Codes   /  192
Generic Instrument Settings VIs   /  193
Polarization Controller VIs   /  196
Polarimeter Control VIs   /  205
Demo VIs   /  212

NOTE
Please note that in the future, only the COM/ActiveX drivers will be 
supported since they offer a much easier way to access the instruments. 
See Direct Instrument Control on page 145 for more information.
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Introduction

Installation The LabView™ driver libraries are installed upon installation of 
the polarizationNAVIGATOR™. You can find them in the Examples\
LabView subfolder of the polarizationNAVIGATOR™ installation directory.

The LabView™ driver libraries contain the following files:

Table 32  LabView™ Driver Library Files

File Description

MIP.llb Collection of VIs for LabView VISA initialization 
and low-level communication

MIPCommands.llb Collection of VIs for device programming on 
application level 

Changed.llb Miscellaneous VIs used in 
DemoPolarimeter.vi

PoincareSphere.llb Miscellaneous VIs for graphical Poincaré 
sphere display
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Starting a VISA Session

To initialize a new VISA session to any of the N778xB/BD devices from your 
LabView™ VI, start with the VI MIP Init.vi which can be found in 
library MIP.llb.

The VI initializes the communication between your VI and the device over 
the desired interface port and assigns the device a unique device 
descriptor number which can be used throughout the whole LabView 
session to address that particularly device. When using these VIs, the VISA 
resource name (or VISA alias) for the desired port must be provided as a 
parameter, e.g. GPIB::30::INSTR. The VISA resource name is identical to 
that used in National Instruments Measurement & Automation Explorer 
(for further information please refer to the NI-VISATM Programmer 
Reference Manual). When using an USB interface for communication, the 
VISA resource name consists of the prefix string USB:: followed by the 
serial number of the device, e.g. USB::DE48100001. If the PC controlling 
the instrument is equipped with an Ethernet adapter, the instrument can 
be accessed remotely by using an additional TCP prefix, containing the IP 
address of that PC, followed by the GPIB or USB string, which is used 
locally on the PC the instrument is connected to, e.g.

TCP::192.168.0.1::USB::DE48100100. 

Instruments of the N778xBD series are equipped with an internal PC, 
internal USB communication and an ethernet adapter, so if such an 
instrument is connected to the local area network or the internet and its IP 
address is known, it can be accessed from LabView VIs running on a 
remote PC by using a descriptor as just described, where the IP address 
and the serial number have to be changed to the actual instrument. The IP 
address of a computer that the polarizationNAVIGATOR™ is installed on 
can easily be obtained by selecting Show IP Address from the Tools menu 
of the polarizationNAVIGATOR™.

One additional parameter can optionally be handed over to the VI, which is 
the device timeout settings in ms (not mandatory).

The VI returns the device descriptor number as stated above and the 
model identification code for the device found on that interface address.

An examples for a VISA session setup is shown below (here: timeout is set 
to 5000ms):
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Variable Handling

All variables available for communication on the device are arranged in a 
tree structure and are addressed by their tree/branch (TreeNo) and 
variable number (VarNo). Additionally each variable has a type from the 
following list:

Binary, UINT8, UINT16, UINT32, INT8, INT16, INT32, TEXTSTRING, 
ARRAYUINT8, ARRAYUINT16, ARRAYUINT32, ARRAYINT8, ARRAYINT16, 
ARRAYINT32, ARRAYTEXTSTRING, FLOAT32, ARRAYFLOAT32

All variables and trees available on the devices are listed under Instrument 
Variables (Discontinued) on page 233. When using variables with an (1D) 
array type, you can address each sub element by its index number (Index).
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Error Codes

All VIs return an error code after execution which shows the result of the 
latest operation. If no error has occurred the VI should return zero, 
otherwise you can find the corresponding explanation in the error list (see 
Error Codes on page 336).
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Generic Instrument Settings VIs

All VIs described here can be found in the library MIPCommands.llb 
and are used to get or set any device specific variables. The device you 
want to communicate with is addressed by the device descriptor number 
as described above (see Starting a VISA Session on page 189).

Not all listed input and output parameters are mandatory or valid for 
operations on different variable types. The parameters which are optional 
or only valid for only one type of variables are indicated with square 
brackets in the following list of MIP-Functions.

MIP_CommonVariableGet

To get the value of a variable available on your device, you can use the VI 
MIP CommonVariableGet.vi. You specify the descriptor numbers 
and type for the requested variable and receive its current value in the 
matching output field.

Please note that array type variables can only be accessed through their 
single elements using the index parameter.

Table 33  MIP_CommonVariableGet Parameters

Input parameters: Device descriptor, tree number, variable number, index 
number, variable type

Output parameters: Device descriptor, (integer data, float data, string data), 
error code
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MIP_CommonVariableGetInfo

Use the VI MIP CommonVariableGetInfo to get information about 
a specific variable. The VI returns the name (as plain text) of the specified 
variable plus its type and access mode.

Table 34  MIP_CommonVariableGetInfo Parameters

MIP_CommonVariableSet

To set the value of any accessible variable on your device use the VIMIP 
CommonVariableSet. The usage is very similar to reading variables from 
the device (see MIP_CommonVariableGet on page 193).

Table 35  MIP_CommonVariableSet Parameters

Input parameters: Device descriptor, tree number, variable number

Output parameters: Variable name, variable type, variable access

Input parameters: Device descriptor, tree number, variable number, (index 
number), variable type, (DataInt, DataFloat, DataArray)

Output parameters: Device descriptor, error code



Keysight N778xB User’s Guide 195

LabView™ Drivers (Discontinued) 7

 



196 Keysight N778xB User’s Guide

7 LabView™ Drivers (Discontinued)
 

Polarization Controller VIs

The following VIs can be used to control the polarization controller 
(applicable to N7784B, N7785B, N7786B and N7788B/BD) in your 
application, i.e. to set all important control parameters and to start and 
stop the different scrambling modes.

MIP_PolConSettings

This is the central VI to control the different modes of the polarization 
controller. All necessary parameters to start the polarization controller can 
be specified according to the following list:

Table 36  MIP_PolConSettings Parameters

Scrambling mode

• Off (turns off all scrambling modes)

• Random (scrambling with a pseudo random sequence)

• Sequence (scrambling with user-definable sequence)

Timebase

• Internal Timer (uses polarization controller timer)

• Polarimeter Clock (uses polarimeter timer for synchronization purpose, 
only valid on N7788B/BD and N7786B)

• External Trig-In (uses external trigger input #1)

Synchronization

• Auto Repeat (scrambling sequence is processed repeatedly)

• OneShot (scrambling sequence is processed just once. The polarization 
controller remains on the last table entry)

Sequence starttrigger

• Auto (scrambling sequence is untriggered and started by software)

Input parameters: Device descriptor, scrambling mode, timebase, 
synchronization, sequence starttrigger, repetition rate, 
divider, holdoff delay, sequence length

Output parameters: Device descriptor, error code 
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• External (scrambling sequence is (re-)started by external event. The 
input port is dependent on timebase settings, i.e. for internal timers 
trigger input #1 is used and for external timebase trigger input #2 on 
expansion port is used)

• Polarimeter (scrambling sequence is (re-)started with every polarimeter 
measurement start)

Repetition rate

• Scrambling rate in kHz (only applicable to internal timer as timebase)

Prescaler

• Additional prescaler m for timebase (default: m=0); the resulting 
scrambling rate is: repetition rate / (m+1), (i.e. m=0 means no 
prescaling, m=1 means half repetition rate, etc.)

Holdoff delay

• Time of sequence restart relative to the external trigger signal in μs; 
only applicable to external trigger events.

Sequence length

• Scrambler sequence length; applicable to pseudo random sequence. 
When using user-definable scrambling sequence, length is determined 
by sequence length in memory.

NOTE
This VI replaces MIP PolConStart.vi, which was used in previous 
revisions.
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This VI starts the polarization controller with the specified mode using the 
current settings from the device variables.

Table 37  MIP_PolConSetMode Parameters

Scrambling Mode

• Off (turns off all scrambling modes)

• Random (scrambling with a pseudo random sequence)

• Sequence (scrambling with user-definable sequence)

Input parameters: Device descriptor, scrambling mode

Output parameters: Error code
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MIP_PolConWaveplateGet

This VI is used to get the current rotation angles of all 5 virtual waveplates 
of the LiNbO3 polarization controller (see Polarization Controller Basics on 
page 119).

Table 38  MIP_PolConWaveplateGet Parameters

WaveplateRot

• Current positions of the waveplates returned as 1-dimensional array, 
consisting of 5 values representing the rotation angle of each waveplate 
in radians.

Input parameters: Device descriptor

Output parameters: Waveplate positions (1D), error code
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MIP_PolConWaveplateSet

This VI is used to manually set the rotation position of the 5 virtual 
waveplates of the LiNbO3 polarization controller.

Table 39  MIP_PolConWaveplateSet Parameters

WaveplateRot

• 1D array of 5 elements representing the waveplate rotation angles (in 
radians 0..2π) of the polarization controller to bet set. Larger values 
than 2π for the rotation angle can be accepted, though they represent 
the same rotation angle, due to the internal structure of endlessly 
rotatable waveplates.

Input parameters: Device descriptors, waveplate positions (1D)

Output parameters: Error code
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MIP_PolConSeqWaveplateSet

This VI is used to program a sequence of waveplate rotation settings into 
the polarization controller, which can then be used as sequence source in 
sequence mode (see MIP PolConStart).

Table 40  MIP_PolConSeqWaveplateSet Parameters

Input parameters: Device descriptor, waveplate positions sequence (2D)

Output parameters: Error code
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RotStep

• 2D table consisting of n rows (n= length of sequence steps), each 
representing one waveplate rotation setting (similar to 
1D-WaveplateRot in MIP PolConWaveplateSet).

MIP_PolConSeqWaveplateSetRetard

This VI is used to program a sequence of waveplate rotation settings into 
the polarization controller, which can then be used as sequence source in 
sequence mode (see MIP PolConStart).
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Table 41  MIP_PolConSeqWaveplateSetRetard Parameters

RotStep

• 2D table consisting of n rows (n= length of sequence steps), each 
representing one waveplate rotation setting (similar to 
1D-WaveplateRot in MIP PolConWaveplateSet).

Input parameters: Device descriptor, waveplate positions sequence (2D)

Output parameters: Error code
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Polarimeter Control VIs

The following VIs are used to control and readout the polarimeter 
(applicable to N7781B/BD, N7786B and N7788B/BD). For a complete 
polarimeter demo application see PolarimeterDemo on page 212.

MIP_PolarimeterMeasStart

This VI is used to start a new polarimeter measurement. The measurement 
parameters (e.g. sampling rate, number of samples, etc.) used for the data 
acquisition are stored in the variable tree structure and can be changed 
prior using the VI MIP CommonVariableSet.

Table 42  MIP_PolarimeterMeasStart Parameters

Measurement mode

• IDLE (currently running measurement is stopped)

• SOP (measurement results are returned as 4-element Stokes 
parameters)

• SOPCONTINUOUS (time-continuous measurement is started; please 
ensure that you pick up all results in appropriate time intervals to 
prevent data loss due to internal ring buffer structure)

Input parameters: Device descriptor, measurement mode

Output parameters: Device descriptor, Error code
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MIP_PolarimeterMeasState

This VI is used to get information about the current measurement state of 
the device.

Table 43  MIP_PolarimeterMeasState Parameters

nSamples

• Number of samples available

TriggerState

• IDLE (no measurement)

• ARMED (measurement initialized, waiting for trigger)

• SAMPLING (measurement in progress)

• DATA AVAILABLE (measurement completed)

• ERROR (error occurred)

MeasState

• Measurement error code (see Error Codes on page 336)

Input parameters: Device descriptor

Output parameters: Device descriptor, number of samples, trigger 
state, measure state
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MIP_PolarimeterMeasStartGet

This VI starts a measurement and waits for completion. Measurement 
parameters are stored in the variable tree structure prior to starting this VI. 
The results of the measurement are returned either in a floating-point or 
integer array, depending on the measurement mode. Currently only 
floating-point data will be returned when measuring SOPs.

Table 44  MIP_PolarimeterMeasStartGet Parameters

Measurement mode

• See MIP_PolarimeterMeasStart on page 205.

FloatTab/ShortTab

• Results of previous measurement according to selected measurement 
mode.

nSamples

• Number of samples available. Rows Number of valid rows (depends on 
measurement mode)

Input parameters: Device descriptor, measurement mode

Output parameters: Device descriptor, float results, short results, 
number of samples, rows, error code
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MIP_PolarimeterMeasGet

This VI is used to retrieve data available on the device.

Table 45  MIP_PolarimeterMeasGet Parameters

Measurement mode

• See MIP_PolarimeterMeasStart on page 205.

FractionStart

• Startindex in results for fraction data transfer (for no fraction transfer 
use default: -1).

FractionLength

• Length of fraction.

FloatTab/ShortTab

• Results of previous measurement according to selected measurement 
mode.

nSamples

• Number of samples available. Rows Number of valid rows (depends on 
measurement mode)

Input parameters: Device descriptor, measurement mode, 
fraction start, fraction length

Output parameters: Device descriptor, float results, short results, 
number of samples, rows, error code
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MIP_PolarimeterMeasPlot

This VI can be used as standalone VI to start a measurement and display 
the results in a graph. All important parameters can be set prior to the 
measurement using the defined control elements. Changes in the control 
elements are valid only after restarting the VI.

Table 46  MIP_PolarimeterMeasPlot Parameters

TriggerSource

• NONE (starts immediately; software trigger)

• TTL HIGH (low-to-high transition on external trigger-in starts 
measurement)

• TTL LOW (high-to-low transition on external trigger-in starts 
measurement)

SamplingRate

• Sampling rate in kHz

Input parameters (control elements): VISA descriptor, Baudrate, measurement 
mode, trigger source, sampling rate, number 
of samples, wavelength, sweeprate, gain

Output parameters (display on screen): Results plot, error code
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Wavelength

• Lightsource wavelength in nm

SweepRate

• Lightsource wavelength sweeprate in nm/s

Gain

• Amplifier gain (0-13)

NOTE
For fixed wavelength source set to 0 nm/s
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MIP_PolarimeterReset

This VI is used to reset the polarimeter to its initial state. All measurement 
parameters are set to their values after device power-up.

Table 47  MIP_PolarimeterReset

Input parameters: Device descriptor

Output parameters: Device descriptor, error code
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Demo VIs

DemoPolarimeterSimple

This VI demonstrates the basic usage of the interface VIs. It first opens a 
session to the instrument connected via GPIB, address 30. Then the 
desired number of samples is set to 1000 and the sampling rate is chosen 
to be 20 kHz.

Note that the VI MIP PolarimeterMeasStartGet.vi (see 
MIP_PolarimeterMeasStartGet on page 207) waits until a measurement 
has been successfully completed, i.e. it waits until the polarimeter receives 
a suitable power level.

PolarimeterDemo

This VI demonstrates a complete polarimeter measurement application. 
You must specify the desired VISA communication port (use 
GPIB0::30::INSTR for an instrument at GPIB address 30). The 
measurement parameters can be changed during runtime and include the 
following parameters:

Tab Polarimeter

• AutoGainFlag, TriggerSource, Samples, SamplingRate, Gain(manual)

Tab Source

• Wavelength(fixed or startwavelength if sweeped), Sweeprate (in nm/s, 
0 for fixed wavelength)
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The results of the measurement are displayed in different diagrams.

Tab Polarimeter

• SOP displayed on Poincaré sphere. Use cursor array in VI to rotate 
sphere.

Tab Stokes

• Stokes parameters displayed in graph

Tab DOP

• DOP displayed in graph Tab Power 

DemoVarInfo

This VI starts a VISA session with a device (here: at port COM1 with 
115200 kBaud) and receives its model code. Afterwards the VI reads the 
variable information from the specified tree and variable number and 
shows the results in the appropriate fields.
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This chapter describes all commands (ASCII-) with their syntax and 
parameter lists.

Introduction   /  216
Generic Control Commands   /  217
Buffer Control Commands   /  219
Polarization Controller Commands   /  222
Polarimeter Control Commands   /  225
Examples   /  228

NOTE
Please note that in the future, only the COM/ActiveX drivers will be 
supported since they offer a much easier way to access the instruments. 
See Direct Instrument Control on page 145 for more information.
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Introduction

This chapter summarizes all available (ASCII-) commands with their syntax 
and parameter lists. ASCII commands can be used for device 
communication over the GPIB interface. Every command starts with an 
asterisk (*) and returns an error code (see Error Codes on page 336) from 
the device. If a command or result has more than one parameter handed 
over, each parameter is separated by a comma (,). Note that floating point 
values use a “.” as decimal point. You can send these commands, e.g. by 
using the National Instruments Measurement & Automation Explorer, 
where you can select an instrument connected to a GPIB interface and 
send ASCII commands as well as read the instrument responses.

NOTE
When using the USB port for device communication the ASCII 
commands are not applicable. In this case please use the LabView™ VIs 
provided in the driver libraries instead (see LabView™ Drivers 
(Discontinued) on page 187).
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Generic Control Commands

These commands are used to get device specific information and access 
device variables.

Table 48  Explanation - Control Commands

*IDN?

Get device identification

Table 49  *IDN?

*VAR?

Get device variable value

Table 50  *VAR?

TreeName Name of variable tree (Instrument Variables 
(Discontinued) on page 233) as plain text

TreeNo Number of variable tree (Instrument Variables 
(Discontinued) on page 233) as integer

VarName Name of variable (Instrument Variables (Discontinued) on 
page 233) as plain text

VarNo Number of variable (Instrument Variables (Discontinued) 
on page 233) as integer

Index Variable index in arraytype [0..max]

Syntax: *IDN?

Results *{ErrorCode},{IDString}
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*VARNAME?

Get device variable description

Table 51  *VARNAME?

*VAR

Set device variable value

Table 52  *VAR

Syntax: *VAR? {TreeName},{VarName}
*VAR? {TreeNo},{VarNo} 
*VAR? {TreeName},{VarName},{Index} 
*VAR? {TreeNo},{VarNo},{Index}

Results *{ErrorCode},{Value}

Syntax: *VARNAME? {TreeName},{VarName}

*VARNAME? {TreeNo},{VarNo} 

Results *{ErrorCode},{VarType},{VarAccess},{VarTextName}

Syntax: *VAR {TreeName},{VarName},{Value}

*VAR {TreeName},{VarName},{Index},{Value} 

Results *{ErrorCode}
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Buffer Control Commands

*BUF?

Returns the current buffer size in bytes.

Table 53  *BUF?

Parameters: 

*BUFR?

Returns the contents of the buffer as binary, hex or numeral values. The 
startindex and length of returned data can be specified by the fraction 
parameters.

Syntax: *BUF?

Results *{ErrorCode},{buffersize}

buffersize(int) Buffer size in bytes

NOTE
When using GPIB as communication interface, the maximum transfer 
size per command is limited to approximately 800 bytes (i.e. 400 hex 
values). For transferring buffers of larger size, you have to split the read 
out in successive buffer read commands of appropriate transfer size.

NOTE
The startindex and length depends on the requested data type. For hex 
and binary dumps the indices refer to byte positions. For numeral 
outputs the indices refer to number positions.

NOTE
Floating point numbers are returned in single precision format (IEEE 754)
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Table 54  *BUFR?

Parameters: 

*BUFALLOC

Reserves space in memory for writing into buffer.

Table 55  *BUFALLOC

Parameters: 

Syntax: *BUFR?

*BUFR? {HEX|NUM},{ALL} 

*BUFR? {HEX|NUM},{fractionstart},{fractionlength}

Results *{ErrorCode},{results}

fractionstart(int) startindex of requested data block

fractionlength(int) Length of requested data block

results (in specified format) HEX: hex dump
NUM: int/float numbers

NOTE
Hex dumps are returned in little endian format

Syntax: *BUFALLOC {length}

Results *{ErrorCode}

length (int) specifies the size of allocated memory and is 
interpreted as number of (float/int) elements in 
buffer
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*BUFW

Writes into allocated buffer memory

Table 56  *BUFW

Parameters: 

Syntax: *BUFW {offset},{value0[,value1,value2,...]}

Results  *{ErrorCode}

offset (int) Specifies the starting index for writing into the 
buffer. Larger values than actual buffer length 
returns an error

value0..n (float) Are the values interpreted as floating point 
numbers, written in the buffer starting at 
specified offset address. Writing more value 
than buffer length returns an error.
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Polarization Controller Commands

*POLCON:START

Starts the polarization controller

Table 57  *POLCON:START

Parameters: 

*POLCON:STOP

Stops the polarization controller

Table 58  *POLCON:STOP

*POLCON:WP?

Get current positions of polarization controller waveplate elements. 
Returned are the rotation angles for the controller elements in rad.

Table 59  *POLCON:WP?

Syntax: *POLCON:START {SCR|SEQ}

Results *{ErrorCode}

SCR Starts pseudo-random scrambling

SEQ Starts scrambling with defined sequence

Syntax: *POLCON:STOP

Results *{ErrorCode}
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Parameters: 

*POLCON:WP

Set current positions of polarization controller waveplate elements.

Table 60  *POLCON:WP

Parameters: 

*POLCON:SEQSET

Sets a new programmable scrambling sequence based on the values 
written previously into the buffer memory. To set up the values for a new 
sequence, write the rotation angle values for each waveplate into the 
buffer memory using the commands BUFALLOC and BUFW. The number 
of sequence elements must be a multiple of the number of control 
elements (nPolConRot) of the polarization controller otherwise an error is 
returned.

Syntax: *POLCON:WP?

Results *{ErrorCode},{angle0},{angle1},{angle2},{angle3},
{angle4}

angle(float) Rotation angle in rad

Syntax: *POLCON:WP {angle0},{angle1},{angle2},{angle3},
{angle4}

Results *{ErrorCode}

angle(float) Rotation angle in rad
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Table 61  *POLCON:SEQSET

Syntax: *POLCON:SEQSET

Results *{ErrorCode}
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Polarimeter Control Commands

*POLMET:RESET

Resets the polarimeter and sets all measurement parameters to their 
default values.

Table 62  *POLMET:RESET

*POLMET:START

Starts a new polarimeter acquisition using the current measurement 
parameters. The measurement type is determined by the indicated mode 
parameter.

Table 63  *POLMET:START

*POLMET:STATE?

Returns the current polarimeter acquisition status, including number of 
samples taken, trigger state and polarimeter error code.

Table 64  *POLMET:STATE?

Syntax: *POLMET:RESET

Results *{ErrorCode}

Syntax: *POLMET:START SOP

Results *{ErrorCode}

Syntax: *POLMET:STATE?

Results *{ErrorCode},{data sampled},{trigger state}, 
{polarimeter errorcode}
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Parameters: 

*POLMET:SOP?

Returns the current SOP from the polarimeter as single Stokes vector.

Table 65  *POLMET:SOP?

Parameters: 

*POLMET:NSOP?

Returns the current SOP from the polarimeter as DOP and single 
normalized Stokes vector.

Table 66  *POLMET:NSOP?

data sampled(int) Number of samples taken so far

trigger state(int) Current polarimeter trigger status (see 
variable TriggerState (seeTree 3: 
Polarimeter on page 236)

polarimeter errorcode(int) Current polarimeter error status (see Error 
Codes on page 336 for explanation)

Syntax: *POLMET:SOP?

Results *{ErrorCode},{s0},{s1},{s2},{s3}

s0..3(float) Stokes parameters

Syntax: *POLMET:NSOP?

Results *{ErrorCode},{DOP},{s0},{s1},{s2}
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Parameters: 

*POLMET:GET?

Reads out the data from the current data acquisition and saves the results 
in the buffer. Note that successive calls of this command without 
restarting the measurement will return a measurement sequence error. 
For the results see Buffer Control Commands on page 219.

Table 67  *POLMET:GET?

Parameters: 

DOP(float) Degree of polarization

s0..3(float) Normalized Stokes parameters

Syntax: *POLMET:GET?

Results *{ErrorCode},{buffersize}

buffersize(int) Buffer size after read-out in bytes
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Examples

Polarimeter Measurements

Table 68  Polarimeter Measurements

*POLMET:RESET Reset the Polarimeter to default 
values

Result: *0

*POLMET:SOP? Get a Stokes vector from 
polarimeter

Result: *0,0.0657170,0.0121462,-0.0557056,0.0317337

*POLMET:NSOP? Get a normalized Stokes vector 
from polarimeter

Result: *0,0.993527,0.184831,-0.847659,0.484158

*VAR Polarimeter,SamplingRate,40 Set sampling rate to 40kHz Result: *0

*VAR Polarimeter,Samples,1000 Set number of samples to 1000 Result: *0

*VAR Polarimeter,WavelengthStart,1540.0 Wavelength=1540nm Result: *0

*VAR Polarimeter,SweepRate,0 Fixed wavelength mode Result: *0

*VAR Polarimeter,TriggerSource,0 Disable external trigger source Result: *0

*VAR Polarimeter,AutoGainFlag,1 Enable polarimeter autogaining Result: *0

*POLMET:START SOP Start SOP measurement Result: *0

*POLMET:START SOP Get measurement state Result: *0,1000,3,0

*POLMET:GET? Readout measurement results Result: *60A

60A indicates a power under range for the first measurement. Note that when using autogaining, a new gain is automatically chosen for the next 
measurement after an over-/underrange condition. Thus simply restarting the measurement will retry the measurement with another gain setting.

*POLMET:START SOP Restarting SOP measurement Result: *0

*POLMET:START SOP Get measurement state Result: *0,1000,3,0

*POLMET:GET? Readout next measurement 
results

Result: *0,16000
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*BUFR? NUM,0,32 Readout measurement from 
buffer 
first 32 float values, 
corresponding to 8 Stokes 
vectors

Result: *0
0.062 0.021 -0.050 0.027
0.062 0.021 -0.050 0.027
0.063 0.021 -0.051 0.027
0.062 0.021 -0.050 0.027
0.062 0.021 -0.050 0.027
0.062 0.021 -0.050 0.027
0.062 0.021 -0.050 0.027
0.062 0.021 -0.050 0.027

*BUFR? HEX,0,400 Read buffer
Example for buffer readout with 
limited packet size Buffer size: 
2048 bytes

Result:
*0
D38AA43DFC0CF0BA98BEBABD146D683D
549E803DC0AC053D0DCE3FBD7069C33C
...

*BUFR? HEX,800,400 Read remaining data

*BUFR? HEX,1200,400

*BUFR? HEX,1600,400

*BUFR? HEX,2000,48
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Setting Up the Polarization Controller

This example shows how to set up the polarization controller to scramble 
with a pseudo random scrambling sequence of (sequence length: 1000 
elements).

Table 69  Polarization Controller - Example 1

This example shows how to manually set the polarization controller 
position.

Table 70  Polarization Controller - Example 2

*VAR PolController,RepRate,10.0 Scrambling rate = 10kHz Result: *0

*VAR PolController,Synchronization,0 Use autorepeat mode Result: *0

*VAR PolController,TimeBase,0 Use internal timer as timebase Result: *0

*VAR PolController,PolConStartTrigger,0 Use software trigger Result: *0

*VAR PolController,SeqLength,1000 Sequence length: 1000 Result: *0

*POLCON:START SCR Use pseudo random scrambling 
mode

Result: *0

*POLCON:STOP Stop polarization controller (all 
modes)

Result: *0

*POLCON:WP 0.1,0.4,-0.2,0.8,1.2 Set manually to a position Result: *0

*POLCON:WP? Get current polarization controller 
position

Result: *0,0.1,0.4,-0.2,0.8,1.2
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This example shows how to program a sequence of 2 entries (sequence 
length = 2 elements).

Table 71  Polarization Controller - Example 3

*VAR? PolController,nPolConRot Get number of waveplates Result: *0,5

*BUFALLOC 10 Allocate buffer 
2 sequence elements multiplied 
with 5 waveplates yields 10 
floating point entries.

Result: *0

*BUFW 0,0.11,-0.22,0.33,-0.44,0.55 Write first sequence step Result: *0

*BUFW 5,-0.66,0.77,-0.88,0.99,-1.00 Write 2nd step Result: *0

*POLCON:SEQSET Generate sequence from buffer 
contents

Result: *0

*POLCON:START SEQ Use sequence mode Result: *0
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This chapter describes a list of variables supported by the instruments.

Introduction   /  234
Tree 0: Common   /  235
Tree 3: Polarimeter   /  236
Tree 4: PolController   /  238

NOTE
Please note that in the future, only the COM/ActiveX drivers will be 
supported since they offer a much easier way to access the instruments. 
See Direct Instrument Control on page 145 for more information.
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Introduction

In the following a list of variables is given which are supported by the 
instruments.

Each variable has a unique variable number and variable name which are 
used to address the corresponding variable. Additionally each variable has 
a type and access code.

Table 72  Variable Types

Table 73  Variable Access Codes

Type Description

INT integer number

FLOAT floating point number

ARRAYINT 1D-array of integer numbers

ARRAYFLOAT 1D-array of floating point numbers

TEXT text string

R read only access

W write only access

R/W read/write access
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Tree 0: Common

The variable tree Common is available on all instruments.

Table 74  Tree 0: Common

No Name Type Acc. Def. Description

0 GPIBAddress INT R/W 30 GPIB address (1..30), only valid after restart

9 ModelCode TEXT R/W instrument model code

10 SerialCode1 TEXT R instrument serial number

11 SerialCode2 TEXT R add. instrument serial number

12 SerialCode3 TEXT R add. instrument serial number

13 SerialCode4 TEXT R add. instrument serial number

17 SelfTestResult INT R 0 Result of selftest. 0=Selftest successful. Other 
values indicate a hardware damage.
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Tree 3: Polarimeter

The variable tree Polarimeter is available on N778xB/BD instruments 
with polarimetry capabilities.

Table 75  Tree 3: Polarimeter

No Name Type Acc. Def. Description

1 WavelengthStart FLOAT R/W 1550.0 Wavelength in nm. In sweep mode: start 
wavelength in nm

2 SweepRate FLOAT R/W 0.00 Sweep rate in nm/s. 0: Fixed wavelength 
mode.

3 TriggerSource INT R/W 0 Trigger source
0: none
1: software
2: TTL high
3: TTL low

7 SamplingRate FLOAT R/W 5.0 Sampling rate in kHz

14 AutoGainFlag INT R/W 1 Auto gain
0: disable
1: enable

15 SweepState INT R 0 Sweep status
0: idle
1: SOP acq. running
2: SOP continuous acq. running

16 Samples INT R/W 256 Desired number of samples for data 
acquisition.

17 Gain INT R/W 0 Current polarimeter gain. Valid gain settings: 
0..13. Write into this variable to manually 
select the gain setting.

28 LastPeakRange FLOAT R Last occurred peak range. A value between 
0..1 indicates the maximum power level 
occurred in the last measurement. A value of 1 
corresponds to the maximum detectable 
power level in the used gain setting. Note that 
values below 0.3 can reduce SOP accuracy.
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29 LastPeakPower FLOAT R Last occurred peak power in mW. This value is 
the power level corresponding to the peak 
value of variable LastPeakRange.

30 TriggerState INT R Trigger state:
0: idle
1: armed
2: sampling
3: data available
4: error

31 Progress INT R/W This variable will be increased whenever a new 
measurement has been taken.

No Name Type Acc. Def. Description
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Tree 4: PolController

The variable tree PolController is available on all N778xB/BD 
instruments that contain a LiNbO3-polarization controller.

Table 76  Tree 4: PolController

No Name Type Acc. Def. Description

4 nPolConRot INT R 5 Number of waveplates of the polarization 
controller

5 RepRate FLOAT R/W 5.0 Repetition rate in kHz

6 ScramblingMode INT R/W 0 PolController mode
0: off
1: random scrambling
2: sequence scrambling

7 Synchronization INT R/W 0 Synchronization:
0: autorepeat
1: oneshot 
autorepeat will restart the sequence 
when finished. oneshot will stop the 
sequence at the end.

8 TimeBase INT R/W 0 Timebase
0: timer
1: polarimeter clock
2: external (BNC Trig-In)
polarimeter clock is only valid for 
N7788B/BD and N7786B

9 SequenceStartTrigge
r

INT R/W 0 0: auto
1: external
2: polarimeter
auto will start the sequence immediately. 
external will start the sequence on an 
external event. polarimeter will start the 
sequence with every polarimeter 
measurement start (valid for AN7788B/BD and 
N7786B).
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11 Prescaler INT R/W 0 prescaler for repetition rate
0: no prescaling
1: div by 2
etc.

12 HoldOffDelay INT R/W 100 Hold off delay in μs after receiving a trigger.

13 SeqLength INT R/W 12 Length of sequence.

No Name Type Acc. Def. Description
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This chapter describes the polarization navigator automation.
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Using VBA   /  273
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Introduction

The polarizationNAVIGATOR™ can be remotely controlled by sending 
human-readable commands and receiving a response from the software.

There are virtual devices you can communicate with, so-called Targets.

As an example, you can send the following command to the target Global:
Get Version

The response will look like:
Version 2.53 (1315), Built on Feb 22 2006 16:14:01

Use PolNavClientTest.exe to test the automation interface. 

You can use the test program PolNavClientTest.exe (you can find 
it in the Start menu) to communicate with the polarizationNAVIGATOR™.

If the polarizationNAVIGATOR™ is not started, it will be automatically 
launched and minimized to the system tray.
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Sending Commands

Using PolNavClientTest.exe to Send Commands

Use PolNavClientTest.exe to test the automation interface

You can use the test program PolNavClientTest.exe to communicate with 
the polarizationNAVIGATOR™. You can find a shortcut to 
PolNavClientTest.exe in the Examples folder of the 
polarizationNAVIGATOR™ entry in the Windows Start menu.

Command Line Tool

You can use the command line tool PolNavSendCommand.exe for 
sending commands to the polarizationNAVIGATOR™. During the 
installation process, this file is placed into the system directory, so you 
don't have to set a path to access it.

For example, start the polarizationNAVIGATOR™ and type the following 
command at the command line:
polnavsendcommand Global "Get Version"

The response will look like:
Version 2.53 (1315), Built on Feb 22 2006 16:14:01

You can print the result code on the command line using the standard 
variable ERRORLEVEL:
echo %ERRORLEVEL%

The communication is implemented using a DLL which can be called from 
any software which supports DLL calls such as LabView, MATLAB, Visual 
C++ or Visual Basic.

In the subfolder 
Examples\PolNavSendCommand_VisualC++7.0 
SourceCode 
of the polarizationNAVIGATOR™ installation directory you can find the 
source code to the command line tool and see how the DLL-calls can be 
implemented.

COM/ActiveX Interface

We recommend to use the COM/ActiveX class AgServerN778xLib as 
shown in Direct Instrument Control on page 145. You can use the interface 
IAgN778xPolarizationNavigator to send an automation command. Please 
take a look at the following examples:
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MATLAB: N778xCOMDemo_PolNav.m

LabView: N778xPolNav.vi

DLL Interface

The communication with the polarizationNAVIGATOR™ is also 
implemented using a DLL interface.

The name of the DLL is PolNavClient.dll. It is installed in the 
WINDOWS\SYSTEM32 directory during the setup process.

There are four exported functions. The C function prototypes are as 
follows:

• PolNav_SendCommand: Sending commands to the 
polarizationNAVIGATOR™ and get a response.

• PolNav_ReadResponse: For long responses, this function reads the 
response in little pieces.

• PolNav_Disconnect: In case of a TCP/IP connection, disconnect the 
client from the server.

• PolNav_HelloWorld: Tests the communication to the 
polarizationNAVIGATOR™

You can find a header file with the function prototypes in a subfolder of the 
polarizationNAVIGATOR™ installation directory: \Examples\Visual C++7.0 
SourceCode SendCommand\PolNavClientDll.h

NOTE
The PolarizationNavigator DLL interface only supports 32bit automation 
environments. 

Use the AgN778xPolarizationNavigator class within the 
AgServerN778xLib COM/Active-X server to access PolarizationNavigator 
functionality from 64bit automation environments.
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Command: PolNav_SendCommand

This function sends a command to the polarizationNAVIGATOR™ and 
retrieves the response1.

Function prototype:

int __stdcall PolNav_SendCommand(const char *Target,
const char *Command,char *Response,int MaxLen,

int &ResponseLen);

Table 77  Variables

1 Depending upon the amount of data and the automation environment that you are working with 
you may need the “Command: PolNav_ReadResponse (see next section) to retrieve 
the full response

Parameter Description

Target Target Name (see Polarization 
Navigator Automation: Target 
Names on page 249)

Command The command string to be sent to the 
Navigator.

Response Pointer to a buffer reserved for the response. 
The calling application has to allocate enough 
memory to receive the response. The response 
is a 0-terminated string.

MaxLen The size of the allocated response buffer.

ResponseLen Here, the total length of the response is 
returned. If the response does not fit into the 
allocated buffer, only the first part is copied 
into the response buffer. Use 
PolNav_ReadResponse to access 
smaller fractions of the response.

Return Value The return value is an Error Codes (Error 
Codes on page 336). A zero (0) indicates 
successful operation.
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Command: PolNav_ReadResponse

This function retrieves portions of a response that has been acquired using 
PolNav_SendCommand.

Using this function you can access fractions of the last received response. 
Particularly in VBA, strings cannot be longer than 32767 characters. Thus 
you will have to access longer response strings using this function.

Function prototype:

int __stdcall PolNav_ReadResponse(int iStart,int iLength,

char *Response,int MaxLen,int &ResponseLen);

Table 78  Variables

Parameter Description

iStart Start index of the fraction.

iLength Number of characters to be read from the total 
response.A value of zero (0) reads the total 
response. A value of -1 reads from the 
beginning indicated by iStart to the next CR or 
LF. This is particularly useful to parse plot data 
returned by the GetPlot Default 
command.

Response Pointer to a buffer reserved for the response. 
The calling application has to allocate enough 
memory to receive the response. The response 
is a 0-terminated string.

MaxLen The size of the allocated response buffer.

ResponseLen Here, the total length of the fraction is 
returned.

Return Value The return value is an Error Codes (Error 
Codes on page 336). A zero (0) indicates 
successful operation.



Keysight N778xB User’s Guide 247

Polarization Navigator Automation 10

 

Command: PolNav_Disconnect

This disconnects a TCP/IP client from the server.

If you communicate with the polarizationNAVIGATOR™ via TCP/IP (see 
next chapter), you should terminate the connection after leaving your 
program.

Function prototype:
int __stdcall PolNav_Disconnect();

char *Response,int MaxLen,int &ResponseLen);

Table 79  Variables

Command: PolNav_HelloWorld

This function is for debugging purposes only.

If you call this function, the polarizationNAVIGATOR™ will be started and a 
value of 123 will be returned.

Function prototype:
int __stdcall PolNav_HelloWorld();

Table 80  Variables

See also Using MATLAB on page 268, Using LabView on page 270, Using 
Python on page 272, Using VBA on page 273, Using Keysight VEE on 
page 274 to learn more about the usage of these functions.

Parameter Description

Return Value The return value is an Error Codes (Error 
Codes on page 336). A zero (0) indicates 
successful operation.

Table 81  Parameter Table 82  Description

Return Value The return value is always 123.
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Remote Control via TCP/IP

You can communicate to a polarizationNAVIGATOR™ running on a 
different machine just by changing the target name. You simply have to 
add the IP-Address of the computer you want to control followed by a ':' to 
the target name. The target name Global will thus be changed to:

192.168.2.15:Global

NOTE
You have to enable the option Remote Server in the Options dialog to 
make the polarizationNAVIGATOR™ listen to incoming commands.
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Command Reference

Polarization Navigator Automation: Target Names

The communication with the polarizationNAVIGATOR™ uses so-called 
targets which act as virtual instruments. When communicating with the 
polarizationNAVIGATOR™ you have to specify the target name of the 
instrument or application you want to control.

You can query the target name of the instrument/application you want to 
control by right-clicking in the browser window and choosing Device 
Server Properties. The target names are generated automatically. For the 
component test application the target name can be for example 
CompTest00000. If you specify CompTest* as target name, the first 
component test application in the tree will be used as communication 
partner.

The communication with the polarizationNAVIGATOR™ is implemented 
using a DLL Interface (see DLL Interface on page 244). A command string 
is sent to the Navigator which returns a response string. The following 
targets are supported:

See Commands Applying to All Targets on page 250 for common 
commands applying to all targets.

Target Name Application/Instrument

Global (see Target Global on page 250) Global Variables

CompTest* (see Target CompTest on page 257) Component Test (PDL/PMD)

CompTestStepped* (see Target 
CompTestStepped on page 260) 

Component Test(Stepped)

PERTest* (see Target PERTest on page 263) PER Test

Polarimeter* (see Target Polarimeter on page 251) Polarimeter

PolCon* (see Target PolController on page 254) PolController
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Commands Applying to All Targets

The following commands apply to all targets:

Target Global

The target name Global will select global variables such as the version 
number of the polarizationNAVIGATOR™.

Command Description

Activate Activates the Instrument/Application.

DeActivate Deactivates the Instrument/Application.

Get VarName Retrieves the content of a variable. See table 
below for available variables.

Set VarName,Value Sets the value of a variable. See table below 
for available variables.

Dir TargetName Returns the available target names. Dir 
without any parameter will return all available 
target names. Dir PolCon* will return all 
target names beginning with PolCon.

Echo XYZ Sends the characters XYZ as response. This is 
can be used to test the communication.

TestData n Returns sample plot data for debugging 
purposes. The response is a string which is 
formatted like a spreadsheet consisting of 
rows and columns. Columns are separated by 
a comma (,). Rows are separated by a LF (ASCII 
code 10). The number of rows is defined by the 
parameter n.
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Target Polarimeter

The target name Polarimeter* will select the first polarization 
analyzer from the browser tree.

Commands

The following commands are available:

VarName R/W Type Description

Version R string Retrieves the version string of the 
polarizationNAVIGATOR™.

SnpTitle R/W string The title field which is included in 
the saved PBIN files.

SnpComment R/W string The comment which is included in 
the saved PBIN files.

SnpOperator R/W string The name of the operator which is 
included in the saved PBIN files.

PolNavReady R bool 1=polarizationNAVIGATOR™ is 
launched and ready to accept 
commands

Command Description

Continuous Activates the Continuous Oscilloscope mode. 
In this mode, the polarimeter will be 
retriggered after finishing a measurement.

Oneshot Activates the Oneshot Oscilloscope mode. In 
this mode, the polarimeter will be triggered 
only once.

Trigger In Oneshot Oscilloscope mode, this 
(re-)activates the measurement cycle and the 
polarimeter is ready to take a measurement. If 
no trigger source is configured, sampling will 
start immediately.
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Variables

Trace Activates the Trace mode. In this mode, the 
polarimeter samples with a sampling rate of 
2.5 kHz. If the parameter 
TraceSensitivity is set to 0, every 
incoming data point will be used. If 
TraceSensitivity is set to a value 
greater than zero, only data points are stored if 
the SOP has been changed by more than the 
value indicated by TraceSensitivity. If 
TraceSensitivity is set to 0.02, for 
example, a new data point is taken only if the 
SOP has changed by at least 0.02 rad.

Stop Stops a measurement.

StartLogging Enables data logging. In the Trace mode, an 
ASC-II file is opened and all incoming SOP 
data is streamed into this file. The columns 
are: S0, S1, S2, S3, DOP.

StopLogging Disables data logging.

GetPlot Default Returns the plot data of the last measurement. 
The response is a string which is formatted like 
a spreadsheet consisting of rows and columns. 
Columns are separated by a comma (,). Rows 
are separated by a LF (ASCII code 10). See 
SOP Data (Default) on page 338 for 
details on the meaning of each column.

VarName R/W Type Description

Mode R string Returns the current acquisition 
mode: Stop, Continuous, Oneshot, 
Trace.

SamplingRate R/W double The sampling rate in kHz

Wavelength R/W double The (start-) wavelength in nm.

SweepRate R/W double The sweep rate in nm/s.

Command Description
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TriggerSource R/W string Defines the trigger source.
TTLLow : Trigger on high-to-low 
edge on the digital input.
TTLHigh : Trigger on 
low-to-high edge on the digital 
input.
TTLLow(Pre) : Trigger on 
high-to-low edge on the digital 
input. Supports pre-trigger 
buffering.
TTLHigh(Pre) : Trigger on 
low-to-high edge on the digital 
input. Supports pre-trigger 
buffering.
SOPChange : Trigger on an SOP 
event. The sensitivity can be 
defined by TrigSenseAngle 
and TrigSenseTime.

PreTrigSamples R/W int Number of pre-trigger samples.

PostTrigSamples R/W int Number of post-trigger samples.

AutoGain R/W bool Auto gaining on (1) or off (0).

Gain R/W int Current gain setting. 0: lowest 
sensitivity. 13: highest sensitivity.

LoggingInterval R/W double Defines the minimum time (in 
seconds) between two logging 
events. A value of 0 will disable 
the timer.

LoggingMax R/W int Maximum number of logging 
events (0=infinite)

LoggingFilenameBody R/W string Defines a string to be used for 
R/W string automatic filename 
generation. The filename will be 
generated by adding a number to 
this string. The data will be stored 
in My Polarization-Navigator 
Files.

IsLogging R bool Returns the current logging state. 
0:Inactive, 1:Active.

VarName R/W Type Description
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Target PolController

The target name PolCon* will select the first polarization controller 
instrument from the browser tree.

Commands

The following commands are available:

TraceSensitivity R/W double  Defines the trace accuracy (in 
rad) if the polarimeter is in the 
Trace mode. A value of 0 will store 
every data point. Values greater 
than 0 will only store data if the 
SOP has moved by more than 
TraceSensitivity.

TrigSenseAngle R/W double Configures the SOPChange 
trigger mode. An event is 
generated if the SOP has moved 
by more than 
TrigSenseAngle (in deg) 
within the time indicated by 
TrigSenseTime.

TrigSenseTime R/W double Defines the time interval 
observed in SOPChange trigger 
mode. A value of 0 indicates that 
TrigSenseAngle is relative 
to the last event, i.e. an event is 
created if the SOP has moved by 
more than TrigSenseAngle 
compared to the last event 
(regardless of the time).

Laser R/W bool Internal laser source on/off (1/0).

VarName R/W Type Description

Command Description

Manual Activates Manual Mode of the Instrument

Scramble Activates Scrambling Mode of the Instrument

Sequence Activates Sequence Mode of the Instrument
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Variables

Randomize Loads a new random sequence in scrambling 
mode

Stabilize Activates Stabilization Mode of the Instrument

LoadSOPTable Filename Loads an ASCII file containing target SOPs.

VarName R/W Type Description

WPL R/W double [5] Waveplate positions in rad (5 
comma-separated values).

Timebase R/W int Timebase used for polcontroller. 
Valid values: 0,1,2; for details see 
PolController Tree (see Tree 4: 
PolController on page 238)

RepetitionRate R/W double Repetition rate in kHz used for 
polcontroller

Prescaler R/W int Prescaler value used for 
polcontroller

HoldOff R/W int HoldOff value in ms used for 
polcontroller

Synchronization R/W int Synchronization value in ms used 
for polcontroller Valid values: 
0..5; 0=”Auto Repeat”, 1="Auto 
Oneshot", 2="External Repeat", 
3="External Oneshot", 
4="Polarimeter Repeat", 
5="Polarimeter Oneshot".

SeqLength R/W int Length for random sequences. 
Only valid when in scrambling 
mode 

Sequence W string Filename (optional with path) for 
sequence data to load (only valid 
when in sequence mode).

DigitalOutput W int Sets the Trigger-Out BNC port to 
logical 0 or 1.

Command Description
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Example (pseudo code) for activating the stabilizer function (only N7786B):
PolNav_SendCommand("PolCon*","Activate")

PolNav_SendCommand("PolCon*","Stabilize")

PolNav_SendCommand("PolCon*","Set TargetSOP,1,0,0")

PolNav_SendCommand("PolCon*","Set Stabilize,1")

PolNav_SendCommand("PolCon*","Get CurrentSOPN")

Example (pseudo code) for setting the current waveplate positions:
PolNav_SendCommand("PolCon*","Set WPL,0.1,0.2,0.3,0.4,0.5")

Wavelength R/W double Operation wavelength of the 
polarization controller.

Stabilize R/W int Activates (1) or deactivates (0) the 
control loop (only in stabilize 
mode).

TargetSOP W double [3] Sets the desired target SOP. The 
command accepts 3 
comma-separated values 
corresponding to the 3 
normalized Stokes parameters.

CurrentSOP R double [4] Reads the current SOP. The result 
is given by 4 comma-separated 
values representing the current 
SOP (not normalized).

CurrentSOPN R double [3] Reads the current SOP. The result 
is given by 3 comma-separated 
values representing the current 
SOP (normalized).

CurrentDOP R double Reads the current DOP.

TargetDist R double Returns the distance of the 
current SOP to the target SOP.

TargetAccuracy R/W double Use an value greater than zero to 
turn the controller off after the 
target SOP has been reached. The 
value defines the maximum 
distance to the target SOP.

SOPTableIndex R/W int Current SOP table index.

SOPTableSize R int Current SOP table size.

VarName R/W Type Description
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Target CompTest

The target name CompTest* will select the component test application.

A simple pseudo program controlling the component test application 
could be as follows:
DECLARE STRING PROGRESS,PLOTDATA

PolNav_SendCommand("CompTest*","Activate")

PolNav_SendCommand("CompTest*","Set WavelengthStart,1540")

PolNav_SendCommand("CompTest*","Set WavelengthStop,1550")

PolNav_SendCommand("CompTest*","SingleMeasurement")

DO

PROGRESS=PolNav_SendCommand("CompTest*","Get Progress")

WAIT

WHILE PROGRESS<>"2"

PLOTDATA=PolNav_SendCommand("CompTest*","GetPlot Default")

Commands

The following commands are available:

Command Description

GetPlot Default Returns the plot data of the last measurement. 
The response is a string which is formatted like 
a spreadsheet consisting of rows and columns. 
Columns are separated by a comma (,). Rows 
are separated by a LF (ASCII code 10). See 
PDL/PMD Data (Default) on page 338 
for details on the meaning of each column.

SingleMeasurement Starts a single measurement. This is similar to 
pressing the button Single Measurement in 
the application.

RepeatMeasurement Starts a repeated measurement. This is similar 
to pressing the button Repeat Measurement in 
the application.

StopMeasurement Stops a measurement. This is similar to 
pressing the button Stop Measurement in the 
application.

TakeReference Starts a reference measurement. This is similar 
to pressing the button Take Reference in the 
application.

StartLogging Enables data logging.
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Variables

StopLogging Disables data logging.

Save Filename Saves the current measurement into a 
PBIN-File

Export Filename Saves the current measurement into an 
ASCII-File

SaveReference Filename Saves the current reference
measurement into a PBIN-File

LoadReference Filename Loads the file into the reference list. The file is 
appended at the end of the list and selected as 
active reference.

ClearReference Removes the current reference measurement.

ClearReferenceAll Removes all reference measurements from the 
list.

VarName R/W Type Description

Progress R int This variable is set to 0 when a 
measurement is started. It is 
increased once when the 
measurement is in progress. 
And it is increased once when 
the data has been evaluated. 
Thus you can wait until this 
variable becomes 2 before 
retrieving the data using the 
GetPlot Default 
command. In repeat mode the 
variable is not reset to 0. Thus 
the next measurement will be 
available if the variable 
becomes 4.

WavelengthStart R/W double Start wavelength in nm.

WavelengthStop R/W double Stop wavelength in nm.

AutoResolution R/W int Turns the automatic resolution 
on/off (1/0).

Resolution R/W double Resolution in nm.

Command Description
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PowerResolution R/W double Resolution of Power trace in 
nm. 0 = Default.

SweepRate R/W double Sweep rate nm/s. Allowed 
values are 0.5, 5.0, 10.0, 20.0, 
40.0, 80.0

TLSPower R/W double TLS power in mW.

UseLambdaLog R/W bool Lambda logging on/off (1/0).

AutoGain R/W bool Auto gaining on/off (1/0).

UseReference R/W bool Use reference measurement 
on/off (1/0).

UseReferenceNo R/W int Selects/queries the number of 
the current reference 
measurement.

CurrentGain R/W int Current gain setting. Allowed 
values are 0..13

DynamicRange R/W string Configures the dynamic range 
for the measurement. Allowed 
values are low, med, high.

Properties R string Dumps the properties which 
are attached to the last 
measurement.

LastEvalError R/W int Result of last evaluation. See 
Error Codes (Error Codes 
on page 336) for possible 
values.

Busy R bool Application busy (1) or not (0).

Active R bool Application activated (1) or not 
(0).

PlotNum R int Number of available plots.

UseLivePower R/W bool Enable (1) or disable (0) 
measurement of Live power 
level (which is shown on the 
Poincaré-Tab).

LivePower R double Live power level (which is 
shown on the Poincaré-Tab).

LiveDOP R double Live DOP

VarName R/W Type Description
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Target CompTestStepped

The target name CompTestStepped* will select the component test 
application.

A simple pseudo program controlling the component test application 
could be as follows:
DECLARE STRING PROGRESS,PLOTDATA
PolNav_SendCommand("CompTestStepped*","Activate")
PolNav_SendCommand("CompTestStepped*","Set WavelengthStart,1540")
PolNav_SendCommand("CompTestStepped*","Set WavelengthStop,1550")
PolNav_SendCommand("CompTestStepped*","Set WavelengthStep,0.1")

LiveSOP R double Live SOP

LiveWavelength R/W double Writing this variable 
immediately sets the laser 
wavelength to the specified 
wavelength in nm.

UseInternalRef R/W bool Internal optical reference path 
is used (Yes) or not (No). It is 
recommended to leave this 
value set to Yes.

KeepRawData R/W bool Raw data is embedded in the 
PBIN files (Yes) or not (No). 
Embedding raw data enables 
offline post processing but 
increases file size.

DetectModehops R/W bool Try to detect mode hops (Yes) 
or not (No). Some laser sources 
can detect mode hops during 
the continuous sweep.

InternalRefValidMinutes R/W double This value defines the 
maximum R/W double lifetime 
of an internal reference 
measurement in minutes. A 
value of 0 (default) defines 
infinite lifetime. Use a value 
greater than 0 if the power of 
your laser source is slowly 
drifting.

VarName R/W Type Description
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PolNav_SendCommand("CompTestStepped*","SingleMeasurement")
DO

PROGRESS=PolNav_SendCommand("CompTestStepped*","Get Progress")
WAIT

WHILE PROGRESS<>"2"

PLOTDATA=PolNav_SendCommand("CompTestStepped*","GetPlot Default")

Commands

The following commands are available:

Command Description

GetPlot Default Returns the plot data of the last measurement. 
The response is a string which is formatted like 
a spreadsheet consisting of rows and columns. 
Columns are separated by a comma (,). Rows 
are separated by a LF (ASCII code 10). See 
PDL/PMD Data (Default) on page 338 
for details on the meaning of each column.

SingleMeasurement Starts a single measurement. This is similar to 
pressing the button Single Measurement in 
the application.

RepeatMeasurement Starts a repeated measurement. This is similar 
to pressing the button Repeat Measurement in 
the application.

StopMeasurement Stops a measurement. This is similar to 
pressing the button Stop Measurement in the 
application.

TakeReference Starts a reference measurement. This is similar 
to pressing the button Take Reference in the 
application.

StepPredict Lambda0; Lambda1; 
...

Starts the automatic step prediction 
algorithm. This is similar to pressing the 
button "Auto" in the application. You have to 
specify the desired wavelengths at which the 
measurements will be performed (given as list 
of values separated by semicolons), e.g.:
PolNav_SendCommand("CompTestStepped*",
"StepPredict 1530.0;1550.0;1580.0")

Save Filename Saves the current measurement into a 
PBIN-File

Export Filename Saves the current measurement into an 
ASCII-File
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Variables

SaveReference Filename Saves the current reference
measurement into a PBIN-File

LoadReference Filename Loads the file into the reference list. The file is 
appended at the end of the list and selected as 
active reference.

ClearReference Removes the current reference measurement.

ClearReferenceAll Removes all reference measurements from the 
list.

VarName R/W Type Description

Progress R int This variable is set to 0 when a 
measurement is started. It is 
increased once when the 
measurement is in progress. And 
it is increased once when the data 
has been evaluated. Thus you can 
wait until this variable becomes 2 
before retrieving the data using 
the GetPlot Default 
command. In repeat mode the 
variable is not reset to 0. Thus the 
next measurement will be 
available if the variable becomes 
4.

WavelengthStart R/W double Start wavelength in nm.

WavelengthStop R/W double Stop wavelength in nm.

WavelengthStep R/W double Step size in nm.

AutoResolution R/W int Turns the automatic resolution 
on/off (1/0).

Resolution R/W double Resolution in nm.

PowerResolution R/W double Resolution of Power trace in nm. 
0 = Default.

TLSPower R/W double TLS power in mW.

AutoGain R/W bool Auto gaining on/off (1/0).

Command Description
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Target PERTest

The target name PERTest* will select the component test application.

A simple pseudo program controlling the component test application 
could be as follows:
DECLARE STRING PER

PolNav_SendCommand("PERTest*","Activate")

PolNav_SendCommand("PERTest*","Set Wavelength,1550")

PolNav_SendCommand("PERTest*","Set Mode,2")

PolNav_SendCommand("PERTest*","StartMeasurement")

WAIT 4000

PolNav_SendCommand("PERTest*","SetPER")

DO

PER=PolNav_SendCommand("PERTest*","Get PERCurrent")

PRINT "PER = ";PER;" dB"

WHILE FOREVER

UseReference R/W bool Use reference measurement 
on/off (1/0).

CurrentGain R/W int Current gain setting. Allowed 
values are 0..13

Properties R string Dumps the properties which are 
attached to the last 
measurement.

UseInternalRef R/W bool Internal optical reference path is 
used (Yes) or not (No). It is 
recommended to leave this value 
set to Yes.

UseReferenceNo R/W int Selects/queries the number of 
the current reference 
measurement.

KeepRawData R/W bool Raw data is embedded in the 
PBIN files (Yes) or not (No). 
Embedding raw data enables 
offline post processing but 
increases file size.

LastEvalError R/W int Result of last evaluation. See 
Error Codes on page 336 for 
possible values.

VarName R/W Type Description
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Commands

The following commands are available:

Command Description

Manual Starts the measurement. This is similar to 
pressing the button PER Manual in the 
application.

Live Stops a measurement and shows the Live PER. 
This is similar to pressing the button PER Live 
in the application.

Wavelength Scan Starts a PER measurement using the 
wavelength scan method. This is similar to 
pressing the button PER WL Scan in the 
application.

Heater (or Heater0) Starts a single-TCU PER measurement. This is 
similar to pressing the button PER (Heater) in 
the application.

Heater1 Starts a single-TCU PER measurement with 
the second TCU. This is similar to pressing the 
button PER (Heater) in the application while 
holding down the CTRL key.

SpliceAngle Starts a dual-TCU PER measurement for splice 
angles. This is similar to pressing the button 
Splice Al ign in the application.

GetPlot Default Returns the plot data of the last measurement. 
The response is a string which is formatted like 
a spreadsheet consisting of rows and columns.
Columns are separated by a comma (,). Rows 
are separated by a LF (ASCII code 10). See 
PDL/PMD Data (Default) on page 338 
for details on the meaning of each column.

TempHeat0 Sets the first Thermal Cycling Unit into heating 
mode.

TempCool0 Sets the first Thermal Cycling Unit into cooling 
mode.
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Variables

TempHeat1 Sets the second Thermal Cycling Unit into 
heating mode.

TempCool1 Sets the second Thermal Cycling Unit into 
cooling mode.

TempOff Turns off the power (no heating, no cooling) of 
the Thermal Cycling Unit.

VarName R/W Type Description

Wavelength R/W double Center wavelength in nm.

SweepRange R/W double Sweep range in nm.

TLSPower R/W double TLS power in mW.

AutoGain R/W bool Auto gaining on/off (1/0)

CurrentGain R/W int Current gain setting. Allowed 
values are 0..13

PERCurrent R double Current PER value in dB.

PERLive R double Current Live-PER in dB.

PowerLive R double Current live power level in mW.

SpliceAngle R double Current Splice Angle in deg.

SplicePER R double Current Splice PER in dB.

HeaterAvail0 R bool 1st TCU: 
0=not installed, 1=installed

HeaterAvail1 R bool 2nd TCU:
0=not installed, 1=installed

HeaterState0 R int 1st TCU: -1=not installed, 0=off, 
1=cooling, 2=heating

HeaterState1 R int 2nd TCU: -1=not installed, 0=off, 
1=cooling, 2=heating

HeatingTime R/W double Maximum heating time in s.

CoolingTime R/W double Maximum cooling time in s.

Command Description
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Target ContScrambling

The target name ContScrambling* will select the continuous 
scrambling application (see Application: Continuous Scrambling on 
page 128 for more details).

A simple pseudo program starting the scrambler could be as follows:
DECLARE STRING MaxSpeed
PolNav_SendCommand("ContScrambling*","Activate")
PolNav_SendCommand("ContScrambling*","Set Scanrate,8")
PolNav_SendCommand("ContScrambling*","Set Enable,1")
MaxSpeed=PolNav_SendCommand("ContScrambling*","Get MaxSpeed")

Variables

SettlingTime R/W double Settling time in s.

SpliceAngleAccuracy R/W double Threshold in deg for finishing 
automatic splice alignment. If the 
splice angle is below this value, 
alignment will stop.

LightSourceAutoOff R/W string Yes = The internal laser source (if 
present) will be automatically 
turned on/off. No = The laser 
source remains on.

HeatingTimeAuto R/W string On = Automatic heating time 
adjustment is activated, No = Use 
HeatingTime and CoolingTime 
instead.

Laser R/W bool Internal laser source on/off (1/0). 
Only if the instrument has a 
built-in laser source.

VarName R/W Type Description

VarName R/W Type Description

Enable W bool Enables (1) or disables (0) the 
scrambling mode.
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IsScrambling R bool Returns the state of the 
scrambler: 0=Off, 1=Scrambling.

Scanrate R/W int Defines the scrambling speed 
(1-1000).

MaxSpeed R double Maximum expected SOP 
movement rate (in rad/s).

VarName R/W Type Description
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Using MATLAB

As described in the chapter DLL Interface (DLL Interface on page 244), the 
DLL PolNavClient.dll can be used to send commands to the 
polarizationNAVIGATOR™. Making use of this DLL is very simple if the 
MATLAB extension (MEX-Files) is used which comes with the software. We 
recommend that you set a permanent path in MATLAB to the Bin\Matlab 
subfolder of the polarizationNAVIGATOR™ installation directory.

After having done so, you can use the following new MATLAB commands:

Commands

[response,result]=MEX PolNav SendCommand(target,command)

Send a command to the polarizationNAVIGATOR™ and receive a string 
response. result contains an error code.
[response,result]=MEX PolNav SendCommandEx(target,command)

Send a command to the polarizationNAVIGATOR™ and receive plot data. 
result contains an error code.

Please type help MEX PolNav SendCommand or help MEX 
PolNav SendCommandEx at the MATLAB command prompt for 
details of the calling parameters.

Here is a simple example of how the component test application (see 
Target CompTest on page 257) can be automated using MATLAB:

MEX_PolNav_SendCommand('CompTest*','Activate');

MEX_PolNav_SendCommand('CompTest*','Set WavelengthStart,1540');

MEX_PolNav_SendCommand('CompTest*','Set WavelengthStop,1550');

MEX_PolNav_SendCommand('CompTest*','SingleMeasurement');

while 1

[response,result]=MEX_PolNav_SendCommand('CompTest*',

'Get Progress');

if str2num(response)==2;

break;

end

pause(1);

end;

[PlotData,result]=MEX_PolNav_SendCommandEx('CompTest*',

'GetPlot Default');

plot(PlotData(:,1),PlotData(:,2));
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Make sure that the polarizationNAVIGATOR™ is already started before 
executing the MATLAB script. In the folder DemoMATLAB, you can find the 
m-file PolNavPERTest.m which is an example for controlling the 
PER-measurement application.
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Using LabView

As described in the DLL Interface on page 244, the DLL 
PolNavClient.dll can be used to communicate with the 
polarizationNAVIGATOR™. Making use of this DLL is very simple if the 
LabView-VIs are used which come with the polarization NAVIGATOR. The 
necessary VIs are located in the library file PolNavClient.llb.

There is only one VI named SendCommand.vi which communicates 
with the polarizationNAVIGATOR™.

Input parameters are the communication target and the actual command. 
Refer to Polarization Navigator Automation: Target Names on page 249 for 
details on the available commands.

Refer to Error Codes on page 336 for details of the possible error results.

Note that the polarizationNAVIGATOR™ has to be started prior to sending 
these commands.

You can also find some example VIs in the library PolNavClient.llb:

• PolNavClient_ComponentTest_Demo.vi gives an example 
implementation for automating the component test application (Target 
CompTest on page 257).

• PolNavClient_PER_Demo.vi gives an example implementation 
for automating the PER application (Target PERTest on page 263).

Input parameters: Target, Command, MaxResponseSize

Output parameters: Response, ResponseSize, ErrorCode
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Using Python

As described in DLL Interface on page 244, the DLL 
PolNavClient.dll can be used to communicate with the 
polarizationNAVIGATOR™. Making use of this DLL is very simple if the 
Python-extension is used which comes with the polarizationNAVIGATOR™. 
We recommend that you copy the DLL PyPolNav.dll into your Python 
DLL directory (typically named c:\Program Files\
PythonXX/DLLs\). You can find this DLL in the directory 
DemoPython2.2 or DemoPython2.4 depending on the Python version you 
are using.

After having done so, you can use the extension by importing the DLL 
using the following command:

import PyPolNav

Check the availability of the DLL as follows (returns the version number):
print "PyPolNav.dll version:" print PyPolNav.GetDLLVersion()

A simple communication with the polarizationNAVIGATOR™ could be as 
follows:
print "polarization NAVIGATOR version:" print

PyPolNav.SendCommand("Global","Get Version")

The last error code can be read as follows:
ErrorCode=PyPolNav.LastError()

Note that the polarizationNAVIGATOR™ has to be started prior to sending 
these commands. Refer to Polarization Navigator Automation: Target 
Names on page 249 for details on the available commands. Refer to Error 
Codes on page 336 for details on the possible error results.

You can also find a simple demo script PERTest.py located in the 
folder DemoPython2.2 or DemoPython2.4 showing how to use the PER 
application with Python.
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Using VBA

As described in DLL Interface on page 244, the DLL 
PolNavClient.dll can be used to communicate with the 
polarizationNAVIGATOR™. You can directly access the DLL functions from 
Microsoft Visual Basic for Applications (VBA), e.g. from EXCEL.

The corresponding declarations are:

See DLL Interface on page 244 for details on the parameters. An example 
using Microsoft EXCEL is included in the software package. The filename is 
PolNavClientDemo1.xls located in the Examples subfolder of the 
polarizationNAVIGATOR™ installation directory.

Declare Function PolNav_SendCommand& Lib "PolNavClient.dll" _

Alias "?PolNav_SendCommand@@YGHPBD0PADHAAH@Z" _

(ByVal Target As String, ByVal Command As String, _

ByVal Response As String, ByVal MaxLen As Long, _

ByRef ResponseLen As Long)

Declare Function PolNav_ReadResponse& Lib "PolNavClient.dll" _

Alias "?PolNav_ReadResponse@@YGHHHPADHAAH@Z" _

(ByVal iStart As Long, ByVal iLength As Long, _

ByVal Response As String, ByVal MaxLen As Long, _

ByRef ResponseLen As Long)
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Using Keysight VEE

You can find an example VEE program in the Examples subfolder of the 
polarizationNAVIGATOR™ installation directory:

\Examples\Vee\Hello World.vee

Please note that Keysight VEE cannot call C++ functions. Therefore, the 
DLL also contains corresponding functions in ANSI-C calling convention:

• PolNavC_SendCommand

• PolNavC_ReadResponse

• PolNavC_Disconnect

• PolNavC_HelloWorld

The corresponding header file is named PolNavClientDll_Vee.h.

See DLL Interface on page 244 for details on the parameters.
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This chapter lists all file types used by the polarizationNAVIGATOR™.

PBIN-Files   /  276
Measurement Series   /  277
CSV-Files (Comma Separated Values)   /  278
ASCII-Files   /  279
PMR-Files   /  280
CD-Files   /  281
MATLAB File Handling   /  282
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PBIN-Files

The default file format used by the polarizationNAVIGATOR™ is a binary 
file format with the extension .pbin. These files contain measurement data 
such as SOP measurements or PMD measurements. For MATLAB 
integration, m-files are provided to load PBIN-files (see MATLAB File 
Handling on page 282).
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Measurement Series

The polarizationNAVIGATOR™ supports handling of measurement series. 
You can load a series of measurements (e.g. a collection of long term data) 
into a single document. Use the File>Import Series to import all PBIN-files 
contained in a single directory. Use File>Save As to save the complete 
series into a single PBIN-file.

Once the series is loaded into a single document, you can export the data 
as CSV-file (see CSV-Files (Comma Separated Values) on page 278) or 
MAT-file (see Exporting MATLAB Files on page 282).
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CSV-Files (Comma Separated Values)

If you want to export data in CSV format use the menu entry File>Export. 
Please choose a target filename with the extension .csv. After selecting the 
target filename a dialog box may appear allowing you to choose which 
data will be exported into that file. See ASCII File Formats on page 338 for 
details on the data organization.

The generated files can be imported e.g. to EXCEL. Please note that the 
polarizationNAVIGATOR™ uses the localized decimal point. For English 
systems, this is usually full stop (.), the value separator is a comma (,) 
accordingly. For German systems, the decimal point is a comma (,) and the 
value separator is a semi-colon (;). You can change these settings in the 
Windows control panel.

Measurement Series

For measurement series, data of one type is formatted to form a block. 
Thus, for example, all DOP values belonging to different measurements are 
grouped together to simplify generation of 3-dimensional plots.

Note that only series can be exported containing measurements with the 
same number of data points each.
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ASCII-Files

If you want to export data in ASCII format use the menu entry File>Export. 
Please choose a target filename with the extension .asc. After selecting the 
target filename a dialog box may appear allowing you to choose which 
data will be exported into that file. See ASCII File Formats on page 338 for 
details on the data organization.
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PMR-Files

Files with the extension .pmr are created by the PMD field tester module 
N3909A belonging to the Keysight Modular Network Tester (MNT) 
platform. These files can be imported into the polarizationNAVIGATOR™ to 
be viewed. Furthermore, they can be exported as PDF reports (see chapter 
Report Generation on page 283).
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CD-Files

Files with the extension .cd are created by the 4-wavelength OTDR module 
N3916AL belonging to the Keysight Modular Network Tester (MNT) 
platform. These files can be imported into the polarizationNAVIGATOR™ to 
be viewed. Furthermore, they can be exported as PDF reports (see chapter 
Report Generation on page 283).
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MATLAB File Handling

Exporting MATLAB Files

If you want to export data as MATLAB .mat files use the menu entry 
File>Export. Please choose a target filename with the extension .mat. Note 
that you need MATLAB to use this feature.

If you load the .mat file into the MATLAB workspace the variable Data 
contains the exported information as a struct variable. Type in Data to 
see the contents:

Data Data =

Lambda: [2077x1 double]

DGD: [2077x1 double]

PDL: [2077x1 double]

Power: [2077x1 double]

PDLDivided: [2077x2 double]

PDLPSP: [2077x3 double]

PSP: [2077x3 double]

PMD2nd: [2077x1 double]

Info: [1x1 struct]

Mueller: [2077x16 double]

Jones: [2077x4 double]

See also Application: PMD/PDL (PMD/PDL/Loss) on page 87.

Loading PBIN-Files into MATLAB

You can load PBIN-files into the MATLAB workspace using the following 
command:
Data=PBinRead('Filename.pbin');

Note that you have to set a path into the directory containing the .m files. 
The .m files that come with the polarizationNAVIGATOR™ are located in 
the \Bin\Matlab\ subfolder of the polarizationNAVIGATOR™ installation 
directory.
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This chapter provides information for report generation.

Generating PDF Reports   /  284
Report Templates   /  287
Command Reference: Main Nodes   /  288
Command Reference: Placing Text   /  291
Command Reference: Text Layout   /  293
Command Reference: Placing Data from the Document   /  297
Command Reference: Placing Images/Plots   /  300
Command Reference: Placing Measurement Table Data   /  302
Command Reference: Conditional Structures   /  304
Command Reference: Document Property Values   /  308
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Generating PDF Reports

The documents containing the measurements can be exported as a PDF 
file. This includes graphical data (e.g. DGD curves) as well as scalar results 
such as the PMD value. The report generator can process multiple files in a 
single run. For example, all .pbin files contained in a directory can be 
converted into multiple PDFs or they can be written into a single PDF.

The appearance of these reports can be highly customized. For example, a 
company logo can be placed on the page(s) or the information can be 
reduced to only the relevant data of a specific customer. Also specific 
parameters can be interactively queried from the customer in a 
customizable dialog (e.g. DUT name or serial number).

The layout is defined by a definition file, the so-called report template. This 
file uses the XML syntax and can be seen as a simple script language. The 
command reference is given in the next chapters.

Creating a Report for the Current Document

You can generate a single report from the current document using the 
following steps:

1 Open your document.

2 Click on Tools>Report Generator or on the PDF icon in the toolbar.

3 The report generator wizard appears. Select Current document from 
the list.

4 Select a report template from the list (apparently only one template is 
selectable).

5 Click on Next.

6 Enter additional information if desired in the next page.

7 Click on Next.

8 Click on Finish.

9 You will be asked for a target filename.

Now, a PDF file is generated and opened afterwards.

NOTE
A PDF viewer such as the Acrobat Reader needs to be installed on your 
system.
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Creating a Report for all Gallery Documents

You can generate multiple reports from all opened documents in the 
gallery using the following steps:

1 Open several documents.

2 Only documents of the same class can be processed at once (e.g. 
either only SOP measurements or PMD measurements). Bring a typical 
document you want to process to the front.

3 Click on Tools>Report Generator or on the PDF icon in the toolbar.

4 The report generator wizard appears. Select All gallery documents 
from the list.

5 Select a report template from the list (apparently only one template is 
selectable).

6 Click on Next.

7 Choose if you want several PDF files to be generated or a single PDF 
file.

8 Click on Next.

9 Choose the target directory.

10 Click on Next.

11 Enter additional information if desired in the next page.

12 Click on Next.

13 Click on Finish.

14 You will be asked for a target filename and if needed for a target 
directory.

Creating a Report for all Documents Contained in a Directory

You can generate multiple reports from all documents contained in a 
single directory using the following steps:

1 Only documents of the same class can be processed at once (e.g. 
either only SOP measurements or PMD measurements). Bring a typical 
document you want to process to the front or close all documents.

2 Click on Tools>Report Generator or on the PDF icon in the toolbar.

3 The report generator wizard appears. Select All document contained in 
a folder from the list.

4 Select a report template from the list.

5 Click on Next.

6 Choose if you want several PDF files to be generated or a single PDF 
file.
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7 Click on Next.

8 Choose the target directory.

9 Click on Next.

10 Enter additional information if desired in the next page.

11 Click on Next.

12 Click on Finish.

13 You will be asked for a target filename and if needed for a target 
directory.
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Report Templates

The report templates are located in the subfolder \Bin\
ReportTemplates\ of the polarizationNAVIGATOR™ installation folder. 
You can make a copy of one of the existing .xml files and modify it 
according to your needs.

File structure

A typical template file has the following structure:

The <Info> node tells the polarizationNAVIGATOR™ something about the 
template file (e.g. which documents can be used, which filename 
extensions can be used for the source files etc.).

The <UserDialog> node includes additional parameters queried from the 
customer during the report generation.

The <PageTemplate> node contains commands which are processed 
whenever a new page begins.

The report layout itself is placed after the PageTemplate section.

<?xml version="1.0" ?>

<ReportTemplate>

<Info>

<Value Name="DocClasses">3</Value>

<Value Name="LongName">Keysight PBIN Files, 
PMD-Measurement</Value>

<Value Name="Extension">pbin</Value>

<Value Name="CountPages">no</Value>

</Info>

<UserDialog>

<Input Name="DUT" Prompt="Device Under Test :" Default="" />

</UserDialog>

<PageTemplate>

{Common Page Layout}

</PageTemplate>

{Pages}

</ReportTemplate>
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Command Reference: Main Nodes

<Info> Node

The <Info> node tells the polarizationNAVIGATOR™ something about the 
template file (e.g. which documents can be used, which filename 
extensions can be used for the source files etc.).

A typical <Info> node looks as follows:

Items:
<Value Name="DocClasses">DocClass1;DocClass2...</Value>

Enter the document classes this report is valid for. Valid class numbers 
are:

<Value Name="LongName">Name</Value>

This entry defines the name displayed in the wizard dialog.

<Info>

<Value Name="DocClasses">3</Value>

<Value Name="LongName">Keysight PBIN Files, PMD-Measurement</Value>

<Value Name="Extension">pbin</Value>

<Value Name="CountPages">no</Value>

</Info>

DocClass Document Type

1 .pbin-files (SOP-Measurement)

2 .pbin-files (PMD-Measurement)

4 .pmr-files

5 .cd-files

<Value Name="Extension">FilenameExtension1;FilenameExtension2...</Value>
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This entry defines a list of applicable filename extensions (usually only 
pbin).

<Value Name="CountPages">{no/yes}</Value>

The total number of pages might depend in certain cases on the 
measurement content. If you want the total number of pages to appear in 
the report, the report generator is called twice to count the pages. If 
Count-Pages is set to no, this behavior is suppressed to speed up the 
process. If you know the number of report pages in advance, we 
recommend to set this value to no.

<UserDialog> Node

The <UserDialog> node allows to configure a special page within the 
report generator wizard to query additional parameters from the user.

A typical <UserDialog> node looks as follows:

Items:

<UserDialog>

<Input Name="DUT" Prompt="Device Under Test :" Default="" />

<Input Name="ProductNumber" Prompt="Product Number :" Default="" />

<Input Name="ProductSN" Prompt="Product S/N :" Default="" />

</UserDialog>

<Input Name="{VariableName}" Prompt="{UserPrompt}" Default="{DefaultValue}" />

Parameter Description

VariableName Identifier name for storing the user entry.

UserPrompt String printed into the dialog box.

DefaultValue Initial value of the input field. Will be pasted into the input 
field if the user clicks on Reset to Defaul ts.
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<PageTemplate> Node

The <PageTemplate> node contains commands which are processed at 
the beginning of every page. It can contain all commands listed in the 
following command reference.

A typical <PageTemplate> node looks as follows:

This command places an image named Background.png located in 
the same directory as the template file on the top left corner of every page 
and scales it to the page width and page height.

<PageTemplate>

<Image x="0" y="0" Width="paper" Height="paper">Background.png</Image>

</PageTemplate>
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Command Reference: Placing Text

< t >< /t >

Examples:
<t>Hello World</t>

<t Align="center">Hello World</t>

<t Linefeed="yes">Hello World</t>

Prints the text at the current cursor position.

< p >< /p >

Examples:
<p>Hello World</p>

<p Align="center">Hello World</p>

<p Linefeed="no">Hello World</p>

Prints the text at the current cursor position and does a linefeed 
afterwards.

< Space/>

Example:
<t>Hello</t><Space/><t>World</t>

Prints a single space.

Attribute Description

Align center: The text will be horizontally centered.

Linefeed yes: A linefeed is performed at the end. no: No
linefeed is performed at the end (default).

Attribute Description

Align center: The text will be horizontally centered.

Linefeed yes: A linefeed is performed at the end (default). no: No 
linefeed is performed at the end.
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< Font >< /Font >

<Font Size="24"><t>Hello World</t></Font>

<Font Size="8" LineWidth="1.3"><p>abc</p><p>def</p></Font>

<Font Face="Helvetica"><t>Hello World</t></Font>

<Font Face="Helvetica-Bold"><t>Hello World</t></Font>

<Font Face="Symbol"><t>abg</t></Font>

Defines the appearance of the font

Attribute Description

Size Defines the font size. Default: 10

LineWidth Defines the vertical space between the lines. Default: 1.0

Face Defines the font to be used. Valid values are: Helvetica, 
Helvetica-Bold, Helvetica-Oblique, Helvetica-BoldOblique, 
Symbol, Courier, Courier-Bold, Courier-Oblique, 
Courier-BoldOblique, Times-Roman, Times-Bold, 
Times-Italic, Times-BoldItalic, ZapfDingbats. Default: 
Helvetica

Encoding Defines the font encoding. Valid values are: 
WinAnsiEncoding, StandardEncoding, 
MacRomanEncoding, Symbol-Set, ZapfDingbats-Set. 
Default: WinAnsiEncoding
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Command Reference: Text Layout

< MoveTo/ >

Examples:
<MoveTo x="30" y="14%" />

<MoveTo x="-170" />

<MoveTo dy="6" />

<MoveTo x="-34%" y="-4%" />

<MoveTo x="25%" />

<MoveTo y="48%" />

<MoveTo x="30" dy="24" Margin="left" />

Moves the virtual cursor to a position on the page.

Attribute Description

x x-Position in points or in percent of the page width. 
Negative value indicate positions relative to the right page 
border.

y y-Position in points or in percent of the page height. 
Negative value indicate positions relative to the bottom 
page border.

dx Relative x-Position in points or in percent of the page 
width.

dy Relative y-Position in points or in percent of the page 
height.

Margin Sets the text margin.
left: Moves to the specified position and sets this position to 
be the left text box margin.
right: Moves to the specified position and sets this position 
to be the right text box margin.
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< Box >< /Box >

Examples:

Puts the commands between the tags into a box. The box boundaries can 
be marked with lines. The box background can have different colors.

The default width is given by the current x-position. In that case the right 
boundary is right page limit minus the current x-position. The vertical size 
is given by the current y-position when opening the box and the current 
y-position when closing the box.

<Box Style="frame"><p>Hello World</p></Box>

<Box Style="overline"><p>Hello World</p></Box>

<Box Color="gray" Width="40%"><p>Hello World</p></Box>

<Box Color="toggle" Width="40%"><p>Hello World</p></Box>

<Box Color="toggle" Width="40%" Style="underline"><p>Hello World</p></Box>

Attribute Description

x x-Position in points or in percent of the page width. 
Negative value indicate positions relative to the right page 
border.

y y-Position in points or in percent of the page height. 
Negative value indicate positions relative to the bottom 
page border.

Width The desired width of the box, either absolute or in percent.

Height The desired height of the box, either absolute or in percent.

Style frame: Draws a frame around the box. 
overline: Draws a line on the top side of the box. 
underline: Draws a line on the bottom side of the box.

Color gray: Sets the background color to gray.
white: Sets the background color to white.
toggle: Toggles between gray and white.

Border Defines the border size between the frame and the text. A 
value of 1.0 corresponds to a character height.
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< TabClear/>;< TabSet/>;< TabNext/>;

Examples:
<TabClear />

<MoveTo x="0%" />

<TabSet />

<MoveTo x="25%" />

<TabSet />

<MoveTo x="37%" />

<TabSet />

<t>Hello</t><TabNext/><p>World</p>

<TabClear/> 

clears the tabulator list.

<TabSet/> 

stores the current position in the tabulator list.

<TabNext/> 

Moves the current position to the next tabulator position.

< HLine/>

Examples:
<HLine/>

<p>Hello World</p>

<HLine/>

Draws a horizontal line at the current y position between the left and right 
text boundaries.

< PushPos/>;< PopPos/>

Examples:
<p>Hello</p>

<PushPos/>

<MoveTo x="-10%" y="-10%">

<DocParam Name="Today" />

<PopPos/>

<p>World</p>

<PushPos/> 

Saves the current position on the position stack.
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<PopPos/> 

Recalls the current position from the position stack.

< PageBreak/>

Examples:
<PageBreak/>

<PageBreak Orientation="portrait" Paper="Letter" />

Begins a new page.

Attribute Description

Orientation tt portrait: Portrait format (default).
tt landscape: Landscape format.

Paper Defines the paper size. Valid values are: a4, a3, a5, legal, 
letter.
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Command Reference: Placing Data from the Document

< DocParam/>

Examples:
<DocParam/>

<DocParam Name="PolNavVersion"/>

<DocParam Name="PolNavVersion" StopChar=","/>

<DocParam Name="WavelengthStartDesired" Format="%.3f"/>

<DocParam Name="SweepRateMain" Format="%.0f"/>

Retrieves property values from the current document and writes them 
using the specified format onto the page.

Without any attributes, the command prints a list of available properties 
and their values. If you define a tab position using < TabSet/>, the 
values will be horizontally aligned.

Usually, a property name is specified using the Name attribute. See 
Command Reference: Document Property Values on page 308 for a 
complete list of available properties.

Attribute Description

Name The name of the desired property.

Format A C-style format string defining how the data will be 
formatted. An empty value indicates a string.
%.3f Floating point value with 3 decimal digits.
%.3g Floating point value with 3 significant decimal digits. 
Variable format.
%d Integer value (signed).
%u Integer value (unsigned).

StopChar Defines a character which terminates the output. Only used 
with strings.
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< DocParamLoadReg/>;< PrintReg/>

Example 1 (Print highest instead of 0):
<DocParamLoadReg Name="Resolution"/>

<Compare Operation="eq">0</Compare>

<If>

<t>highest</t>

</If>

<Else>

<DocParam Name="Resolution" Format="%.3f"/>

</Else>

Example 2 (Convert mW into dBm):
<DocParamLoadReg Name="Loss"/>

<Calc Operation="log10"/>

<Calc Operation="multiply">10</Calc>

<PrintReg Format="%.2f"/>

Simple computations can be performed using a global accumulator 
register.

<DocParamLoadReg/> loads a document property value into this 
accumulator register. Further computations or conditional formats can be 
implemented in this way (e.g. a conversion from mW into dBm).

The property name is specified using the Name attribute. See Command 
Reference: Document Property Values on page 308 for a complete list of 
available properties.

<PrintReg/> prints the current content of the accumulator.

Attribute Description

Name The name of the desired property.

Attribute Description

Format A C-style format string defining how the data will be 
formatted. An empty value indicates a string.
%.3f Floating point value with 3 decimal digits.
%.3g Floating point value with 3 significant decimal digits. 
Variable format.
%d Integer value (signed).
%u Integer value (unsigned).
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< PageNo/>;< SetPageNo ></SetPageNo >

Example:
<SetPageNo>1</SetPageNo>

<t>This is page</t><Space><PageNo/>

<SetPageNo> 

Sets the page counter to the specified value.

<PageNo/> 

Prints the current page number.

< Filename/>

Example:
<t>Source file:</t><Space><Filename/>

Prints the current source file name.
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Command Reference: Placing Images/Plots

< Image >< /Image >

Examples:

Places a JPG or PNG image onto the page.

< Plot >< /Plot >

Examples:
<Plot Width="512" Height="384">DGD</Plot>

<Plot Width="512" Height="384" Scaling="0.5">TE/TM</Plot>

Places plot data onto the page. The name of the plot appears between the 
Tags. Valid values are:

<Image x="0" y="0" Width="paper" Height="paper">Background.png</Image>

<Image x="0" y="0" Width="320" Height="200">Logo.jpg</Image>

Attribute Description

x x-Position in points or in percent of the page 
width. Negative value indicate positions 
relative to the right page border.

y y-Position in points or in percent of the page 
height. Negative value indicate positions 
relative to the bottom page border.

Width The desired width of the box, either absolute 
or in percent. A value of paper scales the width 
to the paper width.

Height The desired height of the box, either absolute 
or in percent. A value of paper scales the 
height to the paper height.

Scaling The picture can be scaled using the 
Scaling attribute. Default: 1.0
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• PMD measurements (.pbin-files)
DGD, TE/TM, PDL, Power/Loss, SOPMD, Depol, PCD.

• SOP measurements (.pbin-files)
Poincaré, Stokes (norm), DOP, Stokes, Power.

• PMD measurements (.pmr-files)
DGD, MaxDGD, SOPMD2nd Order PMD, PCD, Depol., DOP, Loss.

• CD measurements (.cd-files)
absolute D, relative D, RGD, Slope, D/Slope.

Attribute Description

x x-Position in points or in percent of the page width. 
Negative value indicate positions relative to the right page 
border.

y y-Position in points or in percent of the page height. 
Negative value indicate positions relative to the bottom 
page border.

Width The desired width of the box, either absolute or in percent. 
A value of paper scales the width to the paper width.

Height The desired height of the box, either absolute or in percent. 
A value of paper scales the height to the paper height.

Scaling The picture can be scaled using the Scaling attribute. 
Default: 1.0
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Command Reference: Placing Measurement Table Data

< DocPlot/ >;< IsLastRow/ >;< NextDocRow/ >;< ResetDocRow/ >

Examples:
<ResetDocRow />

<IsLastRow />

<Not />

<While>

<DocPlot Name="Wavelength" Format="%.2f" />

<NextDocRow />

<IsLastRow />

<Not />

</While>

The measurement plot data can be accessed using a row counter. The 
initial value of the row counter is 0.

<ResetDocRow/> 

Resets the row counter.

<NextDocRow/> 

Increments the row counter.

<IsLastRow/> 

Checks if the row counter is beyond the last entry and sets the global 
accumulator register to TRUE (1) or FALSE (0) accordingly.

<DocPlot/> 

Retrieves one data point and prints it as text into the document. The data 
point is identified by the plot name and the current row counter position. 

Valid plot names are:

• PMD measurements (.pbin-files)
DGD, TE/TM, PDL, Power/Loss, SOPMD, Depol, PCD.

• SOP measurements (.pbin-files)
Poincaré, Stokes (norm), DOP, Stokes, Power.

• PMD measurements (.pmr-files)
DGD, MaxDGD, 2nd Order PMD, PCD, Depol., DOP, Loss, 
Wavelength.

• CD measurements (.cd-files)
absolute D, relative D, RGD, Slope, D/Slope, Wavelength, 
Frequency, No., Pass/Fail.
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The attributes for the <DocPlot/> command are:

< DocPlotLoadReg/>

Example:
<DocPlotLoadReg Name="Pass/Fail" />

<If>

<t>passed</t>

</If>

<Else>

<t>failed</t>

</Else>

Loads the data point identified by the plot name and the current row 
counter position into the global accumulator register. Further evaluation 
or conditional commands can be processed afterwards.

<NextDocRow/>

Attribute Description

Name The name of the plot data.

Format A C-style format string defining how the data will be 
formatted. An empty value indicates a string.
%.3f Floating point value with 3 decimal digits.
%.3g Floating point value with 3 significant decimal digits. 
Variable format.
%d Integer value (signed).
%u Integer value (unsigned).

Attribute Description

Name The name of the plot data. See < DocPlot/ >;< 
IsLastRow/ >;< NextDocRow/ >;< 
ResetDocRow/ > on page 302 for a list of valid plot 
names.
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Command Reference: Conditional Structures

< If >< /If >;< Else >< /Else >

Example:
<IsEmpty Name="Location A" />

<Not />

<If>

<t>Location A</t>

<TabNext />

<DocParam Name="Location A" />

<p></p>

</If>

<Else>

<p>No location defined.</p>

</Else>

The <If> command executes the commands placed between its tags if 
the content of the global accumulator register is non-zero (TRUE). The 
<Else> command immediately following the if clause will be executed if 
the global accumulator contained a zero value (FALSE).

< While >< /While >

Example 1:
<TabClear />

<MoveTo x="0" />

<TabSet />

<LoadReg>1</LoadReg>

<While MaxIterations="20">

<MoveTo dx="60" />

<TabSet />

<LoadReg>1</LoadReg>

</While>
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Example 2:
<ResetDocRow />

<IsLastRow />

<Not />

<While>

<DocPlot Name="Wavelength" Format="%.2f" />

<NextDocRow />

<IsLastRow />

<Not />

</While>

The while command allows the creation of simple loops. The while 
command decides according to the state of the global accumulator 
register whether the statement is to be executed or not. In this example, 
the accumulator is loaded with 1 (TRUE) causing the loop to be started. 
Note that at the end of the loop, the condition has to be updated manually. 
You can limit the number of iterations using the Maxiterations 
attribute.

< LoadReg >< /LoadReg >

Example:
<LoadReg>1.0</LoadReg>

<While MaxIterations="20">

<MoveTo dx="60" />

<TabSet />

</While>

Loads the global accumulator register with a constant.

< IsEmpty/ >

Example:
<IsEmpty Name="Location A" />

Checks if the document property value described by the Name attribute is 
empty (TRUE) or not (FALSE). The result is stored in the global 
accumulator register.

Attribute Description

MaxIterations The maximum number of iterations of the loop.
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< Not/ >

Example:
<IsEmpty Name="Location A" />

<Not/>

<If>

<p>Variable contains something</p>

</If>

Inverts the logical state of the global accumulator register, i.e. turns TRUE 
(1) into FALSE (0) or vice versa.

< IsLastRow/ >

<ResetDocRow />

<IsLastRow />

<Not />

<While>

<DocPlot Name="Wavelength" Format="%.2f" />

<NextDocRow />

<IsLastRow />

<Not />

</While>

Checks if the current row counter is beyond the last measurement row. 
The result is stored in the global accumulator register.

< Compare/ >

Example:
<DocParamLoadReg Name="Resolution"/>

<Compare Operation="eq">0</Compare>

<If>

<t>highest</t>

</If>

<Else>

<DocParam Name="Resolution" Format="%.3f"/>

</Else>

Attribute Description

Name Document property name. SeeCommand 
Reference: Document Property Values on 
page 308 for a complete list of available properties.
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Compares the current content of the global accumulator register with the 
value between the tags. Different compare operations can be selected by 
means of the Operation-tag. The result is stored in the global 
accumulator register.

< Calc/ >

Example:
<DocParamLoadReg Name="Loss"/>

<Calc Operation="log10"/>

<Calc Operation="multiply">10</Calc>

<PrintReg Format="%.2f"/>

Allows you to apply simple calculations on the global accumulator 
register. The Operation tag defines which calculation is to be 
performed.

Attribute Description

Operation Defines the compare operation.
eq : equals
ne : not equal
le : less or equal
lt : less than
ge : greater or equal
gt : greater than

Attribute Description

Operation Defines the operation.
multiply : multiplies the accumulator with the value 
between the tags.
divide : divides the accumulator by the value between 
the tags.
add : adds the value between the tags to the 
accumulator.
sub : subtracts the value between the tags from the 
accumulator.
log : calculates the natural logarithm from the 
accumulator.
log10 : calculates the logarithm to the basis 10 from 
the accumulator.
pow : let V be the value between the tags, then 
V Accumulator will be calculated.
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Command Reference: Document Property Values

Predefined Properties

PMD Measurement (.pbin files)

Property Name Description

Today The current time/date.

DestFilename The name of the destination file.

SourceFilename The name of the source file.

TotalPages The total number of pages. Only valid if the 
CountPages entry in the Info block is set to 
"yes". Refer to <Info> Node on page 288 
for details.

Property Name Description

Date The date/time the measurement was taken.

SNPolarimeter Serial number of the polarimeter.

PolNavVersion Version of the Polarization Navigator.

WavelengthStartDesired Start wavelength in nm.

WavelengthStopDesired Stop wavelength in nm.

SweepRateMain Sweep rate in nm/s.

Resolution Resolution in nm.

AutoResolution Resolution mode: 1=auto, 0=manual.

UseLambdaLogging Lambda-Logging mode: 1=on, 0=off.

PMD PMD Value in ps.

AvrgPDL Average PDL in dB.

Loss Average transmission coefficient. Either in 
linear scale or in mW depending on the 
measurement mode.
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SOP Measurement (.pbin files)

PMD Measurement (.pmr-files)

Property Name Description

Date The date/time the measurement was taken.

SNPolarimeter Serial number of the polarimeter.

PolNavVersion Version of the Polarization Navigator.

SamplingRate Sampling rate in kHz.

Wavelength Start wavelength in nm.

SweepRate Sweep rate in nm/s.

PeakPower Peak power in mW.

Property Name Description

Date/Time The date/time of taking the measurement.

Cable ID The cable ID.

Fiber ID The fiber ID.

Network Element The name of the network element.

Problem ID The problem ID.

Operator Name The operator name.

Mainframe ID The product name of the mainframe.

Mainframe SN The serial number of the mainframe.

Mainframe Rev The revision number of the mainframe 
firmware.

Module ID The product name of the measurement 
module.

Module SN The serial number of the module.

Module Rev The revision number of the module firmware.

Tx ID The product name of the transmitter unit.
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Tx SN The serial number of the transmitter unit.

Tx Rev The revision number of the transmitter 
firmware.

Tx Start Position [nm] The start wavelength configured at the 
transmitter.

Tx StopPosition [nm] The stop wavelength configured at the 
transmitter.

Tx StartPosition [THz] The start frequency in THz configured at the 
transmitter.

Tx StopPosition [THz] The stop frequency in THz configured at the 
transmitter.

Tx Output Power [dBm] The output power in dBm configured at the 
transmitter.

Start Position [nm] The start wavelength configured at the 
receiver.

Stop Position [nm] The stop wavelength configured at the 
receiver.

Measurement Mode The measurement mode. E.g. Single Sweep, 
Continuous, Averaging - Unlimited number of 
sweeps, Averaging - Number of Sweeps x.

MaxHold Mode The state of the max-hold mode. E.g. "On" or 
"Off".

Fiber Length [km] The fiber length.

PMD Value [ps] The PMD value.

Peak DGD [ps] The peak DGD value.

Peak DGD (MaxHold) [ps] The peak DGD value of the max-hold trace.

PMD Coeff. [ps/sqrt(km)] The PMD coefficient.

SOPMD (avg) [ps^2] The average second-order PMD.

PCD (avg) [ps/nm] The average polarization dependent chromatic 
dispersion.

Depol.Rate (avg) [ps^2] The average depolarization rate.

Property Name Description
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CD Measurement (.cd-files)

DOP (avg) [%] The average degree of polarization.

Loss (avg) [dB] The average loss.

Loss (max) [dB] The maximum loss.

Property Name Description

Property Name Description

Instr. Type The instrument product name.

Instr. SerialNo The instrument serial number.

Instr. FW-Rev The revision number of the instrument 
firmware.

Module Type The product name of the module.

Module SerialNo The serial number of the module.

Module FW-Rev The revision number of the module firmware.

Module Calibrated The last calibration date of the module.

AbsDispMin [ps/nm] Minimum absolute dispersion.

AbsDispMax [ps/nm] Maximum absolute dispersion.

RelDispMin [ps/(nm*km)] Minimum relative dispersion.

RelDispMax [ps/(nm*km)] Maximum relative dispersion.

Timestamp The date/time the measurement was taken.

FiberLength Mode Values: auto or manual.

FiberLength [m] The fiber length.

FiberType The fiber type. Values: SSMF (G.652), DSF 
(G.653), NZDSF (G.655), NegDSF (G.655), 
Unknown, Mixed.

CurveFit Values: 3 term Sellmeier, 4 term Sellmeier.

R2 The R2 value.

Lambda0 [nm] The Lambda0 value.
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S0 [ps/(nm2*km) The S0 value.

D1550 [ps/(nm*km) The D1550 value.

Comment Label0 Space for comments.

Comment Label1 Space for comments.

Comment Label2 Space for comments.

Comment Label3 Space for comments.

Comment Label4 Space for comments.

Property Name Description
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Specifications1 N7781B/N7781BD Polarization Analyzer

1 Ambient temperature change max. ± 0.5°C since normalization. Specification valid 
on day of calibration.

2 SOP/DOP measurements are possible outside the specification wavelength range if a 
manual user calibration is performed.

3 Input power > -30 dBm

4 DOP > 95%

5 User calibration requires a source with DOP = 100%. User calibration is valid for a 
fixed wavelength.

Specification Wavelength Range Opt 300, O-Band:
1270 nm to 1375 nm
(Opt 400, O/C/L-Band):
1270 nm to 1375 nm, 1460 nm to1 620 nm 
(Opt 500, C/L-Band):
1460 nm to 1620 nm 

Operating Wavelength Range 2 1260 nm to 1640 nm

SOP Uncertainty (typ.) 3, 4 1.5° on the Poincaré sphere

DOP Uncertainty 3 ±2.0%

DOP Uncertainty after User Calibration (typ.) 3, 5 ±0,5%

Maximum Sampling Rate up to 1 MHz

Relative Power Uncertainty 3 C/L-Band: ± 0.03 dB (± 0.02 dB typ.)
O-Band: ±0.07 dB ( ± 0.04 dB typ.)

Input Power Range -50 dBm to +7 dBm

Maximum Safe Optical Input Power 12 dBm
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Specifications1 N7782B PER Analyzer

1 Ambient temperature change max. ± 0.5°C since normalization. Specification valid 
on day of calibration.

2 PER measurements are possible outside the specification wavelength range if the 
user performs a manual calibration. Note that a fully polarized light source is needed 
for calibration.

3 Input power > -30 dBm

4 Narrow-band light source with DOP > 95% needed.

5 At room temperature.

Specification Wavelength Range O-Band (Opt. 300):
1270 nm to 1375 nm
O/C/L-Band (Opt. 400):
1270 nm to 1375 nm
1460 nm to 1620 nm
C/L-Band (Opt. 500):
1460 nm to 1620 nm

Operating Wavelength Range 2 1260 nm to 1640 nm

PER Range 3, 4 0 to 50 dB

PER Uncertainty, Single-TCU Method 3, 4 (typ.) PER= 0 dB to 30 dB: 0.30 dB
PER=30 dB to 50 dB: 0.60 dB

Splice Angle Uncertainty, Dual-TCU Method 3, 4 

(typ.)
± ( 0,1° + 4% x Angle)

Input Power Range -50 dBm to +7 dBm

Relative Power Uncertainty 3 C/L-Band: ± 0.03 dB (± 0.02 dB typ.)
O-Band: ±0.07 dB ( ± 0.04 dB typ.)

Internal Laser Source Wavelength O-Band (Opt. 401): 1290 nm to 1360 nm 
(1310 nm typ.)
C-Band (Opt. 501/401): 1510 nm to 1580 
nm (1550 nm typ.)

Internal Laser Source Output Power 5 (typ.) O-Band (Opt. 401): -12 dBm
C-Band (Opt. 501/401): -10 dBm



316 Keysight N778xB User’s Guide

13 Specifications
 

Specifications1 N7782B-101 PER Analyzer (Discontinued)

1 Ambient temperature change max. ± 0.5°C since normalization. Specification valid 
on day of calibration.

2 The specification wavelength matches the wavelength of the internal laser source.

PER measurements are possible outside the specification wavelength range if the 
user performs a manual calibration. Note that a fully polarized light source is needed 
for calibration.

3 Input power > -20 dBm

4 Narrow-band light source with DOP > 95% needed.

5 At room temperature.

Specification Wavelength Range 1, 2 850 nm nominal

Operating Wavelength Range 830 nm to 1000 nm

PER Range 3, 4 0 .. 40 dB

PER Uncertainty, Single-TCU Method 3, 4 (typ.) PER= 0 dB to 30 dB: 0.30 dB
PER= 30 dB to 40 dB: 0.60 dB

Splice Angle Uncertainty, Dual-TCU Method 3, 4 

(typ.)
± ( 0,1% + 5% x Angle)

Input Power Range -35 dBm to +10 dBm

Internal Laser Source Wavelength 830 nm to 880 nm, 850 nm typ.

Internal Laser Source Output Power 5(typ.) -11 dBm
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Specifications1 N7788B/N7788BD Optical Component Analyzer

1 Ambient temperature change max. ± 0.5°C since normalization. Valid for 81600B 
Tunable Laser Source Family. Tunable laser power set to -6 dBm. Sweep over 
Specification Wavelength Range. Specification does not include instability in test 
device. Specified loss ranges include loss of test device and any additional switches 
or connections in the optical path. Specification valid on day of calibration.

2 SOP/DOP measurements outside the specification wavelength range are only 
possible if a manual user calibration is performed.

3 DUT properties: Insertion Loss < 30 dB, PDL < 1 dB, DGD < 150 ps. Specification is 
typical for DGD > 150 ps.

Specification Wavelength Range Opt 300, O-Band:
1270 nm to 1375 nm
Opt 400, O/C/L-Band:
1270 nm to 1375 nm, 1460 nm to 1620 nm
Opt 500, C/L-Band:
1460 nm to 1620 nm

Operating Wavelength Range 2 1260 nm to 1640 nm

DGD Uncertainty 3 Resolution 2,0 nm:±(30 fs+ 0,3%*DGD)
Resolution 0,1 nm:±(30 fs+ 3,0%*DGD)

DGD Measurement Range 3 0 to 1000 ps

PMD Uncertainty 4 ±(30 fs + 2.0%*PMD)

PMD Repeatability (typ.) ±3 fs

PMD Measurement Range 4 0 to 300 ps

PDL Uncertainty 5 C/L-Band: ±(0.05 dB + 4%*PDL)
O-Band: ±(0.10 dB + 4%*PDL)

PDL Repeatability (typ.) ±5 mdB

Insertion Loss Uncertainty (typ.) 3 C/L-Band: ±0.03 dB
O-Band: ±0.07 dB

Insertion Loss Dynamic Range (typ.) 3 > 41dB
(for TLS power levels higher than -6 dBm, 
increase value accordingly)

Polarization Analysis See N7781B/BD

Optical Power Measurement See N7781B/BD

Polarization Control See N7785B
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4 DUT properties: Insertion Loss < 41 dB, PDL < 3 dB, PMD < 50 ps. Applies for highly 
mode-coupled devices such as single mode fibers. Specification applies for PMD 
being the averaged DGD over a wavelength span of 100 nm. Specification is typical 
for PMD > 50 ps.

5 DUT properties: Insertion Loss < 25 dB, PDL < 6 dB. Note: DUT connectors are 
considered part of the DUT. Thus, angled connectors will add to the device PDL.
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Specifications1 N7784B Polarization Controller

1 Ambient temperature change max. ± 0.5°C since normalization. Specification valid 
on day of calibration.

2 Outside the stabilizer wavelength range, the PER at PMF Output may be degraded.

3 Input power at Port III > -30 dBm, response to an immediate step of 180° on the 
Poincaré sphere.

4 For SOP scrambling/switching, only ports I/II are used.

5 Valid for optimum input polarization at PBS input (Port III). Add insertion loss of port 
I/II and III/IV to obtain total insertion loss for SOP stabilizing mode.

Operating Wavelength Range 1260 nm to 1640 nm

Wavelength Range in Stabilizer Mode 2 1520 nm to 1580 nm

SOP Switching Time (open-loop) < 10 μs

PER at PMF Output (typ.) > 23 dB

Stabilizer Response Time (typ.) 3 2 ms

Insertion Loss Port I to Port II 4 < 3.5 dB (< 3.0 dB, typ.)

Insertion Loss Port III to Port IV 5 < 1.8 dB (< 1.4 dB, typ.)

PDL Port I to Port II (typ.) C/L-Band: < 0.2 dB
O-Band: < 0.5 dB

Maximum Safe Input Power Port I: 20 dBm
Port III: 3 dBm

Input Power Range in Stabilizer Mode Port III: -30 dBm to 0 dBm

Polarization

Controller

DSP based control electronics

SMF

PMF

SMF

Pol Splitter

GPIB

Trigger in

Trigger out
Power

Analog inPort I Port II Port III Port IV

USB
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Specifications1 N7785B Synchronous Scrambler

1 Ambient temperature change max. ± 0.5°C since normalization. Specification valid 
on day of calibration.

Operating Wavelength Range 1260 nm to 1640 nm

SOP Switching Time < 10 μs

Insertion Loss < 3.5 dB (< 3.0 dB, typ.)

PDL (typ.) C/L-Band: < 0.2 dB
O-Band: < 0.5 dB

Maximum Safe Input Power 20 dBm
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Specifications1 N7786B Polarization Synthesizer

1 Ambient temperature change max. ± 0.5°C since normalization. Specification valid 
on day of calibration.

2 SOP/DOP measurements are possible outside the specification wavelength range if a 
manual user calibration is performed.

3 The instrument adaptively finds the polarization controller settings to let the SOP 
cycle through user-defined polarization states (closed loop operation). After having 
found these settings, the SOP can cycle through the polarization states in open loop 
operation.

4 This value is defined to be 5 times the standard deviation of the angular SOP error on 
the Poincaré sphere. Valid if controller is turned on. Power at instrument input > -10 
dBm.

5 Input power > -20 dBm 

The polarization analyzer readout reflects the SOP at the instrument output. Thus, 
effects caused by the internal polarization controller are included.

Specification Wavelength Range Opt 400, O/C/L-Band:
1270 nm to 1375 nm,1460 nm to 1620 nm
Opt 500, C/L-Band:
1460 nm to 1620 nm

Operating Wavelength Range 2 1260 nm to 1640 nm

SOP Switching Time 
(non deterministic)

< 10 μs

SOP Cycling Time 3 < 25 μs

Remaining SOP Error after deterministic SOP 
setting (typ.) 4

< 3° at input SOP movement rate of 1.2 rad/s
< 6.5° at input SOP movement rate of 40 rad/s

SOP Uncertainty (typ.) 5, 6 1.5° on the Poincaré sphere

DOP Uncertainty 5 ±2,0%

DOP Uncertainty after User Calibration (typ.) 5, 7 ±0,5%

Relative Power Uncertainty 5 C/L-Band: ± 0.14 dB (± 0.12 dB typ.)
O-Band: ±0.16 dB ( ± 0.14 dB typ.)

Input Power Range -38 dBm to +19 dBm

Insertion Loss < 4.0 dB (< 3.5, typ.)

PDL (typ.) C/L-Band: < 0.2 dB
O-Band: < 0.5 dB

Maximum Safe Input Power 20 dBm
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6 DOP > 95%

7 User calibration requires a source with DOP = 100%. User calibration is valid for a 
fixed wavelength.
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Specifications1 N7783B Thermal Cycling Unit

1 Ambient temperature change max. ± 0.5°C since normalization. Specification valid 
on day of calibration.

2 Measured on the surface of the TEC elements.

Minimum Peak-to-Peak Temperature Tuning 
Range (typ.) 2

50 K

Ambient Temperature Range 20°C to 30°C
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Definition of Terms

Specification

Specification describes a guaranteed product performance that is valid 
under the specified conditions. Specifications are based on a coverage 
factor1 of 2 (unless otherwise stated), corresponding to a level of 
confidence of >95%.

Typical Value

A characteristic describing the product performance that is usually met, 
but not guaranteed. 

Generally, all specifications are valid within the specified temperature 
range, after warm-up, at the stated operating conditions and 
measurement settings.

Operating Conditions 

The environmental conditions for system operation. The system must not 
be operated outside these conditions.

Specified Temperature 

The temperature range where the specifications apply (if not differently 
stated).

Ambient Temperature Range

Temperature range of the ambient environment where specifications 
apply.

NOTE
For a system mounted in a rack the environmental conditions within the 
rack.

NOTE
For a system mounted in a rack the environmental conditions within the 
rack.
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Operating Wavelength Range 

The wavelength range in which the instrument's internal optics can be 
used. If the wavelength is outside the specification wavelength range, the 
SOP/DOP performance can be improved by a user calibration. This 
calibration is done by applying the desired light source by means of a 
standard SMF. The calibration data is collected while the SMF is 
(manually) randomly moved.

Specification Wavelength Range 

The wavelength range in which the specified optical performance is met.

Relative Power Uncertainty 

The relative power uncertainty is defined as the peak-to-peak variation of 
the measured power level when varying the polarization state (SOP).

Input Power Range

The range of power levels for which the instrument displays a 
measurement readout.

Maximum Safe Optical Input Power

Higher power levels than defined by the maximum safe optical input power 
may damage the instrument irreversibly. Note that proper operation is only 
provided within the Input Power Range.

NOTE
DGD/PMD measurements outside the specification wavelength range are 
not supported.

NOTE
DGD/PMD measurements outside the specification wavelength range are 
not supported.

WARNING
Higher power levels than defined by the maximum safe optical input 
power may damage the instrument irreversibly.
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Output Power

The power level at the connector interface.

Input Power Range in Stabilizer Mode

The input power range at Port III where specifications for stabilizer mode 
apply.

Gain (Loss, Insertion Loss)

Gain is defined as the difference in the transmitted power, expressed in dB, 
between the test device measurement, Pb, and the normalization 
measurement, Pa, given a constant power of the laser source, calculated 
as:

Loss is calculated with the same formula as gain, but with opposite sign (in 
dB).

Insertion Loss Uncertainty 

The insertion loss uncertainty is given by the doubled standard deviation of 
the insertion loss error at each given wavelength.

Insertion Loss Dynamic Range 

The maximum test device loss for which insertion loss measurements can 
be performed.

NOTE
The Polarization Navigator shows gain (rather than loss). That is, lossy 
test devices are shown with negative values.

Gain (loss) includes connector effects at normalization and at test device 
measurement.

In general, loss depends on wavelength and polarization state.
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State of Polarization (SOP)

The State of Polarization of a signal is defined by the three normalized 
Stokes Parameters s1, s2 and s3 which define a point in a 
three-dimensional coordinate system. For fully polarized light 
(DOP=100%), this point is located on a unity sphere commonly known as 
Poincaré sphere.

SOP Uncertainty 

The SOP uncertainty is defined to be twice the standard deviation of the 
angular error on the Poincaré sphere. 

Degree of Polarization (DOP)

The Degree of Polarization is the square-root of the sum of the squared 
normalized Stokes Parameters s1, s2 and s3. DOP can be a value between 
0 and 1 or between 0% and 100% accordingly:

DOP Uncertainty 

The DOP uncertainty is defined to be twice the standard deviation of the 
DOP from the ideal value:

DOPi denotes the measured DOP value and StDev denotes the standard 
deviation over repetitions i.

If DOP is given in %, the DOP uncertainty has the same unit.

Measurement: The polarization state of a signal with nominally 100% 
polarized light is randomly scrambled. The readout deviations from 100% 
are recorded over all polarization states and wavelengths. 

NOTE
Although the uncertainty unit is %, the deviation is not relative to the 
actual value. It is calculated DOPmeasured-DOPactual.
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Differential Group Delay (DGD)

The dependence of the group delay at a fixed wavelength resulting from 
applying all possible polarization states, expressed as the difference 
between the maximum and the minimum group delay value.

Differential Group Delay (DGD) Uncertainty

Specifies the uncertainty of the measurement results for  differential group 
delay, expressed as the sum of the absolute value of the DGD 
measurement error and its standard deviation at each given wavelength.

• Conditions: Stable device-under-test.

• Measurement: Using a standard SM fiber with nominally 0 ps DGD and 
various PM fibers with specified DGD over the specified wavelength 
range. 

Differential Group Delay (DGD) Measurement Range

Specifies the range of DUT DGD values for which the instrument measures 
DGD values not disturbed by aliasing effects.

Polarization Mode Dispersion (PMD)

The arithmetic average of the differential group delay (DGD) over a broad 
specified wavelength span (here unless otherwise noted 100 nm).

Polarization Mode Dispersion (PMD) Uncertainty 

The PMD uncertainty is given by twice the standard deviation of the PMD 
error.

Conditions: Measurement settings and operation mode as specified. 
Wavelength span and wavelength increment as specified.

NOTE
In highly mode-coupled devices, such as standard single mode fibers of 
kilometer length, the DGD depends on wavelength. Stress or 
temperature change may change the dependence of DGD on wavelength 
significantly. It can be shown that the DGD characteristics of such 
devices can be described statistically by PMD.
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Polarization Mode Dispersion (PMD) Repeatability 

The agreement of repeated measurements of PMD on a stable test device 
and under constant environmental conditions, expressed as:

PMDi denotes the measured PMD and StDev denotes the standard 
deviation over repetitions i. 

Polarization Mode Dispersion (PMD) Vector 

The PMD vector represents the polarization dependence of the group 
delay (GD). For a given wavelength, the magnitude of the PMD vector is 
the Differential group delay (DGD) at that wavelength, and the vector 
direction corresponds to the fast principal state of polarization in Mueller 
notation. The PMD vector is denoted by

Second Order PMD

The second-order PMD, S, quantifies the magnitude of the differential 
change of the Polarization mode dispersion (PMD) vector, with rotational 
frequency, ω, expressed in [ps2],

 

NOTE
Second-order PMD can be expressed in [ps/nm] at a wavelength of 
1550 nm by multiplying the [ps2] value with the factor 0.784 nm/ps.
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Polarization-Dependent Chromatic Dispersion (PCD) 

The PCD, quantifies the differential change of the magnitude of the 
Polarization mode dispersion (PMD) vector, with angular optical 
frequency, ω, expressed in [ps2],

Depolarization Rate 

The depolarization rate, d, quantifies the absolute value of the differential 
change of the normalized Polarization mode dispersion (PMD) vector, with 
rotational frequency change, ω, weighted with the DGD (expressed in [s2]). 

PMD Measurement Range

Specifies the range of DUT PMD values for which the instrument measures 
PMD values not disturbed by aliasing effects. This value applies for highly 
mode-coupled devices such as single mode fibers. For non-mode-coupled 
devices such as polarization maintaining fibers (PMFs), the PMD 
measurement range equals the DGD measurement range. 

Polarization Dependent Loss (PDL)

The dependence of the loss (gain) of a device on the input polarization 
state, calculated as the difference between maximum and minimum loss 
(gain), usually expressed in dB.

Polarization Dependent Loss (PDL) Uncertainty 

Specifies the uncertainty of the measurement results for polarization 
dependent loss, expressed as the doubled standard deviation of the PDL 
error at each given wavelength.

Conditions: Loss range as specified. DUT connectors are considered being 
part of the DUT. Thus, angled connectors will add to the device PDL.

NOTE
The depolarization rate is a measure of how fast the PMD vector changes 
direction with the rotational frequency of the optical wave (or with the 
wavelength).
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Polarization Dependent Loss (PDL) Repeatability 

The agreement of repeated measurements of  PDL on a stable test device 
and under constant environmental conditions, expressed as:

PDLi(λ) denotes the PDL at any wavelength λ and StDev denotes the 
standard deviation over repetitions i.

Polarization Dependent Loss (PDL) Range

Specifies the maximum PDL which can be measured.

Maximum Sampling Rate

Specifies the maximum sampling rate into instrument memory for 
acquiring the State of Polarization (SOP) including DOP. Note that the time 
needed for transferring this data into a PC depends on the used interface.

Wavelength Range in Stabilizer Mode

The wavelength range where specifications for stabilizer mode apply.

SOP Switching Time

The time needed to move to another SOP setting of the polarization 
controller in open loop mode.

SOP Cycling Time

The instrument adaptively finds the polarization controller settings to let 
the SOP cycle through user-defined polarization states (closed loop 
operation). After having found these settings, the SOP can cycle through 
the polarization states in open loop operation. The SOP cycling time is the 
time needed to move to the next SOP.

Remaining SOP Error After Deterministic SOP Setting

This value is defined to be 5 times the standard deviation of the angular 
SOP error on the Poincaré sphere while the controller is turned on.

One-Heater Method for PER-Measurement

The one-heater method for PER-measurement uses one thermal cycling 
unit (N7783B) to create temperature changes in a PMF. This allows to 
measure the PER of the light guided in the PMF.
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Two-Heater Method for Splice Angle Measurement

The two-heater method for splice angle measurement uses two thermal 
cycling units (N7783B) to create temperature changes in two sections of 
PMF. This allows to measure the angular misalignment of the two PMFs at 
the connection point (typically a PMF splice or two misaligned 
connectors).

PER Range 

Specifies the maximum PER level which can be measured using the 
one-heater method.

PER Uncertainty 

This value is defined as being twice the standard deviation of the 
Polarization Extinction Ratio (PER) measurement error. It is given in dB.

Splice Angle Uncertainty 

Is specified as twice the standard deviation of the splice angle error 
between two PMFs at a connection point (typically a PMF splice or two 
misaligned connectors).

Minimum Peak-to-Peak Temperature Tuning Range

The minimum temperature tuning range measured on the surface of the 
thermo electric coolers of the N7783B (Unit: Kelvin).
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Command Line Parameters

The following command line parameters are supported by the software:

Command Line Switch Description

/minimize The software will be minimized to the system 
tray on startup. This may be useful if the 
polarizationNAVIGATOR™ is only needed for 
remote control or as automation target.
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Polarimeter Input Ranges

The following table shows the permitted input power ranges for all 
available gain settings. If the input power falls below the lower boundary 
measurement, results become noisy due to quantization. If the input power 
exceeds the upper boundary, errors may appear due to limits of the input 
amplifier. You can manually choose a specific gain setting by disabling the 
auto-gain function (i.e. TreeNo=3/VarNo=14 (Tree 3: Polarimeter on 
page 236) AutoGainFlag = 0).

Gain Max. Input Power Power Range

0 7 dBm 0dBm .. 7dBm

1 4 dBm -3dBm .. 4dBm

2 0 dBm -7dBm .. 0dBm

3 -3 dBm -10dBm .. -3dBm

4 -6 dBm -13dBm .. -6dBm

5 -10 dBm -17dBm .. -10dBm

6 -13 dBm -20dBm .. -13dBm

7 -16 dBm  -23dBm .. -16dBm

8 -20 dBm -27dBm .. -20dBm

9 -23 dBm -30dBm .. -23dBm

10 -26 dBm -33dBm .. -26dBm

11 -30 dBm -37dBm .. -30dBm

12 -33 dBm -40dBm .. -33dBm

13 -36 dBm -43dBm .. -36dBm
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Error Codes

The following table lists all available error codes and their explanation:

Error Code (HEX) Description

0x0000 No error

0x0003 Undefined function

0x0007 Memory allocation error

0x0008 Memory overflow error

0x000B Variable type mismatch

0x0011 Generic error

0x0035 Unknown tree number

0x0036 Unknown variable

0x0037 Variable access violation

0x0038 Unknown variable type

0x0039 Parameter missing/Wrong number of parameters

0x0054 Health check error

0x0063 Target not found

0x0064 Unknown command

0x0065 Response buffer overflow

0x0067 Referencing error

0x0068 Resolution error

0x0400 Polcontroller generic error

0x0401 Polcontroller memory allocation error

0x0601 Polarimeter no calibration data

0x0602 Polarimeter calibration range

0x0603 Polarimeter measurement timeout

0x0604 Polarimeter measurement in progress
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0x0605 Polarimeter measurement sequence error

0x0609 Polarimeter measurement over range

0x060A Polarimeter measurement under range

Error Code (HEX) Description
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ASCII File Formats

SOP Data (Default)

PDL/PMD Data (Default)

Column 1: Wavelength in nm

Column 2: Time in s

Column 3: DOP

Column 4: S0 in mW

Column 5: S1 in mW

Column 6: S2 in mW

Column 7: S3 in mW

Column 8: Corresponding ADC Range (0..1)

Column 9: s
1

Column 10: s
2

Column 11: s
3

Column 1: Wavelength in nm

Column 2: DGD in ps

Column 3: PDL in dB

Column 4: Power in mW or -Loss (linear scale)

Column 5: TE (Power in one PDL axis)

Column 6: TM (Power in other PDL axis)

Column 7: s
1 of PDLPSP

Column 8: s
2 of PDLPSP

Column 9: s
3 of PDLPSP

Column 10: s
1 of PSP
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Mueller Data

Jones Data

Column 11: s
2 of PSP

Column 12: s
3 of PSP

Column 13: 2nd-order PMD in ps2

Column 14: PCD in ps2

Column 15: Depolarization in ps2

Column 1: M11

Column 2: M12

Column 3: M13

Column 4: M14

Column 5: M21

Column 6: M22

.

.

.

Column 1: RE (J11)

Column 2: RE (J12)

Column 3: RE (J21)

Column 4: RE (J22)

Column 5: Im (J11)

Column 6: Im (J12)

Column 7: Im (J21)

Column 8: Im (J22)
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Jones Data + Lambda

SOP Data

SOP Streaming Data

Column 1: Wavelength in nm

Column 2: RE (J11)

Column 3: RE (J12)

Column 4: RE (J21)

Column 5: RE (J22)

Column 6: Im (J11)

Column 7: Im (J12)

Column 8: Im (J21)

Column 9: Im (J22)

Column 1: S0 in mW

Column 2: S1 in mW

Column 3: S2 in mW

Column 4: S3 in mW

Column 1: S0 in mW

Column 2: S1 in mW

Column 3: S2 in mW

Column 4: S3 in mW

Column 5: DOP
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Symptoms and Solutions

Connection Expert displaying a warning icon next to an N778xB 
instrument connected to GPIB

Connection Expert not showing an N778xB instrument connected to 
USB

Can’t find any instrument connected to GPIB

Possible Reason Solution

N778xB instruments return an IDN string that 
differs slightly from most other Keysight 
instruments, resulting in a warning icon next 
to the instrument.

You can safely ignore this warning.

Possible Reason Solution

By design N778xB instruments are not listed 
in the Connection Expert.

Use the Polarization Navigator or tools from 
the Photonic Application Suite for checking 
and adressing N778xB instruments.

Possible Reason Solution

If you’re using a GPIB interface connected to 
your PC and an N778xB instrument is 
connected to the GPIB bus and it is configured 
for Remote GPIB, communication on the GPIB 
bus doesn’t work.

Power-cycle the N778xB instrument to set it 
back to default settings (Remote GPIB off ). 
Refer to Using the N778xB/BD GPIB 
Interface (Remote GPIB) on page 59 for 
further details.
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Can’t find individual instruments connected to GPIB

Possible Reason Solution

By default all N778xB instruments are 
configured for GPIB address 30. If there are 
multiple instruments with the same GPIB 
address connected to the same GPIB bus, 
usually none of them is visible on the bus.

Either use a USB connection to change the 
N778xB instruments’ GPIB addresses or 
temporarily remove the instruments and 
connect single instruments to the bus 
subsequently. For each instrument, change the 
GPIB address appropriately. 
In both cases, use the PolarizationNavigator to 
change the GPIB address (refer to Changing 
the GPIB Address on page 60 for details).
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